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Chapter 1 Introduction 

1.1 Overview 

1.1.1 Background 

With the development of industry and social economy, information technology based on 

computers, high-speed networks, cloud services is becoming more and more mature and 

advanced, and the scope of application spans from industrial manufacturing, import and 

export trade, transportation, electric power, petroleum, chemical industry, metallurgy to 

people's daily life, culture and entertainment, etc. Information technology is also gradually 

developing towards automation, intellectualization and cloudification, which is pushing 

forward the revolution of productivity and improvement in human's standard of living.  

The cloud platform model refers to the deployment where local data is uploaded to a cloud 

service platform. Delta's IoT cloud platform, DIACloud, can communicate with remote 

devices at any time, in any place, and under any network. It realizes browsing of the status 

of connected industrial equipment and collected data, receiving alarms, push notifications, 

and other information sent by the cloud platform, as well as graphical analysis and display 

for the data. Users can monitor operation and alarm information of the equipment in real 

time through mobile APP or webpage at any place, which is convenient for remote 

maintenance, guidance and troubleshooting, and provides users with comprehensive 

solutions and services for remote management and monitoring of industrial equipment. 
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The graphical interface editor, DIAWeb Designer, provides professional design tools for 

DIACloud. The extensive graphical configuration options and charts allows user to quickly 

create exquisite page displays. 
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1.2 Features 

 Based on Windows operating system, widely adaptable with flexibility and reliability. 

 Adopt .NET application platform with HTML supported to create visually appealing 

interfaces through Web technology. 

 Distributed layout for strong scalability. 

 User-friendly and intuitive interfaces with extensive graphical options makes it easier 

to configure, use and maintain. 

 Simple template binding function. 

 Efficient data download and upload mode.  

 Apply VBScript, the script language easy to learn and use. 
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Chapter 2 Installation and Uninstallation 

2.1 System Requirements 

Item System Requirements 

CPU 2GHz or above 

Memory 4GB or above 

Hard Disk Drive 20GB or above 

Monitor Resolution: 1024 x 768 Pixels or above 

Operating System 

Windows 7 SP1 (32 / 64 bits) (Professional / Ultimate / 

Enterprise) 

Windows 8 (32 / 64 bits) (Professional / Ultimate / Enterprise) 

Windows 10 (32 / 64 bits) (Professional / Ultimate / Enterprise) 

Windows 11 (32 / 64 bits) (Professional / Ultimate / Enterprise) 

Windows Server 2008 R2 SP1 (64 bits) 

Windows Server 2012 (64 bits) 

Languages: Traditional Chinese, Simplified Chinese, English 

Access Rights Administrator permissions are required for Windows 

Browser 
Chrome official version 124.0.6367.60 (64 bits) and Edge 

official version 123.0.2420.97 (64 bits) are recommended 
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2.2Installing and Uninstalling DIAWeb Designer 

This section introduces how to install and uninstall DIAWeb Designer. 

2.2.1Installation 

To install DIAWeb Designer (based on Windows 11 Professional):  

1. Double-click the DIAWeb DesignerSetup.exe file.  

 

2. Select the language: click to open the drop-down list and select the language you require. Click OK 

to continue. 

  

3. The DIAWeb Designer Setup dialog will appear.  

The default download path is C:\Program Files (x86)\Delta Industrial Automation\DIAWeb Designer. 

Click Browser to change the path if necessary. 
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Click Agreement to read the End-User License Agreement or print it out. Click OK to close the 

dialog.  

 

4. Check the box of I accept the terms in the License Agreement. Then click Start Install. The 

DIAWeb Designer Setup dialog will appear.  

 

Click Cancel if you want to stop installation. A dialog for double confirmation will pop up. Click Yes 

to stop or No to continue installation. 

 



  Chapter  1  In t roduct ion  

1_ 

5. The dialog below will appear after installation is done. Click Finish to complete and exit the Setup 

Wizard. If the Start DIAWebDesigner box is ticked, the DIAWeb Designer software will be opened 

directly after clicking Finish.  

 

 

2.1.2 Uninstallation 

There are three approaches to uninstall DIAWeb Designer (based on Windows 11 

Professional): 

 Approach 1 

1. Open the Control Panel. Select Programs and Features. Right-click DIAWeb Designer and 

select Uninstall.  

 

2. A dialog for double confirmation will pop up.  
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Click Yes and then DIAWeb Designer will be removed automatically. Or, click No to exit. 
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Approach 2  

1. Open the DIAWeb DesignerSetup.exe file and click Remove to uninstall.  

 

 Approach 3 

1. Select Start on the desktop, go to the Settings page and select Apps > Apps & Features.  

2. Find the Delta Industrial Automation folder. Right-click DIAWeb Designer and select 

Uninstall.  
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Chapter 3 Getting Started with DIAWeb Designer 

 

This chapter introduces the basic setup for project development in DIAWeb Designer. It is 

important to note that each project application differs, and these steps only serve as 

general guidelines. Users are advised to select the most appropriate configurations based 

on the specific project requirements.  

3.1Quick Start 

1. Open the DIAWeb Designer software.  

2. To create a new project:  

On the StartPage, click File > New or Start > New to create a new project. Specify 

a name and storage location for the project to get started. The Project pane will 

appear on the right-hand side after you click OK.  

3. To log in: 

Please log in to access the template binding feature. Click Please login at the top-

right corner to open the LoginBox dialog. Click Login after entering user name and 

password. 
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4. To bind a template:  

Click IIoT > Bind Template and select a template for your project. After binding a 

template, you will be able to download and upload data between the template on 

DIACloud and the project. 

 

5. To synchronize the data:  

There are local tags and cloud tags in the variable dictionary. Select IIoT > Download 

Data to synchronize the data. 
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6. To add local tags:  

On the Project pane, double-click LocalTags under Variable Dictionary to add local 

variables. 

 

7. To create a web window:  

It involves creating graphical interfaces for the system, drawing graphics for on-site 

simulation, and configuring related properties, charts, and so on. On the Project pane, 

right-click Web Window to create a new window. To configure, you can drag and 

drop the controls from the Toolbox pane.   
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8. To configure an animation: 

Double-click the control you have selected and its Property Edition dialog will pop 

up. Select the Animation tab to edit the display. 

 

9. To configure the project: 

Click Project Configuration on the Project pane to set the start window for project 

execution.  

 

10. To start running the project: 
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You can check whether the designs and functionality meet the project requirements 

or not through Start > Preview or IIoT > Upload Data.   

 

Chapter 4 Development Environment 

4.1 Terminology 

This section introduces the terminology which is commonly used in DIAWeb Designer. 

Term Definition 

Project 

A project is a set of automation application systems developed using DIAWeb Designer 

according to users’ demands. It mainly includes the development of automation monitoring and 

control systems and the collection of configuration information. It encompasses graphical 

interfaces, variables, thumbnails, project configurations and other elements. Project developers 

can manage each part of the project uniformly and centrally on DIAWeb Designer. 

Authenticate user 

with DIACloud 

Users are required to attain cloud authentication by logging in before having access to the 

functions such as downloading and uploading data or binding templates.  

Download Data Download data from DIACloud to synchronize it in the project. 

Upload Data Upload the project in the DIAWeb Designer to the cloud. 

Bind Template 
It is required to bind a template with the project before downloading data from or upload the 

project to the cloud.  

Development 

environment / 

runtime 

environment 

DIAWeb Designer consists of two parts: the development environment and the runtime 

environment.  

The development environment is the platform where users are provided with graphical interface 

design, function configurations, etc. for project design and development. Users can create new 

projects in the development environment, define variable dictionaries in the project, drawing 

graphics for on-site simulation, and configure animations, events, and curve charts on the canvas. 

It also allows background scripts editing based on data and mathematical expressions for logical 

processing. 

The runtime environment, on the other hand, is the platform for dynamic operation of the project 

where runtime display and interface control are provided, allowing users to conduct real-time 

monitoring. 

Variable Dictionary / 

Local Tags / 

Cloud Tags 

Variable dictionary refers to a collection of variables that can be managed in a project while 

variables are values that can be changed at any time in a project and play a crucial role in system 

data exchange. 

In DIAWeb Designer, variable dictionary is divided into local tags and cloud tags. 
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Term Definition 

Web Window 

The web window is the core component provided for drawing on-site simulation, configuring 

parameters, and displaying data. It serves as the foundation for realizing real-time visualization 

in DIAWeb Designer. In the web window, it offers basic graphics, window controls, extended 

controls, and other elements for drawing. The system is equipped with both built-in and custom-

built graphics libraries for users. Additionally, it provides a pop-up window where configurations 

of property, animation and event are available. In DIAWeb Designer, a web window corresponds 

to one scene. 

Property Property refers to the traits of graphics such as name, appearance, and so on.  

Animation 
Animation is related to the visibility of graphics. It displays the process that changes with the 

variation of variables during project operation. 

Event 

Event refers to the operation that can be identified and responded to by the graphics. The 

interactions between users and the graphical objects drive the controls to perform particular 

actions. 

Thumbnails 
When publishing a project, it is optional to submit related images to provide an overview of the 

project for quick review and enhancement of user experience.  

Global Global allows users to choose different display languages.  

Project 

Configuration 

Project configuration is related to the settings of the runtime environment in DIAWeb Designer 

includes the start window, view, and canvas size.  

Preview 
Preview allows users to run and test a project created in the development environment on local 

devices without deploying it to a remote server. 
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4.2 Introduction to the Development Environment 

 General Layout 

Open DIAWeb Designer. The main interface consists of the following parts: 

 

1. Quick access toolbar: to display the frequently used commands.  

2. Menu bar: to provide the basic functions for project development.  

3. Toolbar: to show the commands of each function.  

4. Login: to provide entry for user login. Click to open the LoginBox dialog as shown below.  
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If the user does not have an account yet, please visithttps://hms.diacloudsolutions.com to sign 

up. 

 

5. Toolbox: to provide the frequently used graphics and controls.  

6. Gallery: to include the built-in graphics library and the custom-built graphics library. 

7. Canvas workspace: the main area for project management and graphics editing. 

8. Project pane: to display the directory in the form of a project tree, allowing for configuration. 

9. Object pane: to display all the objects contained in the web window.  

  

https://hms.diacloudsolutions.com/
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Users can adjust the layout by dragging the panes to a different position. In the following example, the 

positions of the Object pane and the Project pane are rearranged. 
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 Create a New Project 

There are four ways to start a new project in DIAWeb Designer.  

1. In the File tab, click New. 

 

2. In the Start tab, click New. 
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3. On the StartPage, click New in the toolbar located at the bottom of the page.  

 

4. Right-click anywhere on the StartPage, and select New. 
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Specify a name and position for the project to get started.  

 

Item Description 

Name 

It is mandatory to specify a name for the project. Users can keep the name which is automatically 

generated by the system or name it by themselves. The naming rules are based on VBScript as 

follows:  

1. Consist of letters, numbers, Chinese characters, and underscores; must begin with a 

letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters such as 

@$#&*?. 

4. Cannot exceed 100 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other created projects within the same project folder. 

6. Only support names in traditional Chinese, simplified Chinese, or English. 

Position It refers to the storage location of the project. Click  to modify. 

Description It allows users to add project-related information or description here. 
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 Project Management Window 

In DIAWeb Designer, it offers two approaches to manage projects: through the StartPage or through the 

Menu bar (please refer to section 4.4.1).  

 StartPage 

Open DIAWeb Designer with the StartPage automatically as the initial page, where information 

of the created projects such as project name, template name, create time, modification time, 

project path, etc. is listed. On the StartPage, users can create, open, delete, modify, clean, 

backup, or restore projects.  

 

Right-click on the StartPage to find more options. 
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The following table lists the buttons and their functions on the StartPage.  

Item Description 

New 
To create a project. The project created will be added to the project list on the StartPage with its 

project tree shown on the Project pane. Please refer to section 4.2.2.  

Open 

To select and open a project. Or double-click the project in the list on the StartPage. After the project 

is opened, the Project pane will appear on the right-hand side. 

 

Delete 

To delete the selected project. Select the project that you want to delete from the list on the StartPage 

and click Delete, or right-click the project to open the Delete Project dialog. 

 

There are two delete options:  

1. Delete list items of start page: remove the selected project information from the project list on 

the StartPage but the project itself is not deleted. 

2. Delete project files and items, unrecoverable: remove the selected project information from the 

project list on the StartPage, and the project itself is completely deleted. 
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Item Description 

Modify 

To rename the project or rewrite the description. Click Modify or right-click to open the Modify 

Project dialog.  

 

Clean 
To refresh the project information on the StartPage. The project which has been deleted but still 

remains in the list will be cleaned.  

Backup 

To back up the selected project and save as a .dwdzip file.  

 

Restore To restore the backup projects. 

Preview To preview the project operation on local devices. 

Open Project 

Folder 
To open the folder in which the selected project is.  
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 Operations on the NewProject node 

After creating a project, the Project pane will appear on the right-hand side, displaying the project 

tree. Right-click the project name to open the context menu as shown below. 

 

Item Description 

Open Project Folder To open the folder in which the selected project is.  

Copy Project Path To copy the storage path of the project. 

Rename To modify the project name. 

Password  

To set a password for the project.  

Right-click the project name and select Password, then the dialog below will pop up. 

 

1. OldPassword: enter the current password (if you are setting a password for the first time, 

leave it empty). 

2. NewPassword: set the new password. 

3. ConfirmPassword: enter the new password again. 

Afterwards, users will be requested to enter the password to open the project. 
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Item Description 

 

Close To close the current project. 

 Project Development Window 

On the Project pane, right-click Web Window and select New Web Window. Then a blank window for 

graphics drawing and editing will be created. 

 

Its components are based on the elements introduced in section 4.2.1. 
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4.3 Quick Access Toolbar 

The quick access toolbar involves the frequently used commands as listed in the table below. 

Icon Command Description 

 

Save To save the web window you are editing.  

 

SaveAll 

To save all the web windows and configurations in the project. 

Click the triangle right next to the SaveAll button to enable the AutoSave 

function, then set the interval as required.  

 

 

 
Undo 

To undo the previous action. Click the icon repeatedly to undo multiple 

steps in reverse order. 

 Redo To redo the last action that you have undone.  

 
Log in To attain user authentication from DIACloud by logging in. 

 

Help (F1) To find the files for help. 

 
Fold To show or hide the toolbar. 
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4.4 Menu Bar 

 File 

 

The File tab is for project management, including the following items.  

Item Description 

New To create a new project. 

Open To open a created project. 

Close To close the project that has been opened. 

About 

To browse the current version information of DIAWeb Designer. 
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 Start  

 

The Start tab is for project management and graphical interface design, which includes the position, layer, 

and other arrangements of graphics. The availability of each command in this tab is determined by the 

attribute of the selected graphics. When the mouse is placed over an icon, a tooltip will appear to explain its 

function. Please refer to the following sections for details. 

4.4.2.1 Project 

Icon Command Description 

 

New To create a new project.  

 

Open To open a created project. 

 

Preview To preview the project that is currently opened in the development environment. 

4.4.2.2 Clipboard 

Icon Command Description 

 

Cut To cut the selected object to the clipboard.  

 

Copy To copy the selected object to the clipboard. 

 

Paste To paste the selected object to the canvas. 

4.4.2.3 Arrangement 

Icon Command Description 

 

Align Left To left align two or more selected objects with the left edge of the first selected object. 

 

Align Center 
To vertically align the center of two or more selected objects with the center of the 

first selected object. 

 

Align Right 
To right align two or more selected objects with the right edge of the first selected 

object. 

 
Align Top 

To top align two or more selected objects with the top edge of the first selected 

object. 

 
Align Middle 

To horizontally align the center of two or more selected objects with the center of the 

first selected object. 
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Icon Command Description 

 
Align Bottom 

To align the bottom of two or more selected objects with the bottom edge of the first 

selected object. 

 

Distribute 

Vertical 
To align the vertical intervals between three or more selected objects. 

 

Distribute 

Horizontal 
To align the horizontal intervals between three or more selected objects. 

 
Same Center 

To align the center point of two or more selected objects with the center point of the 

first selected object. 

4.4.2.4 Size 

Icon Command Description 

 

Same Width 
To make the width of two or more objects the same as the width of the first selected 

object. 

 

Same Height 
To make the height of two or more objects the same as the height of the first selected 

object. 

 

Same Size 
To make the size of two or more objects the same as the size of the first selected 

object. 

4.4.2.5 Group 

Icon Command Description 

 

Group 
Where there are multiple objects on the canvas, group the selected objects into an 

assembly. 

 

Ungroup Ungroup an assembly into its component object. 

4.4.2.6 Layer  

Icon Command Description 

 

Bring to Front 
When there are multiple objects overlapped, click to move the selected one in front 

of all others. 

 

Send to Back 
When there are multiple objects overlapped, click to move the selected one behind 

all others. 

 

Bring Forward 
When there are multiple objects overlapped, click to move the selected one forward 

one layer. 

 
Send Backward 

When there are multiple objects overlapped, click to move the selected one back one 

layer.  
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4.4.2.7 Rotation  

Icon Command Description 

 

Rotate 

Clockwise 
To rotate the selected object 90 degrees right. 

 

Rotate Counter 

Clockwise 
To rotate the selected object 90 degrees left. 

 

Flip Vertical To flip the selected object along the x-axis of the center point (upside down).  

 

Flip Horizontal To flip the selected object along the y-axis of the center point (from left to right).   

 

  



  Chapter  1  In t roduct ion  

1_ 

4.4.2.8 Canvas 

Icon Command Description 

 

Show  

Grid Line 
To show or hide the grid line of the canvas. 

 

Show Ruler To show or hide the main framework ruler of the canvas. 

 

Enable Snap 
If the snap function is enabled, the objects are created or moving along the 

grid lines. 

 

Enable Pan 
If the pan function is enabled, the hand tool appears for users to move the 

canvas. 

 
Zoom Ratio To set the zoom ratio for the current canvas.  

4.4.2.9 Edit 

In the development environment, open a project and click the Find and Replace button or press Ctrl + F to 

bring out the dialog. 

 

In the Find Condition section, only Project is available in Find Range and so as Variable in Find Type. 

Specify the contents you want to search for and click Find to see the results with green background. The 

Search Count is shown at the bottom-left corner. 
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As the Find Type: Variable requests exact matches for the content you enter, it is suggested to click  

next to the search box to select a variable from the list.  

 

As for the replace function, check the box in front of the address to be replaced first and then specify the 

Replace Content. Click Replace to see a pop-up for double confirmation. Click Yes to continue or No to 

close. 
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In the example, Var.Local.Variable12 is substituted for Var.Local.Variable11. 

 

 

4.4.2.10 Parameter Settings 

This is for language settings in the development environment. Three languages are supported: Simplified 

Chinese, Traditional Chinese, and English. Click Parameter Settings > Language Settings and select the 

language to switch. The language settings take effect after the software restarts. 
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 View  

In the View tab, users can select to open the particular configuration windows such as Project, Toolbox, 

Gallery, etc.   

 

Icon Command Description 

 
StartPage To open the StartPage pane. 

 

Project To open the Project pane. 

 
Object To open the Object pane. 

 
Toolbox To open the Toolbox pane. 

 
Gallery To open the Gallery pane. 

 
ErrorList To open the ErrorList pane. 

 
Restore Layout To restore the layout of the overall interface. 
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 IIoT 

The commands in the IIoT tab are used for binding the project with a template in DIACloud or uploading the 

local project up to DIACloud, achieving data synchronization between the local project and the cloud server. 

 

4.4.4.1 Download Data 

To synchronize the project data with DIACloud, click Download Data to retrieve data from DIACloud. Then, 

the dialog below will appear. Please log in first and bind a template for the project prior to this step. 

 

Check the box in front of CloudTags then click OK. Data synchronization is started. The result is displayed as 

in the dialog below.  
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Click OK to finish. 

If the bound template is locked due to billing issues, the following window will pop up:  

 

User needs to log in to the DIACloud platform to recharge it before using it. The DIACloud platform login 

URL is demonstrated as follow:  

https://hms.diacloudsolutions.com  

After logging in as a user, click My Account on the left to open the recharge portal and perform recharge 

operations:  

 

4.4.4.2 Upload Data 

This is to upload the project data to DIACloud. Click Upload Data with the Sync to DIACloud dialog popping 

up.  

Please log in first and bind a template for the project prior to this step.  

https://hms.diacloudsolutions.com/
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Click Upload and the dialog below will appear after the project is successfully uploaded. 

 

Click OK and you will be directed to the login page of DIACloud. 
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After login, you can run the project on DIACloud. 
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If the bound template is locked due to billing issues, the following window will pop up:  

 
User needs to log in to the DIACloud platform to recharge it before using it. The DIACloud platform login 

URL is demonstrated as follow:  

https://hms.diacloudsolutions.com  

After logging in as a user, click My Account on the left to open the recharge portal and perform recharge 

operations:  

 

 

4.4.4.3 Bind Template 

Template binding is necessary for uploading the project to DIACloud. Click BindTemplate, the Select Project 

Template dialog will appear. 

https://hms.diacloudsolutions.com/
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Item Description 

Template Name Enter the keyword to search for a template. 

Model Select a device using the drop-down list.  

Find To start searching based on the template name and model provided. 

Customer Customer information 

Comment Note  

Select the template and click OK. The following dialog appears. Click OK again to complete template binding. 

 



  Chapter  1  In t roduct ion  

1_ 

If the template is bound, an icon will appear on the right side of the template, indicating 

that the current template has been locked, as shown below:  

  

User needs to log in to the DIACloud platform to recharge it before using it. The DIACloud platform login 

URL is demonstrated as follow:  

https://hms.diacloudsolutions.com  

After logging in as a user, click My Account on the left to open the recharge portal and perform recharge 

operations:  

 
  

https://hms.diacloudsolutions.com/
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4.5 Context Menu for Canvas 

Right-click on the blank space of the canvas in the web window tab to bring out the context menu as shown 

below. 

 

Item Description 

Property To open the Property Edition dialog. 

Cut To cut the selected object to the clipboard.  

Copy To copy the selected object to the clipboard. 

Paste To paste the selected object to the canvas. 

Delete To remove the selected object from the canvas. 

SelectAll To select all objects on the canvas. 

Group Where there are multiple objects on the canvas, group the selected objects into an assembly. 

Arrangement To align or distribute the selected objects in different ways. 

Dimensions To modify the size of the selected objects in different ways. 

Layer To change the layering of the selected objects in different ways. 

Rotation To rotate the selected objects in different ways. 
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4.6 Keyboard Shortcuts 

Keyboard shortcuts are keys or combinations of keys that serve as an alternative way to give commands that 

you typically do with a mouse. The following table lists the available shortcuts in DIAWeb Designer. 

Shortcut Command 

Ctrl ＋ O Open a project 

Ctrl ＋ N Create a new project 

Ctrl ＋ R Preview the project 

F11 Maximize the window / Exit full screen mode 

Ctrl ＋ C Copy 

Ctrl ＋ X Cut 

Ctrl ＋ V Paste 

Ctrl ＋ Z Undo  

Ctrl ＋ Y Redo 

Ctrl ＋ S Save  

Ctrl ＋ G Group 

Ctrl ＋ U Ungroup 

Delete Delete 

↑ Move up 

↓ Move down 

← Move left 

→ Move right 
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4.7 Toolbox 

On the Toolbox pane, it provides the basic graphics, controls, and toolbar designer as shown in the figure 

below. 
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4.8 Gallery 

On the Gallery pane, it provides the frequently used graphic models. Users can also add self-defined or 

customized items to the gallery. 
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4.9 Project 

On the Project pane, it displays the directory where all the function nodes are listed hierarchically. The nodes 

serve as the manager and entrance to access functions and information related to project configuration. 

Right-click or double-click any of the nodes to proceed with related configurations.  

If there are sub-items under a root node, you will see a  in front of the entry. Click  to expand all the 

sub-items and double-click the selected item to open it on the canvas for further configuration. 

 

4.10 Object 

On the Project pane, it lists all the objects on the currently displayed canvas. Click any of the object in the list 

and the corresponding graphic on the canvas is selected. 
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4.11 Property Edition 

In the Property Edition dialog, users can manage the property, animation, and event of the graphic. Double-

click any graphic on the canvas or right-click it and select Property to open the dialog. 

 Property 

In the Property tab, users can modify the properties of the graphic including its name, appearance, layout, 

etc.  
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 Animation 

In the Animation tab, users can configure animations for the graphic. The configuration requires connecting 

relevant properties and variables. 
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 Event 

In the Event tab, users can manage events for the graphic. The configuration involves movements of the 

mouse and requires relevant variables to complete. 

 

 

 

Chapter 5 Variable Dictionary 

 

5.1 Overview 

To manage and present the on-site operation in real time, projects created in DIAWeb Designer involve a 

variety of variables and data interactions. 

There are three types of variables in DIAWeb Designer, which are system variables, local variables (local tags), 

and cloud variables (cloud tags). System variables are variables that come with the software system and 

cannot be modified. 

Local tags and cloud tags are project variables, namely, user-defined variables in the project, which are 

generally managed by the Variable Dictionary. 

Variable Dictionary provides unified and centralized management of all variables in the project; Local Tags 

can be added, deleted, copied, pasted, imported, exported, retrieved and so on, while Cloud Tags are 

synchronized with the templates in DIACloud and cannot be revised. 

 System Variables: Fixed variables that come with the system; there are 11 system variables in 

DIAWeb Designer, which can be directly called by users. 

2 5 
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5.2 Local Tags 

Local tags are values that can be changed at any time in the project, which play a crucial part in system data 

exchange. Information about local tags is introduced in this section. 
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Item Description 

Name 

To specify the name of the local variable. The naming rules are as follows:  

1. Consist of letters, numbers, Chinese characters, and underscores; must begin with a 

letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters such as 

@$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other created local variables. 

6. Only support names in traditional Chinese, simplified Chinese, or English. 

Variable Type 

To define the variable type. There are three types:  

1. Text: string (maximum length: 2000 bytes) 

2. Digital: False / True 

3. Analog: int / float 

Initial Value To set the initial value of the variable. 

Minimum Value / 

Maximum Value 
To specify the range of value (only available for analog variables). 

Decimal Digit To specify the decimal place (only available for analog variables). 

Read and Write Type To set the read and write type: read and write (default) or read only. 

Description To add more information on the variable. 
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5.3 Cloud Tags 

Cloud tags are values synchronized with the templates in DIACloud and cannot be revised. Information about 

cloud tags is introduced in this section. 

 

Item Description 

Name The variable name is case-sensitive. 

Variable Type 

There are three variable types:  

1. Text: string (maximum length: 2000 bytes) 

2. Digital: False / True 

3. Analog: int / float 

Initial Value The initial value of the variable. 

Retentive Value 
If the box is checked, the initial value will be set as the last obtained value at the end of system 

operation; otherwise, it will remain unchanged. 

Minimum Value / 

Maximum Value 
The range of value for the variable (only available for analog variables). 

Decimal Digit The decimal place of the variable (only available for analog variables). 

Read and Write Type The read and write type: read and write, write only or read only. 

Description To add more information on the variable. 
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5.4 Toolbar   

 

The following table lists the toolbar items and descriptions. 

c Description 

Add 
To add a new variable.  

 

Insert 
To add a new variable by inserting it before the selected variable. 

 

Delete 
To delete the selected variables. 

 

Batch Add To add multiple variables in a batch. 

Import To import a variable table. 

Export To export the current variable table. 

KeyWord To provide a keyword for searching. 

Search To start searching based on the keyword provided 

 Add: On the Project pane, click LocalTags under Variable Dictionary to open the setting window. 

Then click Add to add a default variable called Variable in the table. 

 

 Insert: Select Variable1 in the following table and click Insert. The new variable Variable3 is then 

added before Variabel1. 
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 Delete: Select Variable1 and click Delete. Variable1 is removed from the table. 
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 Batch Add: Click Batch Add to add multiple variables at a time.  
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 Import: DIAWeb Designer allows import of variables in .xls file format.  

Click Import on the LocalTags tab and select the file in which the variables are correct and valid 

to input.  

 

 Export: Click Export and specify the storage location to save the variables in .xls file format.   

 



  Chapter  1  In t roduct ion  

1_ 
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 Search: With several variables created, enter a keyword and click Search. The table will only 

display variables that match the keyword. If no keyword is input, the table will display all variables. 

Enter variable names only in the KeyWord box 
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5.5 Variable Reference Browser 

The Variable Reference Browser dialog is for viewing all the references of variables in Variable Dictionary, 

allowing users to check whether the variables are referenced and the referenced path. 

On the Project pane, right-click Variable Dictionary and select Variable Reference Browser. 

 

The following dialog appears. 
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1. On the left is the directory of variable dictionary, and the right side displays the reference information. 

2. In the directory, the variables marked with a yellow circle are referenced while those with a grey circle 

are not. 

3. Select the variable you would like to check in the directory, and view the corresponding information 

on the right pane where all the objects that have referenced the variable are listed in tree diagram. It 

helps locate the web window where the objects are in the project. 

4. Click the box at the top left corner to open the drop-down list for filtering variables.  
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5.6 Variable Substitution  

The Variable Substitution dialog is for replacing the referenced variable which is selected with a new variable.  

On the Project pane, right-click Variable Dictionary and select Variable Substitution. 

 

 

Click  next to the OriginalVariable box to select the variable to be replaced. The selected variable must 

have been referenced, or the hierarchical list below will not appear.  

Then click  next to the NewVariable box to select the variable to be the substitute. Check the variables 

to be replaced in the hierarchical list (select all by default) or click Select All to choose all the variables. Click 

Replace. 
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The result is shown below. 
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5.7 Variable Statistics 

The Variable Statistics dialog displays the total number of variables and their application in the project. 

On the Project pane, right-click Variable Dictionary and select Variable Statistics. 
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5.8 Variable Browser 

In the Variable Browser dialog, it displays all variables in the Variabel Dictionary. Many functions in the 

project require the use of variables. Open the Variable Browser dialog as shown below to search for the 

desired variables when necessary.  

 

The left is the directory of variable dictionary. Click LocalTags to check all variables in this category on the 

right side. Select the desired variable and click OK, or double-click the desired variable directly to use it. 

  



  Chapter  1  In t roduct ion  

1_ 

 Toolbar 

Item Description 

TypeFilter 

The background of the variable type turns blue when it is selected with all the variables of this type 

in the variable dictionary being listed in the table below. The variables of the type that is not 

selected will not appear. 

1. View Analog only 

 

2. View Analog and Digital 
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Item Description 

ReadWriteFilter 

Users can select the read and write type in the drop-down list. The table below only shows the 

variables that match. 

1. View Readable only 

 

2. View Writeable only 

 

 

NameFilter Type in a keyword to search for the variables that match. 
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5.9 Expression 

An expression is a combination of digits, operators, separators (e.g. brackets), variables, etc. arranged in a 

meaningful way that can produce a value. It is used to perform logical, arithmetic and relational operations 

to producte values for animation, event and script configurations, satisfying the implementation of certain 

functions in the project.  

Here are some commonly used operators:  

Type 
Operat

or 
Operation Example Result Order 

Arithmetic 

operators 

^ 
Raise a number to the 

power of an exponent. 
5^2 25 

From the 

highest to the 

lowert 

(relational 

operators 

have the same 

precedence), 

the order can 

be changed 

using 

parentheses 

“()”. 

 

* Multiply two numbers. 80*2 160 

/ 

Divide two numbers and 

return a floating-point 

result. 

5/3 2.5 

\ 
Divide two numbers and 

return an integer result. 
20\6 3 

Mod 

Divide two numbers and 

return only the 

remainder. 

20Mod6 2 

+ Sum two numbers. 50+50.1 100.1 

- 

Find the difference 

between two numbers or 

to denote negative 

values. 

50-50.1 -0.1 

String 

operators 

& 
Combine two strings to 

form one string (use & 

operator to force string 

concatenation). 

"stu"&"dent"; 

"1"& “2” 

student; 

12 

+ "1"+"2" 12 

Relational 

(comparison) 

operators 

<  Less than 4<7 True 

<= Less than or equal 39<=10 False 

>  Greater than "abc">"abced" False 

>= Greater than or equal 39>=10 True 

= Equal to "A"="a" False 

<>  Not equal to  9<>8 True 
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Type 
Operat

or 
Operation Example Result Order 

Logical 

operators 

Not 
Returns True when the 

expression is not true. 

Not 39>10  

Not 10>39 

False 

True 

And 

Returns True when 

expression 1 and 

expression 2 are true. 

39>10 And 

8>10 
False 

Or 
Returns True when either 

expression is true. 
39>10 Or 8>10 True 

Xor 

Returns True when either 

expression 1 or 

expression 2 is true, but 

not both. 

1 Xor 1 

0 Xor 1 

1 Xor 0 

1 Xor 1 

False 

True 

True 

False 

Eqv 

Returns True when both 

expression 1 and 

expression 2 are true, or 

when both expression 1 

and expression 2 are 

false. 

0 Eqv 0 

0 Eqv 1 

1 Eqv 0 

1 Eqv 1 

True 

False 

False 

True 

Imp 

Perform a logical 

implication on two 

expressions. 

0 Imp 0 

0 Imp 1 

1 Imp 0 

1 Imp 1 

True 

True 

False 

True 

The figures below are the expression dialogs used when configuring an animation.  
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 Section Description 

1 Project To provide a directory of system variables, local varialbes and cloud variables.  

2 Script Library To provide system functions. 

3 Variable List To list the filtered variables. Double-click to select the desired variable. 

4 
Variable 

Property List 

To display the properties of the selected variable. Double-click to select and use the 

property. 

5 Expression To edit expressions. 

6 

Operator 

and Number 

Keys 

To select and use the operators, digits and so on. 
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Chapter 6 Graphical Interface Development 

6.1 Overview 

Graphical interface development is to depict on-site facilities, equipment, and construction vividly on 

canvases in DIAWeb Designer software, constituting simulations of industrial sites. The data parameters of 

current equipment can be updated to DIAWeb Designer by uploading and downloading via DIACloud, 

allowing real-time data display in DIAWeb Designer for monitoring of on-site condition. 

Graphical interface development plays a crucial part in realization of the monitoring and control system and 

is regarded as the core of the entire project. By integrating system resources to fulfill project requirements, it 

enables the windows in DIAWeb Designer to serve as the platform for live data display and system control. 

The basic elements that compose the graphical interface are called graphics or objects. DIAWeb Designer 

provides canvases, basic graphics, controls, graphic models, etc. for drawing; meanwhile, it is equipped with 

windows for property, animation and event configurations of graphics, making it a comprehensive platform 

for developing graphical interfaces. 

6.2 Web Window 

6.2.1 Operations on the Web Window Node 

Web windows are the core of on-site simulation, parameter configuration and data display as well as the 

foundation of real-time visualization in DIAWeb Designer. 

10. New Web Window:  

On the Project pane, right-click Web Window and select New Web Window.  

 



  Chapter  1  In t roduct ion  

1_ 

A sub-item is created under the Web Window node with a default name, and its canvas is shown in 

the canvas workspace. 

 

11. New Web Window Group:  

To group and manage web windows. In the project users can group windows of different types and 

purposes to manage them. 

On the Project pane, right-click Web Window and select New Web Window Group. 

 

Then a sub-item is created under the Web Window node with a default group name. 
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12. Export Web Window: 

To export web windows to a designated location. On the Project pane, right-click Web Window and 

select Export Web Window. 

 

13. Import Web Window:  

To import web windows to the project as sub-items under the Web Window node. On the Project 

pane, right-click Web Window and select Import Web Window. 
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14. Paste:  

To paste the copied web window to the Web Window node. On the Project pane, right-click Web 

Window and select Paste. 
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6.2.2 Web Window Operation 

5. Open a web window:  

When a web window is newly created, it is automatically opened in the canvas workspace. If it is an 

existed web window, double-click the web window you want to open on the Project pane.  

More than one web window can be opened in the canvas workspace at the same time.  

 

6. Close a web window: 

There are several ways to close a web window.  

a. In the canvas workspace, click  next to the web window name to close it 

 

  



  Chapter  1  In t roduct ion  

1_ 

b. In the canvas workspace, right-click the web window name to select the way to close: 

 Close: close the current web window. 

 Close All But This: close all the other web windows except for the current one. 

 Close All: close all web windows. 

 

7. Copy a web window: 

On the Project pane, right-click the web window to copy and select Copy. Save the configuration of 

the web window before copying. 
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To paste the copied web window, right-click Web Window and select Paste.  

 

8. Delete a web window: 

On the Project pane, right-click the web window to delete and select Delete.  
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9. Rename a web window: 

On the Project pane, right-click the web window to rename and select Rename. Then enter the new 

name. 

 

Naming rule:  

a. Consist of letters, numbers, Chinese characters, or underscores; must begin with a letter or 

Chinese character. 

b. Not case-sensitive. 

c. Cannot contain spaces, periods, exclamation marks, or special characters such as @$#?*&. 

d. Cannot exceed 100 characters, with no more than 25 Chinese characters. 

e. Cannot share the same name with other created web windows, project or script keywords within 

the same project. 

f. Only supports names in traditional Chinese, simplified Chinese, or English. 
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6.2.3 Web Window Group 

Users can create multiple web windows under a web window group. Right-click the selected web window 

group and select New Web Window. 

 

Item Description 

New Web Window Group 
To create a new web window group under the web window group.  

Right-click the selected web window group and select New Web Window Group. 

Export Web Window 
To export web windows under the web window group to a designated location.  

Right-click the selected web window group and select Export Web Window. 

Import Web Window 
To import web windows to the selected web window group.  

Right-click the selected web window group and select Import Web Window. 

Paste 
To paste the copied web windows to the current web window group.  

Right-click the selected web window group and select Paste. 

Delete 
To delete a web window group.  

Right-click the web window group to delete and select Delete. 

Rename 

Follow the naming rule of web window to rename a web window group.  

Right-click the web window group to rename and select Rename. Then enter the new 

name.  
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6.2.4 Web Window Configuration 

Open a web window, right-click on the blank space of the canvas and select Property.  

 

Item Description 

Name To set the name of the web window. The name is the same as shown on the Project pane. 

Title 

To set the title name when the web window is displayed as a dialog. For example, script 

operation.  

 

Fill Color 
To set the background of the canvas, including styles such as monochrome, picture, gradient, 

radiation, etc. 

Location To set the location of the web window at runtime. 

Size To set the width and height of the canvas (unit: pixels). 
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6.3 Introduction to Basic Graphics 

6.3.1 Line 

 

Open a web window, select Basic Graphics > Line on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag and drop to draw 

a line. Press Shift key while dragging to draw a vertical or horizontal line. Repeat the steps to draw another 

one. 

 Introduction  

 

Users can click the line to put it in edit mode as in the image above. 

Points 1 and 2 are for size adjustment; point 3 is for skewing; point 4 is for rotation and point 5 is the 

center point. 

 Property  

The property of a line consists of base, appearance, text, layout, and transform. 
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Item Description 

Base 

Name 

The name of the graphic in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the graphic is shown or hidden at runtime.  

Lock 

If the graphic is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked graphic.  

Appearance Line Style 

To set the style of the line, including line type, width, dash style, start and end 

vertices, color of line stroke and so on. The width field ranges from 0 to 256 and 

may contain two decimal places. As for the color setting, only monochrome is 

supported. 

You can see the preview on the right side. 
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Item Description 

 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 
Location 

To set the X and Y coordinates of the graphic in the web window. The values are 

kept as integers only. 

 

Length To set the length of the graphic. The value is kept as integer only (unit: pixels). 

Transform 
Center Point 

To set the ratio of the X and Y coordinates of the graphic’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the graphic (unit: degree). 
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6.3.2 Rectangle 

 

Open a web window, select Basic Graphics > Rectangle on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to draw a rectangle. Repeat the steps to draw another one. 

 Introduction  

 

Users can click the rectangle to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing. 

 Property  

The property of a rectangle consists of base, appearance, text, layout, and transform. 
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Item Description 

Base 

Name 

The name of the graphic in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the graphic is shown or hidden at runtime.  

Security 
To set permissions for operation on the graphic. Assign the graphic to one or more 

securities for user access management.  

Lock 

If the graphic is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked graphic.  

Appearance 
Horizontal Fill 

Direction 

To select the direction when filling the graphic horizontally (from left to right / from 

right to left / from the middle to the edge). 
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Item Description 

Vertical Fill 

Direction 

To select the direction when filling the graphic vertically (from up to down / from 

down to up / from the middle to the edge).  

Horizontal Fill 

Ratio 

To set the ratio of the width of the filled area to the width of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Vertical Fill 

Ratio 

To set the ratio of the height of the filled area to the height of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Line Style 

To set the line style, including line type, width, dash style, join, color of line stroke 

and so on. The width field ranges from 0 to 256 and may contain two decimal places. 

As for the color setting, only monochrome is supported. 

 

Fill Color 
To set the fill color of the graphic. It supports styles such as monochrome, pattern, 

picture, gradient, and radiation. 

Opacity 

To set the opacity of the graphic. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the graphic in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the graphic. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the graphic’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the graphic (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 
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Item Description 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.3.3 Rounded Rectangle 

 

Open a web window, select Basic Graphics > Rounded Rectangle on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to draw a rounded rectangle. Repeat the steps to draw another one. 

 Introduction  

 

Users can click the rounded rectangle to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing. 

 Property  

The property of a rounded rectangle consists of base, appearance, text, layout, and transform. 
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Item Description 

Base 

Name 

The name of the graphic in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the graphic is shown or hidden at runtime.  

Security 
To set permissions for operation on the graphic. Assign the graphic to one or more 

securities for user access management.  

Lock 

If the graphic is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked graphic.  

Appearance 
Horizontal Fill 

Direction 

To select the direction when filling the graphic horizontally (from left to right / from 

right to left / from the middle to the edge). 
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Item Description 

Vertical Fill 

Direction 

To select the direction when filling the graphic vertically (from up to down / from 

down to up / from the middle to the edge).  

Horizontal Fill 

Ratio 

To set the ratio of the width of the filled area to the width of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Vertical Fill 

Ratio 

To set the ratio of the height of the filled area to the height of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Border Radius 
To set the curvature radius of the rounded corners. The radius cannot exceed half 

of the minimum side length of the graphic. 

Line Style 

To set the line style, including line type, width, dash style, color of line stroke and so 

on. The width field ranges from 0 to 256 and may contain two decimal places. As 

for the color setting, only monochrome is supported. 

 

Fill Color 
To set the fill color of the graphic. It supports styles such as monochrome, pattern, 

picture, gradient, and radiation. 

Opacity 

To set the opacity of the graphic. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the graphic in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the graphic. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the graphic’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the graphic (unit: degree). 

Skew Angle X To set the angle of skewing in the horizontal direction. The field ranges from -80 to 
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Item Description 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.3.4 Ellipse 

 

Open a web window, select Basic Graphics > Ellipse on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to draw an ellipse. Repeat the steps to draw another one. 

 Introduction  

 

Users can click the ellipse to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing. 

 Property  

The property of an ellipse consists of base, appearance, text, layout, and transform. 
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Item Description 

Base 

Name 

The name of the graphic in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the graphic is shown or hidden at runtime.  

Security 
To set permissions for operation on the graphic. Assign the graphic to one or more 

securities for user access management.  

Lock 

If the graphic is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked graphic.  

Appearance 
Horizontal Fill 

Direction 

To select the direction when filling the graphic horizontally (from left to right / from 

right to left / from the middle to the edge). 
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Item Description 

Vertical Fill 

Direction 

To select the direction when filling the graphic vertically (from up to down / from 

down to up / from the middle to the edge).  

Horizontal Fill 

Ratio 

To set the ratio of the width of the filled area to the width of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Vertical Fill 

Ratio 

To set the ratio of the height of the filled area to the height of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Line Style 

To set the line style, including line type, width, dash style, color of line stroke and so 

on. The width field ranges from 0 to 256 and may contain two decimal places. As 

for the color setting, only monochrome is supported. 

 

Fill Color 
To set the fill color of the graphic. It supports styles such as monochrome, pattern, 

picture, gradient, and radiation. 

Opacity 

To set the opacity of the graphic. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the graphic in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the graphic. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the graphic’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the graphic (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 
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Item Description 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.3.5 Polyline 

 

Open a web window, select Basic Graphics > Polyline on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point and click, then move the cursor to another point and 

click to draw a polyline. Pressing Shift key while moving allows drawing at angles in multiples of 15 degrees. 

Click once to create a vertex and double-click to finish drawing. Repeat the steps to draw another polyline. 

 Introduction  

 

Users can click the polyline to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing.  

Right-click the polyline and select Anchor Edit to put it in anchor edit mode. 
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Point 1 is the starting point, points 2 and 3 are vertices of the polyline, and point 4 is the endpoint.  

When you hover the mouse over the point, the cursor is changed into , which means you can 

move the point to change the shape of the polyline.  

To exit anchor edit mode, right-click the polyline and select Exit Anchor Edit as shown below. Then 

the graphic is back into edit mode. 

 

 Property  

The property of a polyline consists of base, appearance, text, layout, and transform. 
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Item Description 

Base 

Name 

The name of the graphic in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the graphic is shown or hidden at runtime.  

Lock 

If the graphic is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked graphic.  
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Item Description 

Appearance Line Style 

To set the line style, including line type, width, dash style, start and end vertices, join, 

color of line stroke and so on. The width field ranges from 0 to 256 and may contain 

two decimal places. As for the color setting, only monochrome is supported. 

 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the graphic in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the graphic. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the graphic’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the graphic (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 

6.3.6 Polygon 

 

Open a web window, select Basic Graphics > Polygon on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point and click, then move the cursor to another point and 

click to draw one side of a polyline. Click once to create a vertex and double-click to finish drawing. Repeat 

the steps to draw another polygon. 

 Introduction  
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Users can click the polygon to put it in edit mode as in the image above.  

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing. 

Right-click the polygon and select Anchor Edit to put it in anchor edit mode. 
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When you hover the mouse over the point, the cursor is changed into , which means you can 

move the point to change the shape of the polygon.  

To exit anchor edit mode, right-click the polygon and select Exit Anchor Edit as shown below. Then 

the graphic is back into edit mode. 
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 Property  

The property of a polygon consists of base, appearance, text, layout, and transform. 

 

Item Description 

Base 

Name 

The name of the graphic in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the graphic is shown or hidden at runtime.  

Security 
To set permissions for operation on the graphic. Assign the graphic to one or more 

securities for user access management.  
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Item Description 

Lock 

If the graphic is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked graphic.  

Appearance 

Horizontal Fill 

Direction 

To select the direction when filling the graphic horizontally (from left to right / from 

right to left / from the middle to the edge). 

Vertical Fill 

Direction 

To select the direction when filling the graphic vertically (from up to down / from 

down to up / from the middle to the edge).  

Horizontal Fill 

Ratio 

To set the ratio of the width of the filled area to the width of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Vertical Fill 

Ratio 

To set the ratio of the height of the filled area to the height of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Line Style 

To set the line style, including line type, width, dash style, join, color of line stroke 

and so on. The width field ranges from 0 to 256 and may contain two decimal places. 

As for the color setting, only monochrome is supported. 

 

Fill Color 
To set the fill color of the graphic. It supports styles such as monochrome, pattern, 

picture, gradient, and radiation. 

Opacity 

To set the opacity of the graphic. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the graphic in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the graphic. The values are kept as integers only (unit: 

pixels). 
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Item Description 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the graphic’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the graphic (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 

6.3.7 Bezier Curve 

 

Open a web window, select Basic Graphics > Bezier Cruve on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point and click, then move the cursor to another point and 

click to draw a Bezier curve. Click once to create a vertex and double-click to finish drawing. Repeat the steps 

to draw another Bezier curve. 

 Introduction  

 

Users can click the Bezier curve to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing.  

Right-click the Bezier curve and select Anchor Edit to put it in anchor edit mode. 
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Point 1 is the starting point, points 2 and 3 are vertices of the curve, and point 4 is the endpoint.  

When you hover the mouse over the point, the cursor is changed into , which means you can 

move the point to change the shape of the Bezier curve. 

To exit anchor edit mode, right-click the Bezier curve and select Exit Anchor Edit as shown below. 

Then the graphic is back into edit mode. 
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 Property  

The property of a Bezier curve consists of base, appearance, text, layout, and transform. 

 

Item Description 

Base 
Name 

The name of the graphic in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the graphic is shown or hidden at runtime.  
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Item Description 

Lock 

If the graphic is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked graphic.  

Appearance Line Style 

To set the line style, including line type, width, dash style, color of line stroke and so 

on. The width field ranges from 0 to 256 and may contain two decimal places. As 

for the color setting, only monochrome is supported. 

 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the graphic in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the graphic. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the graphic’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the graphic (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 

  



  Chapter  1  In t roduct ion  

1_ 

6.3.8 Closed Curve  

 

Open a web window, select Basic Graphics > Closed Curve on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point and click, then move the cursor to another point and 

click to draw one side of a closed curve. Click once to create a vertex and double-click to finish drawing. 

Repeat the steps to draw another closed curve. 

 Introduction  

 

Users can click the closed curve to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing. 

Right-click the closed curve and select Anchor Edit to put it in anchor edit mode. 



  Chapter  1  In t roduct ion  

1_ 

  

 

When you hover the mouse over the point, the cursor is changed into , which means you can 

move the point to change the shape of the closed curve.  

To exit anchor edit mode, right-click the closed curve and select Exit Anchor Edit as shown below. 

Then the graphic is back into edit mode. 
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 Property  

The property of a closed curve consists of base, appearance, text, layout, and transform. 

 

Item Description 

Base 

Name 

The name of the graphic in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the graphic is shown or hidden at runtime.  

Security 
To set permissions for operation on the graphic. Assign the graphic to one or more 

securities for user access management.  
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Item Description 

Lock 

If the graphic is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked graphic.  

Appearance 

Horizontal Fill 

Direction 

To select the direction when filling the graphic horizontally (from left to right / from 

right to left / from the middle to the edge). 

Vertical Fill 

Direction 

To select the direction when filling the graphic vertically (from up to down / from 

down to up / from the middle to the edge).  

Horizontal Fill 

Ratio 

To set the ratio of the width of the filled area to the width of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Vertical Fill 

Ratio 

To set the ratio of the height of the filled area to the height of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Line Style 

To set the line style, including line type, width, dash style, color of line stroke and so 

on. The width field ranges from 0 to 256 and may contain two decimal places. As 

for the color setting, only monochrome is supported. 

 

Fill Color 
To set the fill color of the graphic. It supports styles such as monochrome, pattern, 

picture, gradient, and radiation. 

Opacity 

To set the opacity of the graphic. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the graphic in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the graphic. The values are kept as integers only (unit: 

pixels). 
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Item Description 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the graphic’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the graphic (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 

6.3.9 Arc 

 

Open a web window, select Basic Graphics > Arc on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to draw an arc. Repeat the steps to draw another one. 

 Introduction  

 

Users can click the arc to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing.  

Right-click the arc and select Anchor Edit to put it in anchor edit mode. 
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Points 1 and 2 are for arc length adjustment.  

When you hover the mouse over the point, the cursor is changed into , which means you can 

move the point to change the arc length. 

To exit anchor edit mode, right-click the arc and select Exit Anchor Edit as shown below. Then the 

graphic is back into edit mode. 
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 Property  

The property of an arc consists of base, appearance, text, layout, and transform. 

 

Item Description 

Base 
Name 

The name of the graphic in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the graphic is shown or hidden at runtime.  
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Item Description 

Lock 

If the graphic is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked graphic.  

Appearance 

Starting Angle 
To set the starting angle. The field ranges from 0 to 359 and is kept as integer only. 

The default value is 0 (unit: degree). 

Scan Angle 

To set the angle that the endpoints of the arc subtend at the circle’s center. The field 

ranges from 0 to 359 and is kept as integer only. The default value is 260 (unit: 

degree). 

Line Style 

To set the line style, including line type, width, dash style, color of line stroke and so 

on. The width field ranges from 0 to 256 and may contain two decimal places. As 

for the color setting, only monochrome is supported. 

 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the graphic in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the graphic. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the graphic’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the graphic (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.3.10 Arch 

 

Open a web window, select Basic Graphics > Arch on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to draw an arch. Repeat the steps to draw another one. 

 Introduction  

 

Users can click the arch to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing. 

Right-click the arch and select Anchor Edit to put it in anchor edit mode. 
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Points 1 and 2 are for angle adjustment.  

When you hover the mouse over the point, the cursor is changed into , which means you can 

move the point to change the angle of the graphic. 

To exit anchor edit mode, right-click the arch and select Exit Anchor Edit as shown below. Then the 

graphic is back into edit mode. 
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 Property  

The property of an arch consists of base, appearance, text, layout, and transform. 

 

Item Description 

Base 
Name 

The name of the graphic in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the graphic is shown or hidden at runtime.  
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Item Description 

Security 
To set permissions for operation on the graphic. Assign the graphic to one or more 

securities for user access management.  

Lock 

If the graphic is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked graphic.  

Appearance 

Horizontal Fill 

Direction 

To select the direction when filling the graphic horizontally (from left to right / from 

right to left / from the middle to the edge). 

Vertical Fill 

Direction 

To select the direction when filling the graphic vertically (from up to down / from 

down to up / from the middle to the edge).  

Horizontal Fill 

Ratio 

To set the ratio of the width of the filled area to the width of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Vertical Fill 

Ratio 

To set the ratio of the height of the filled area to the height of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Starting Angle 
To set the starting angle. The field ranges from 0 to 359 and is kept as integer only. 

The default value is 0 (unit: degree). 

Scan Angle 

To set the angle that the endpoints of the arch subtend at the circle’s center. The 

field ranges from 0 to 359 and is kept as integer only. The default value is 260 (unit: 

degree). 

Line Style 

To set the line style, including line type, width, dash style, color of line stroke and so 

on. The width field ranges from 0 to 256 and may contain two decimal places. As 

for the color setting, only monochrome is supported. 

 

Fill Color 
To set the fill color of the graphic. It supports styles such as monochrome, pattern, 

picture, gradient, and radiation. 

Opacity 
To set the opacity of the graphic. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 
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Item Description 

full transparency. 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the graphic in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the graphic. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the graphic’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the graphic (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.3.11 Pie 

 

Open a web window, select Basic Graphics > Pie on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to draw a pie. Repeat the steps to draw another one. 

 Introduction  

 

Users can click the pie to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing. 

Right-click the pie and select Anchor Edit to put it in anchor edit mode. 
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Points 1 and 2 are for angle adjustment.  

When you hover the mouse over the point, the cursor is changed into , which means you can 

move the point to change the angle of the graphic. 

To exit anchor edit mode, right-click the pie and select Exit Anchor Edit as shown below. Then the 

graphic is back into edit mode. 
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 Property  

The property of a pie consists of base, appearance, text, layout, and transform. 

 

Item Description 

Base 
Name 

The name of the graphic in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the graphic is shown or hidden at runtime.  
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Item Description 

Security 
To set permissions for operation on the graphic. Assign the graphic to one or more 

securities for user access management.  

Lock 

If the graphic is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked graphic.  

Appearance 

Horizontal Fill 

Direction 

To select the direction when filling the graphic horizontally (from left to right / from 

right to left / from the middle to the edge). 

Vertical Fill 

Direction 

To select the direction when filling the graphic vertically (from up to down / from 

down to up / from the middle to the edge).  

Horizontal Fill 

Ratio 

To set the ratio of the width of the filled area to the width of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Vertical Fill 

Ratio 

To set the ratio of the height of the filled area to the height of the graphic. The field 

ranges from 0 to 1 and may contain two decimal places. The default value is 1. 

Starting Angle 
To set the starting angle. The field ranges from 0 to 359 and is kept as integer only. 

The default value is 0 (unit: degree). 

Scan Angle 

To set the angle that the endpoints of the pie subtend at the circle’s center. The field 

ranges from 0 to 359 and is kept as integer only. The default value is 260 (unit: 

degree). 

Line Style 

To set the line style, including line type, width, dash style, color of line stroke and so 

on. The width field ranges from 0 to 256 and may contain two decimal places. As 

for the color setting, only monochrome is supported. 

 

Fill Color 
To set the fill color of the graphic. It supports styles such as monochrome, pattern, 

picture, gradient, and radiation. 

Opacity 
To set the opacity of the graphic. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 
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Item Description 

full transparency. 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the graphic in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the graphic. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the graphic’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the graphic (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.3.12 Pipe 

 

Open a web window, select Basic Graphics > Pipe on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point and click, then move the cursor to another point and 

click to draw a pipe. Pressing Shift key while moving allows drawing at angles in multiples of 15 degrees. 

Click once to create a vertex and double-click to finish drawing. Repeat the steps to draw another pipe. 

 Introduction  

 

Users can click the pipe to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing.  

Right-click the pipe and select Anchor Edit to put it in anchor edit mode. 
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Point 1 is the starting point, points 2 and 3 are vertices of the pipe, and point 4 is the endpoint.  

When you hover the mouse over the point, the cursor is changed into , which means you can 

move the point to change the shape of the pipe.  

To exit anchor edit mode, right-click the pipe and select Exit Anchor Edit as shown below. Then the 

graphic is back into edit mode. 
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 Property  

The property of a pipe consists of base, appearance, text, layout, and transform. 

 

Item Description 

Base 
Name 

The name of the graphic in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the graphic is shown or hidden at runtime.  
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Item Description 

Security 
To set permissions for operation on the graphic. Assign the graphic to one or more 

securities for user access management.  

Lock 

If the graphic is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked graphic.  

Appearance 

Liquid Color To set the color of the liquid inside the pipe. Only monochrome is supported. 

Liquid Width 
To set the width for the cross section of the liquid inside the pipe (i.e. the flow rate). 

The liquid width is always less than the width of the pipe. 

Pipe Color To set the color of the pipe. Only monochrome is supported. 

Pipe Width To set the width for the cross section of the pipe. 

Forward Flow 
To set the direction in which the liquid flows through the pipe. Check this option for 

forward flow or leave it unchecked for reverse flow. 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the graphic in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the graphic. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the graphic’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the graphic (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.4 Introduction to Window Controls 

6.4.1 Button 

 

Open a web window, select Window Controls > Button on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a button. Repeat the steps to create another one. 

 Introduction  

 

Users can click the button to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing.  

 Property  

The property of a button consists of base, appearance, text, layout, and transform. 
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Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Enable To enable or disable the control at runtime.  

Security 
To set permissions for operation on the control. Assign the control to one or more 

securities for user access management.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked control.  

Appearance Font Size 
To set the font style, font weight, font size, and italics for the content displayed on 

the control. 
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Item Description 

 

Font Color To set the font color. Only monochrome is supported.  

Border Color To set the border color of the control. Only monochrome is supported. 

Fill Color 

To set the fill color of the control. It supports styles such as monochrome, picture, 

gradient, and radiation. 

 

Opacity 

To set the opacity of the control. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Text 
Content To edit the content displayed on the control. Multiple languages are supported. 

Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 

Horizontal 

Alignment 
To horizontally align the content displayed on the control (left / center / right). 

Vertical 

Alignment 
To vertically align the content displayed on the control (top / center / bottom). 

Transform Center Point 
To set the ratio of the X and Y coordinates of the control’s center point relative to 

its width and height. The default value is 0.5, 0.5. 
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Item Description 

Rotate Angle To set the angle of rotation for the control (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.4.2 Check Box 

 

Open a web window, select Window Controls > Check Box on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a check box. Repeat the steps to create another one. 

 Introduction  

 

Users can click the check box to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing.  
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 Property  

The property of a check box consists of base, appearance, select item, text, layout, and transform. 

 

Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Enable To enable or disable the control at runtime.  

Security To set permissions for operation on the control. Assign the control to one or more 
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Item Description 

securities for user access management.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked control.  

Appearance 

Font Size 

To set the font style, font weight, font size, and italics for the content displayed on 

the control. 

 

Font Color To set the font color. Only monochrome is supported.  

Opacity 

To set the opacity of the control. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Select Item Checked To set the default as checked or unchecked. 

Text 
Content To edit the content displayed on the control. Multiple languages are supported. 

Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the control’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the control (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.4.3 Combo Box 

 

Open a web window, select Window Controls > Combo box on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a combo box. Repeat the steps to create another one. 

 Introduction  

 

Users can click the combo box to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing.  

 Property  

The property of a combo box consists of base, appearance, select item, text, layout, and transform. 
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Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Enable To enable or disable the control at runtime.  

Security 
To set permissions for operation on the control. Assign the control to one or more 

securities for user access management.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked control.  

Appearance Font Size To set the font style, font weight, font size, and italics for the content displayed on 
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Item Description 

the control. 

 

Font Color To set the font color. Only monochrome is supported.  

Border Color To set the border color of the control. Only monochrome is supported. 

Fill Color 

To set the fill color of the control. Only monochrome is supported. 

 

Opacity 

To set the opacity of the control. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 
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Item Description 

Select Item 

Sub Groups 

To edit the selectable items in the combo box. Click to open the Collection Editor 

dialog for editing. 

 

Button Description 

 

To add an option. 

 

To delete an option. 

 

To move the selected option to the top of the list. 

 

To move the selected option up. 

 

To move the selected option down. 

 

To move the selected option to the bottom of the list. 

 

Select Item 
To select an item from the sub-groups as the header of the combo box. Multiple 

languages are supported. 

Text Text 
To edit the text displayed when the combo box is closed without a selected item. 

Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 

Horizontal 

Alignment 
To horizontally align the content displayed on the control (left / center / right). 
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Item Description 

Vertical 

Alignment 
To vertically align the content displayed on the control (top / center / bottom). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the control’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the control (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.4.4 Label 

 

Open a web window, select Window Controls > Label on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a label. Repeat the steps to create another one. 

 Introduction  

 

Users can click the label to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing.  

 Property  

The property of a label consists of base, appearance, text, layout, and transform. 
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Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Enable To enable or disable the control at runtime.  

Security 
To set permissions for operation on the control. Assign the control to one or more 

securities for user access management.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked control.  
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Item Description 

Appearance 

Font Size 

To set the font style, font weight, font size, and italics for the content displayed on 

the control. 

 

Font Color To set the font color. Only monochrome is supported.  

Auto Scale To set whether the content scales with the size of the label border. 

Fill Color 

To set the fill color of the control. It supports styles such as monochrome, picture, 

gradient, and radiation. 

 

Opacity 

To set the opacity of the control. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Text 
Text To edit the content displayed on the control. Multiple languages are supported. 

Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 

Horizontal 

Alignment 
To horizontally align the content displayed on the control (left / center / right). 
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Item Description 

Vertical 

Alignment 
To vertically align the content displayed on the control (top / center / bottom). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the control’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the control (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.4.5 Text Box 

 

Open a web window, select Window Controls > Text Box on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a text box. Repeat the steps to create another one. 

 Introduction  

 

Users can click the text box to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing.  

 Property  

The property of a text box consists of base, appearance, text, layout, and transform. 
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Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Enable To enable or disable the control at runtime.  

Security 
To set permissions for operation on the control. Assign the control to one or more 

securities for user access management.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked control.  
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Appearance 

Font Size 

To set the font style, font weight, font size, and italics for the content displayed on 

the control. 

 

Font Color To set the font color. Only monochrome is supported.  

Border Color To set the border color of the control. Only monochrome is supported. 

Fill Color 

To set the fill color of the control. It supports styles such as monochrome, picture, 

gradient, and radiation. 

 

Opacity 

To set the opacity of the control. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Multi-line 

mode 

Check this option to wrap extra-long text into multiple lines. In multi-line mode, you 

can press Enter key to break a line; however, it is invalid to enter a line break by 

pressing Enter key when this option is not checked. 

Text 
Text To edit the content displayed on the control. Multiple languages are supported. 

Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 
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Horizontal 

Alignment 
To horizontally align the content displayed on the control (left / center / right). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the control’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the control (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.4.6 Password Box 

 

Open a web window, select Window Controls > Password Box on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a password box. Repeat the steps to create another one. 

 Introduction  

 

Users can click the password box to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing.  

 Property  

The property of a password box consists of base, appearance, text, layout, and transform. 
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Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Enable To enable or disable the control at runtime.  

Security 
To set permissions for operation on the control. Assign the control to one or more 

securities for user access management.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked control.  
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Appearance 

Font Size 

To set the font style, font weight, font size, and italics for the content displayed on 

the control. 

 

Font Color To set the font color. Only monochrome is supported.  

Border Color To set the border color of the control. Only monochrome is supported. 

Fill Color 

To set the fill color of the control. It supports styles such as monochrome, picture, 

gradient, and radiation. 

 

Opacity 

To set the opacity of the control. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Text 
Password To set the password. 

Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 

Horizontal 

Alignment 
To horizontally align the content displayed on the control (left / center / right). 
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Transform 

Center Point 
To set the ratio of the X and Y coordinates of the control’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the control (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.4.7 Date Time Picker 

 

Open a web window, select Window Controls > Date Time Picker on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a date time picker. Repeat the steps to create another one. 

 Introduction  

 

Users can click the date time picker to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing. As for point 11, it is the place where the date and time are 

displayed. 

 Property  

The property of a date time picker consists of base, appearance, date, layout, and transform. 
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Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Enable To enable or disable the control at runtime.  

Security 
To set permissions for operation on the control. Assign the control to one or more 

securities for user access management.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 
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Item Description 

locked control.  

Appearance 

Font Size 
To set the font style, font weight, font size, and italics for the content displayed on 

the control. 

Font Color To set the font color. Only monochrome is supported.  

Border Color To set the border color of the control. Only monochrome is supported. 

Fill Color To set the fill color of the control. Only monochrome is supported. 

Opacity 

To set the opacity of the control. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Date 

Date To set the initial date displayed.  

Time To set the initial time displayed. 

Start Date To set the minimum selectable date and time at runtime. 

End Date To set the maximum selectable date and time at runtime. 

Time Format 

To set the date and time format. There are six kinds of displays: 

yyyy/MM/dd HH:mm:ss 

yyyy-MM-dd HH:mm:ss 

yyyy/MM/dd 

yyyy-MM-dd 

HH:mm:ss 

HH:mm 

Layout 

Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the control’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the control (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.4.8 Image 

 

Open a web window, select Window Controls > Image on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create an image. Repeat the steps to create another one. 

 Introduction  

 

Users can click the image to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing.  

 Property  

The property of an image consists of base, appearance, text, layout, and transform. 
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Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Enable To enable or disable the control at runtime.  

Security 
To set permissions for operation on the control. Assign the control to one or more 

securities for user access management.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked control.  

Appearance Image Path To specify the image path. Click  to open the setting page. It supports various 
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image file formats such as jpg, jpeg, png, bmp, ico, wmf, emf, and so on. 

Opacity 

To set the opacity of the control. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Text Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the control’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the control (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.4.9 Nixie Tube 

 

Open a web window, select Window Controls > Nixie Tube on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a nixie tube. Repeat the steps to create another one. 

 Introduction  

 

Users can click the nixie tube to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment, point 9 is for rotation, point 10 is the center point, and the space 

above point 2 is for horizontal skewing.  

 Property  

The property of a nixie tube consists of base, appearance, text, layout, and transform. 
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Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked control.  

Appearance Font Color To set the font color. Only monochrome is supported.  
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Fill Color 

To set the fill color of the control. It supports styles such as monochrome, picture, 

gradient, and radiation. 

 

Opacity 

To set the opacity of the control. The field ranges from 0% to 100% and is kept as 

integer only. The default value is 0%. 0% represents full opacity while 100% represents 

full transparency. 

Text 

Number To set the number displayed. 

Decimal places To set the number of decimal places displayed. 

Integer Digits To set the number of integer digits displayed. 

Tooltip To edit the content of the tooltip. Multiple languages are supported. 

Layout 

Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 

Transform 

Center Point 
To set the ratio of the X and Y coordinates of the control’s center point relative to 

its width and height. The default value is 0.5, 0.5. 

Rotate Angle To set the angle of rotation for the control (unit: degree). 

Skew Angle X 
To set the angle of skewing in the horizontal direction. The field ranges from -80 to 

80 and may contain two decimal places. The default value is 0 (unit: degree). 

Skew Angle Y 
To set the angle of skewing in the vertical direction. The field ranges from -80 to 80 

and may contain two decimal places. The default value is 0 (unit: degree). 
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6.5 Introduction to Extended Controls 

6.5.1 Pie Chart 

 

Open a web window, select Extended Controls > Pie Chart on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a pie chart. Repeat the steps to create another one. 

 Introduction  

 

Users can click the pie chart to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment. 
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 Property  

The property of a pie chart consists of base, layout, display, and chart. 

 

Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked control.  
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Layout 

Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 

Display Background 

To set the fill color outside the plot area of the chart. Only monochrome is 

supported. 
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Legend 

To decide whether to show or hide the chart legend. Users can change the position 

of the legend and customize its font and color. 

 

Property Description 

Display To decide whether to show the legend. 

Legend Font 

Family 
To set the font style, font weight, font size, and italics. 

Legend 

Location 

To set the position of the legend: top, bottom, left, or right. The 

legend is arranged horizontally when at the top or bottom and 

is arranged vertically when on the left or right. The legend is 

placed at the bottom by default. 

Legend Font 

Color 
To set the font color. Only monochrome is supported. 
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Data Display 

To configure data display. 

 

Property Description 

Name 
Check this option to show the data name; or, leave it 

unchecked to hide the data name. 

Value 

Check this option to show the data value; or, leave it 

unchecked to hide the data value. The value of decimal 

places ranges from 0 to 12 and is 2 by default. It can be 

changed by users. 

Percentage 

Check this option to show the data percentage; or, leave it 

unchecked to hide the data percentage. The value of decimal 

places ranges from 0 to 12 and is 2 by default. It can be 

changed by users. 

Data Font 

Family  
To set the font style, font weight, font size, and italics. 

Data Font 

Color 
To set the font color. Only monochrome is supported. 

Data Display 

Location 

To set the position of the data: inside, outside or arrange. The 

data is placed outside the plot area by default. 
 

Chart 
Doughnut 

Coefficient 

To configure the pie chart as a doughnut chart. Set the proposition of the pie chart 

that is hollow. The value ranges from 0% to 99% and is kept as integer only. The 

default value is 0%. 
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Unit 

To configure the elements and relevant variables for the pie chart. 

 

The left pane is for addition or deletion of elements while the right pane is for 

property configuration for the selected element. 

Property Description 

Add To add a new element. 

Delete To delete the selected element. 

Variable Path 

To set a variable for the element. It only supports readable 

analog variables. After setup, the value below is greyed out 

and locked. Right-click the variable and delete it to unlock 

and modify the value. 

Name 
To set the name of the element. Multiple languages are 

supported. 

Value 
To set the initial value of the element, which must be greater 

or equal 0. 

Color 
To set the fill color of the element. Only monochrome is 

supported. 
 

Refresh Time(s) 
To set the data refresh interval. The value is kept as integer and is 1 by default (unit: 

second). 
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6.5.2 Column Chart  

 

Open a web window, select Extended Controls > Column Chart on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a column chart. Repeat the steps to create another one. 

 Introduction  

 

Users can click the column chart to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment. 
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 Property  

The property of a column chart consists of base, layout, display, axis, and chart. 

 

Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked control.  
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Layout 

Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 

Display Background 

To set the fill color outside the plot area of the chart. Only monochrome is 

supported. 
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Legend 

To decide whether to show or hide the chart legend. Users can change the position 

of the legend and customize its font and color. 

 

Property Description 

Display To decide whether to show the legend. 

Legend Font 

Family 
To set the font style, font weight, font size, and italics. 

Legend 

Location 

To set the position of the legend: top, bottom, left, or right. The 

legend is arranged horizontally when at the top or bottom and 

is arranged vertically when on the left or right. The legend is 

placed at the bottom by default. 

Legend Font 

Color 
To set the font color. Only monochrome is supported. 
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Show Data 

To configure data display. 

 

Property Description 

Name 
Check this option to show the data name; or, leave it 

unchecked to hide the data name. 

Value 

Check this option to show the data value; or, leave it 

unchecked to hide the data value. The value of decimal 

places ranges from 0 to 12 and is 2 by default. It can be 

changed by users. 

Name and 

value wrap 

To set whether to wrap text when the name or value is too 

long. 

Data Font 

Family  
To set the font style, font weight, font size, and italics. 

Data Font 

Color 
To set the font color. Only monochrome is supported. 

Data Display 

Location 

To set the position of the data: inside bottom, inside center 

or outside. The data is placed inside bottom by default. 

Data Display 

Style 

To set the display style of the data: horizontal, tilt left, tilt 

right, or vertical. The data is displayed vertically by default. 

Border Radius To set the border radius of the data bars. The value ranges 
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from 0 to 90 and is 0 by default. 
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Toolbor 

The toolbar setting will appear when the chart data type is set as History. All the 

toolbars in the current web window is shown in the drop-down list with the selected 

one being greyed out. 
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Axis X Axis 

To set the font style, display style, label color, and axis color.  

 

Property Description 

Font Family  
To set the font style, font weight, font size, and italics for the 

axis labels. 

Style 
To set the display style of the axis labels: horizontal, tilt left, 

tilt right, or vertical. 

Label Color  To set the label color. Only monochrome is supported. 

Axis Color To set the axis color. Only monochrome is supported. 
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Y Axis 

To set the font style, display style, scale configuration, label color, axis color, etc. 

 

 

Property Description 

Show Grid 

Line 

Check this option to show the grid line; or, leave it unchecked 

to hide the grid line.  

Line Show 
Check this option to show the line and labels of the Y axis; 

or, leave it unchecked to hide the line and labels. 

Font Family  
To set the font style, font weight, font size, and italics for the 

axis labels. 

Label Style 
To set the display style of the axis labels: horizontal, tilt left, 

tilt right, or vertical. 

Display Style 

To set the display style of the coordinates: adaptive or 

customize. Adaptive is selected by default with small scale, 

upper and lower limits fixed in grey. The display changes 

automatically based on the actual values. 

Large Scale To set the number of large scales. 

Small Scale To set the number of small scales. 

Upper Limit To set the upper limit of the Y axis coordinates, which must 
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be greater than the lower limit. 

Lower Limit 
To set the lower limit of the Y axis coordinates, which must 

be less than the upper limit. 

Label Color  To set the label color. Only monochrome is supported. 

Axis Color To set the axis color. Only monochrome is supported. 
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Axis Transpose 
Check this option to switch X axis to Y axis and vice versa, crossing at the origin (0,0). 

This option is unchecked by default. 

Chart 

Chart Type 

There are two types available: standard chart or stack chart. 

Standard Chart 

 

Stack Chart 

 

 

Chart Data 

Type 

To select the data type displayed: realtime or history data. 
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Serials 

To configure the data series: member and category. Members of different categories 

can be individually bound with variables. 

 

In the Member section, users can add, delete and arrange the order of the members. 

The maximum number is 32. The members correspond to the chart legend. 

In the Category section, users can add, delete and arrange the order of the 

categories. The maximum number is 32. Click  to modify the category name in 

which multiple languages are supported. There are two types of category: category 

and time. The latter type is available only in history charts.  

Type of 

Category 
Description 

Category 

To configure the categories in the development environment 

and the members are grouped by category at runtime. In each 

group, all members are displayed and can be bound with 

different variables. 

Time 

Configuration is not required in the development 

environment. The members are grouped based on the 

requested time interval divided by the data refresh interval. 

The maximum number of groups is 32. In each group, all 

members are displayed. Here, the X axis serves as the time 
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Item Description 

axis. 

 

 

The Property section is for configuring the properties of the members. 

Type of 

Category 
Description 

Element Name 
To set the name of the member. Multiple languages are 

supported. 

Color 
To set the fill color of the member. It supports monochrome 

and gradient. 

Variable 

To set the variables for the member. It only supports readable 

analog variables. After setup, the value below is greyed out 

and locked. Right-click the variable and delete it to unlock 

and modify the value.  

Value 
To set the initial value of the member. This property is not 

available in history charts. 
 

Refresh Time(s) 

To set the data refresh interval. The value is kept as integer and must be greater 

than or equal 1. The default is 1. 

Chart Data 

Type 
Description 

Realtime 

The data refresh interval of a realtime chart is 1 by default. 

The value is kept as integer and must be greater than or equal 

1. 

History 

The data refresh interval of a history chart is 600 by default. 

The value is kept as integer and must be greater than or equal 

600. The historical data query function is disabled when the 

refresh interval is set as 0. 
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  6.5.3 Circle Gauge 

 

Open a web window, select Extended Controls > Circle Gauge on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a circle gauge. Repeat the steps to create another one. 

 Introduction  

 

Users can click the circle gauge to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment. 
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 Property  

The property of a circle gauge consists of base, layout, display and dashboard. 

 

Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked control.  

Layout Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 
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Item Description 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 

Display 

Background 

To set the fill color of the circle gauge. Only monochrome is supported. 

 

Data Display 

To configure the display of data and label. 
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Item Description 

 

Property Description 

Show Data 
Check this option to show the data; or, leave it unchecked to 

hide the data. 

Data Font To set the font style, font weight, font size, and italics. 

Data Color To set the font color. Only monochrome is supported. 

Data Unit 

To select the unit for the data in the drop-down list. The 

options include °, ℃, ＄, ㎡, m³, sec, etc. It supports user-

defined units, limited to 10 characters. 

Data Position 

The data is horizontally centered while its vertical position 

can be adjusted, ranging from 0 to 1, supporting two decimal 

places. The default value is 0.8. 

Show Label 
Check this option to show the label; or, leave it unchecked to 

hide the label. 

Label Content To edit the content of the label. 

Label Font To set the font style, font weight, font size, and italics. 

Label Color To set the font color. Only monochrome is supported. 

Label Position 

The label is horizontally centered while its vertical position 

can be adjusted, ranging from 0 to 1, supporting two decimal 

places. The default value is 0.6. 
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Item Description 

Dashboard Dashboard 

To configure the properties such as gauge type, major and minor ticks, maximum 

and minimum values, center point, radius, etc. 
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Item Description 

 

Property Description 

Gauge Type 
There are two types available: internal gauge or external 

gauge. 

Major Tick To set the number of major ticks. 

Major Tick 

Color 

To set the color of major ticks. Only monochrome is 

supported. 

Major Tick 

Length 

To set the length of major ticks. The field ranges from 0 to 

100. The default value is 10. 

Major Tick 

Width 

To set the width of major ticks. The field ranges from 0 to 

10. The default value is 2. 

Minor Tick 
To set the number of minor ticks. The field ranges from 1 to 

365. The default value is 5. 

Minor Tick 

Color 

To set the color of minor ticks. Only monochrome is 

supported. 

Minor Tick 

Length 

To set the length of minor ticks. The field ranges from 0 to 

100. The default value is 5. 

Minor Tick 

Width 

To set the width of minor ticks. The field ranges from 0 to 

10. The default value is 1. 

Max Value 
To set the maximum value of the gauge. It may contain two 

decimal places and the default value is 100. 

Min Value 
To set the minimum value of the gauge. It may contain two 

decimal places and the default value is 0. 

Center Point 

To set the position of the center point of the gauge. It is 

horizontally centered as 0.5 while the vertical position can be 

adjusted, ranging from 0 to 1, supporting two decimal places. 
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Item Description 

The default value is 0.5.  

Radius 
To set the radius of the gauge. The field ranges from 1% to 

100% and the default value is 80%. 

Border Width To set the width of the border (unit: px). 

Border Color 
To set the fill color of the border. Only monochrome is 

supported. 

Start Angle 
To set the start angle of the gauge. The field ranges from 0 to 

360 and the default value is 225. 

End Angle 
To set the end angle of the gauge. The field ranges from 0 to 

360 and the default value is 315. 

Segments* 
To configure segments for the gauge. This property is not 

available when the pointer style is set as fill. 

Font Color 
To set the font color for the gauge. Only monochrome is 

supported. 

Board Font 
To set the font style, font weight, font size, and italics for the 

gauge. 

*Configuration: 

 

 

Property Description 
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Item Description 

Start Value 
To set the start value of the segment. Overlaps between 

segments are not allowed. 

End Value 
To set the end value of the segment. Overlaps between 

segments are not allowed. 

Color 
To set the color of the segment. Only monochrome is 

supported. 

Add To add a segment. 

Delete To delete the selected segment. 
 

Pointer 

To configure the style, relative length, color, value and variable path for the pointer. 

 

Property Description 

Pointer Style 

There are six types available: solid circle arrow (default), 

hollow circle arrow, diamond arrow, arrow, line, or fill.  

The fill style is not available when there are segments in 

the gauge. 

Pointer Relative 

Length 
To set the distance from the pointer to the scale value. 

Pointer Color 
To set the color of the pointer. Only monochrome is 

supported. 

Pointer Value 
To set the default value for the gauge. This property is not 

available when the gauge is bound with variables. 

Variable Path It is required to set a variable for the pointer. 
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6.5.4 Trend Chart 

 

Open a web window, select Extended Controls > Trend Chart on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a trend chart, accompanied by an adaptive toolbar. Repeat the steps to create another 

one. 

 Introduction  

 

Users can click the trend chart to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment. 
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 Property  

The property of a trend chart consists of base, layout, appearance, series, axis, and limit line. 

 

Item Description 

Base 

Name 

The name of the control in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the control is shown or hidden at runtime.  

Lock 

If the control is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked control.  
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Item Description 

Layout 

Location 
To set the X and Y coordinates of the control in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the control. The values are kept as integers only (unit: 

pixels). 

Appearance Background 

To set the fill color outside the plot area of the chart. Only monochrome is 

supported. 

 



  Chapter  1  In t roduct ion  

1_ 

Item Description 

Legend 

To decide whether to show or hide the chart legend. Users can change the position 

of the legend and customize its font and color. 

 

Property Description 

Display To decide whether to show the legend. 

Legend Font 

Family 
To set the font style, font weight, font size, and italics. 

Legend 

Location 

To set the position of the legend: top, bottom, left, or right. The 

legend is arranged horizontally when at the top or bottom and 

is arranged vertically when on the left or right. The legend is 

placed at the bottom by default. 

Legend Font 

Color 
To set the font color. Only monochrome is supported. 

 

Toolbar 

To select the desired toolbar from the drop-down list where it shows all available 

toolbars in the current web window. By default, it is bound with the toolbar that 

comes with the created trend chart. 
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Item Description 

Series 

Collection 

To configure the data series. The number of members ranges from 1 to 10. 

 

Property Description 

Display  To decide whether to show or hide the selected member. 

Series Name To set the name of the member. 

Variable Path To bind cloud variables with historical data for the member. 

Series Style To set the line style: fold line, smooth line, column, or area. 

Color To set the line color. 
 

Default Time 

Interval 

To set the initial time interval. The default time is 10 minutes and can be set as 

10min, 30min, 1h, 8h, 1day, 3day, 1week, 1month. 

Refresh Time(s) 
To set the data refresh interval. The default value is 300 seconds, which is also the 

minimum value. 
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Item Description 

Axis 

Time Axis 

To configure the display of the time axis. 

 

Property Description 

Show Time 

Range 

Check this option to show the time range

. 

Drag left or right or scroll to view different time ranges in the 

development environment. 

Show Grid 

Line 

Check this option to show the grid line; or, leave it unchecked 

to hide the grid line.  

Large Scale 
To set the number of segments on the time axis. The field 

ranges from 1 to 15 and the default value is 5. 

Label Style 
To set the display style of the axis labels: horizontal, tilt left, 

tilt right, or vertical. 

Label Font 

Family 

To set the font style, font weight, font size, and italics for the 

axis labels. The default font style is Microsoft YaHei UI with 

a font size of 12. 

Label Color To set the label color. Only monochrome is supported. 

Axis Color To set the axis color. Only monochrome is supported. 
 

Numerical Axis To configure the display of the numerical axis. 
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Item Description 

 

 

Property Description 

Show Grid 

Line 

Check this option to show the grid line; or, leave it unchecked 

to hide the grid line.  

Line Show 
Check this option to show the line and labels of the Y axis; 

or, leave it unchecked to hide the line and labels. 

Label Font 

Family 

To set the font style, font weight, font size, and italics for the 

axis labels. The default font style is Microsoft YaHei UI with 

a font size of 12. 

Label Style 
To set the display style of the axis labels: horizontal, tilt left, 

tilt right, or vertical. 

Display Style 

To set the display style of the coordinates: adaptive or 

customize. Adaptive is selected by default with small scale, 

upper and lower limits fixed in grey. The display changes 

automatically based on the actual values. 

Large Scale 
To set the number of large scales. The field ranges from 1 to 

15 and the default value is 5.  

Small Scale 
To set the number of small scales. Available only in 

customized display. The value is kept as integer and must be 
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Item Description 

greater than or equal 1 

Upper Limit 

To set the upper limit of the Y axis coordinates, which must 

be greater than the lower limit. Available only in customized 

display. 

Lower Limit 

To set the lower limit of the Y axis coordinates, which must 

be less than the upper limit. Available only in customized 

display. 

Label Color  To set the label color. Only monochrome is supported. 

Axis Color To set the axis color. Only monochrome is supported. 
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Item Description 

Limit Line 
Limit Line A  

Limit Line B 

To set up the configurations of the limit lines A and B. The upper and lower limit 

lines are differentiated based on the actual values. 

 

Property Description 

Display  To decide whether to show or hide the selected limit line. 

Value 
To set a limit for the selected limit line to control the value 

of double data type. 

Variable Path 
To set variables for controlling the limit line at runtime. 

 

Limit Line 

Name 
To set the name of the limit line. 

Limit Line Font 

Family 

To set the font style, font weight, font size, and italics for the 

limit line name. The default font style is Microsoft YaHei UI 

with a font size of 12. 

Limit Line 

Style 

To set the display style of the limit line: solid line or dotted 

line.  

Limit Line 

Width 

To set the width of the limit line. The field is kept as integer 

and must be greater than 0. 
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Item Description 

Limit Line 

Color 

To set the color of the limit line. Only monochrome is 

supported. 

Over Limit 

Color 

To set the line color of the part where the value exceeds the 

limit. 
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6.6 Introduction to Toolbar Designer 

6.6.1 Column Chart Toolbar 

  

Open a web window, select Toolbar Designer > Column Chart Toolbar on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a column chart toolbar. Repeat the steps to create another one. 

 Introduction  

  

Users can click the toolbar to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment. 

 Property  

The property of a column chart toolbar consists of base, layout, and display. 
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Item Description 

Base 

Name 

The name of the toolbar in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the toolbar is shown or hidden at runtime.  

Lock 

If the toolbar is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked toolbar.  

Layout 

Location 
To set the X and Y coordinates of the toolbar in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the toolbar. The values are kept as integers only (unit: 

pixels). 
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Item Description 

Display 

Fill 

To set the fill color of the toolbar. Only monochrome is supported. 

 

Border Style 

To set the border line style, including line type, width, dash style, join, color of line 

stroke and so on. The width field ranges from 0 to 256 and may contain two decimal 

places (default:0). As for the color setting, only monochrome is supported. 

 

Icon Height 
To set the height of icons in the toolbar. The field ranges from 10 to 64 and is kept 

as integer only. The default value is 25. 

Icon Space 
To set the space between icons in the toolbar. The field ranges from 0 to 100 and is 

kept as integer only. The default value is 8. 

Button Setting 
To specify the button types to be shown in the toolbar, and to change the icons to 

be displayed and edit the contents of the tooltip. 
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Item Description 

 

1. To add a button to the toolbar, select the target button in the Button Select 

section and click . If the button is already included in the toolbar, it cannot 

be added again. You can remove the selected button from the toolbar simply 

by clicking . Additionally, click  or  to sort the buttons in the 

toolbar. 

2. In the Setting section, click  next to the icon to replace the default icon of 

the selected button with a custom image. And, click  in the tooltip column 

to edit the contents of the tooltip as well as the display language. 

3. Click ResetDefault button at the bottom of the Button Select section to reset 

the button types, icons, and tooltip contents to default. 

Toolbar Style To set the layout of the column chart toolbar: Horizontal or Vertical. 
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 Column Chart Toolbar in Use 

Button Description 

Time Select 

Available only when the type of category in serials configuration of the column chart is set as “Time”. 

You can set up the time interval in the drop-down list.  

This option is greyed out and not available if the type is set as “Category”. 

 

 

Statistics 

The statistical method used to display historical data in the column chart. For example: 

 

1. The column chart type is “Category”: The time period for querying historical data is the past hour, 

and the statistical method is “average”. Each member in each category displays the average 

value in the last hour. 

2. The column chart type is “Time”: The time period for querying historical data is the past hour, the 

time interval is “10 min”, and the statistical method is “average”. After clicking the query button, 

6 categories are displayed and each member in each group shows the average value of the 10 

minutes. 

 

Data Select Select the time interval for querying historical data in the column chart. Click Confirm to continue. 
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Button Description 

Restore 

Click the restore button to reset the column chart toolbar to its default configuration and performs a 

query. The default configuration is: time interval “10 minutes”; statistic “average value”; time period “the 

past hour”. 

 

 

Export 

Click the export button to save the data result as a .CSV file after query. The file is automatically named 

using the column chart name and the current time. 

 

 

Capture 

Click the capture button to take a screenshot of the current column chart. The screenshot does not 

include the column chart toolbar. The image is automatically named using the column chart name and 

the current time. 
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6.6.2 Trend Chart Toolbar 

 

Open a web window, select Toolbar Designer > Trend Chart Toolbar on the Toolbox pane.  

Place the cursor on the canvas. Select a starting point, click and hold the mouse, then drag to the lower right 

and drop to create a trend chart toolbar. Repeat the steps to create another one. 

 Introduction  

 

Users can click the toolbar to put it in edit mode as in the image above. 

Points 1 to 8 are for size adjustment. 

 Property  

The property of a trend chart toolbar consists of base, layout, and display. 
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Item Description 

Base 

Name 

The name of the toolbar in the web window. The naming rules are as follows:  

1. Consists of letters, numbers, Chinese characters, or underscores; must 

begin with a letter or Chinese character. 

2. Not case-sensitive. 

3. Cannot contain spaces, periods, exclamation marks, or special characters 

such as @$#?*&. 

4. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

5. Cannot share the same name with other objects in the same web window or 

with the web window where it is. 

6. Only supports names in traditional Chinese, simplified Chinese, or English. 

Display To decide whether the toolbar is shown or hidden at runtime.  

Lock 

If the toolbar is locked, mouse operations are invalid but users can still edit 

properties via the Property Edition dialog. A small lock  will appear around the 

locked toolbar.  

Layout 

Location 
To set the X and Y coordinates of the toolbar in the web window. The values are 

kept as integers only. 

Size 
To set the width and height of the toolbar. The values are kept as integers only (unit: 

pixels). 

Display 

Background 

To set the fill color of the toolbar. Only monochrome is supported. 

 

Border Style 

To set the border line style, including line type, width, dash style, join, color of line 

stroke and so on. The width field ranges from 0 to 256 and may contain two decimal 

places. As for the color setting, only monochrome is supported. 
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Item Description 

 

Icon Height To set the height of icons in the toolbar. The field ranges from 10 to 64. 

Icon Space To set the space between icons in the toolbar. The field ranges from 0 to 100. 

Button Setting 

To specify the button types to be shown in the toolbar. 

  

1. Click  or  to add the selected button to be shown on the toolbar or 

remove the selected button from the toolbar. 

2. Click  or  to sort the buttons in the toolbar. 

3. In column 1 (red box), you can replace the default icon of the selected button 

with a custom image. Image file formats like SVG, PNG, JPG, and JPEG are 

supported and the maximum size is 64px. 
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Item Description 

 

4. In column 2 (red box), you can edit the tooltip contents and set up the display 

language. 

 

Toolbar Style To set the layout of the trend chart toolbar: Horizontal or Vertical. 

 Trend Chart Toolbar in Use 

 

No. Button Description 

1 Setting 
Click the setting button to see the configured trend charts. You can then decide whetherto show 

the corresponding trend chart. The options are shown below.  
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2 Start / Stop 

Click the start / stop button to start, stopo or refresh the trend charts in real time at runtime.  

 

3 Time Select 

The current real-time refresh time interval is set as 10 minutes by default. This setting can be 

modified at runtime. Options include 10 min, 30 min, 1h, 8h, 1 day, 3 days, 1 week, and 1 month. 

 

 

4 Statistics Options are average value, instantaneous value, maximum value, and minimum value. 

5 Date Select 
Select the time period for querying historical data in the trend chart. The result is shown as below. 

Use the cursor to define a time and date range, then click Confirm to initiate the query. 
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7 Restore Click the restore button to reset the trend chart toolbar to the settings in real time. 

8 Export 

Click the export button to save the data result as a .CSV file after query. The file is automatically 

named using the trend chart name and the current time. The format is time / trend curve. If the 

exported range exceeds the performance limit, a prompt will pop up. An example is shown below. 

 

 

9 Capture 

Click the capture button to take a screenshot of the current trend chart. The screenshot does not 

include the trend chart toolbar. The image is automatically named using the trend chart name 

and the current time in PNG file format. 
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6.7 Gallery 

The gallery in DIAWeb Designer contains a variety of frequently used graphic models as well as user-defined 

graphic collections such as motor pump fan, valve vessel, indicating instructment, button switch and more. 

You can create and add your own graphic models to the gallery. The models in the gallery are pre-assembled 

graphics, which you can easily add to the canvas for use. 
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6.7.1 Use the Gallery  

The gallery in DIAWeb Designer provides built-in grphic models and allows users to define and add their 

own graphic models to the the gallery 

The graphic models are applied on the canvas in the same way as how the general graphics are used. 

On the Gallery pane, find the category where the graphic model belongs to. Select the graphic you need 

then move your cursor to anywhere on the canvas and double-click to create one. After that, you can proceed 

with further adjustments to the graphic such as position, size, and so on. 

 Add a Category 

Users can add their commonly used graphic models to the gallery. It is recommended to create 

custom library categories to make it easier for use and management. 

On the Gallery pane, right-click anywhere to open the context menu. 

 



  Chapter  1  In t roduct ion  

1_ 

Click Add Category to add a new category in and its default name is New Category as in the 

image below. The newly established category name is editable. You can choose a category and 

then right-click it to access other options like Delete Category or Rename Category for that 

selected category.  

Naming Rules: The system will generate a default name New Category, but you can also define 

a new name for the category. Self-defined names cannot be the same as other category names 

that have been established 
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6.7.2 Expand the Gallery 

A graphic model is formed by a collection of graphics grouped on the canvas. Follow the steps below to 

create a model: 

1. Create the sub-graphics. 

2. Adjust the size, position, layers and other properties of the sub-graphics. And then group the graphics 

into an assembly. 

3. Add the new assembly as a model to the gallery. 

 Add User-defined Models to the Gallery 

Unfold the category where the model will be added in on the Gallery pane; select the assembly 

on the canvas and drag it to the unfolded category. See the images below for reference. 
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The system will automatically generate a default model name. Right-click on the model to access 

options like Delete Group, Rename, or Export to Image. a new name for the category.  

Naming rules: 

a. Consists of letters, numbers, Chinese characters, or underscores; must begin with a letter or 

Chinese character. 

b. Not case-sensitive. 

c. Cannot contain spaces, periods, exclamation marks, or special characters such as @$#?*&. 

d. Cannot exceed 200 characters, with no more than 25 Chinese characters. 

e. Cannot share the same name with other objects in the same web window or with the web 

window where it is. 

f. Only supports names in traditional Chinese, simplified Chinese, or English. 
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6.7.3 Export Models as Images 

Follow the steps below to export models from the gallery as images. 

1. Select and right-click on the graphic model you want to export. 

2. Select the option Export to Image on the context menu. 
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6.8 Graphic Operations 

Graphic operations involve adjusting graphics by scaling, rotating, distorting, arranging, aligning, grouping, 

and other actions to alter the properties of the graphics to achieve the intended functionality and visual 

effects. 

During project development, you have various approaches to modifying the properties of graphics. You can 

edit through the property edition dialog, using a mouse, right-clicking, keyboard shortcuts, or via quick 

access toolbar and menu bar. For instance, while drawing a graphic, you can rotate it by adjusting the rotation 

point or change the size by stretching the stretching points as the image shown below.  

              

The DIAWeb Designer offers a user-friendly context menu to provide users an easier setting experience. 

Please refer to section 4.5 for more details. 

 

To provide you with a convenient and efficient development environment, DIAWeb Designer offers shortcut 

buttons for frequently used commands in the software. Please refer to section 4.4.2 for more details. 
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6.8.1 Rotation 

Rotating a graphic involves pivoting around a central point, which may be in the default position (the center 

of the graphic) or in a modified position prior to rotation. 

To rotate a graphic, place the mouse over the rotatiing point and the cursor will change to . Then hold 

the left mouse button and drag the rotating point to rotate the graphic. 

Below is an example of rotating a graphic with a default central point. 

 

Below is an example of rotating a graphic with a modified central point. 

 

The other approach to rotate a graphic is to specify a precise value of rotation angle (in degrees) in the 

Rotation property box in the Property Edition dialog. 
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6.8.2 Stretch  

To adjust the size of the seleted graphic, click the graphic to put it in edit mode first. Take a rectangle as an 

example, you can see 8 stretching points when the graphic is in edit mode as in the image below. Then place 

the cursor over any of the stretching points. When the cursor turns into  or , click and drag the 

point to adjust the size of the graphic. 

 

 

The other approach to adjust the graphic size is to specify precise values of height and width (in degrees) in 

the Size property box in the Property Edition dialog. 
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6.8.3 Arrangement 

When there are multiple graphics on the canvas, sometimes it may be required to align or distribute them in 

certain ways. DIAWeb Designer offers 7 types of alignment along with 2 types of distribution commands. 

Most alignment commands are applicable only when there are two or more graphics selected.  

 

When multiple graphics are selected, you can use the following rules to have the selected graphic aligned.   

1. When select by drawing a selection box to include multiple graphics on the canvas, the graphic which 

is first created will serve as the reference graphic with brighter stretching points. 

2. When selecting multiple graphics by clicking them one by one, the first clicked graphic will serve as 

the reference graphic with brighter stretching points. 

Command Description 

Align Left 

The icon of this command in the Start tab is . 

To left align two or more selected graphics with the left edge of the reference graphic. 

For example: Select 3 graphics with Graphic 1 whose stretching points are brighter as the reference 

graphic. Then click the Align Left icon in the menu bar to make the other graphics align with the left 

edge of Graphic 1. 
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Command Description 

 

The graphics have been aligned left. 

 

 

Align Right 
The icon of this command in the Start tab is . 

To right align the other selected graphics with the right edge of the reference graphic. 

Align Top 
The icon of this command in the Start tab is . 

To top align the other selected graphics with the top edge of the reference graphic. 

Align Bottom 
The icon of this command in the Start tab is . 

To align the bottom of the other selected graphics with the bottom edge of the first selected object. 

Align Center 
The icon of this command in the Start tab is . 

To vertically align the center of the other selected graphics with the center of the reference graphic. 
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Command Description 

Align Middle 
The icon of this command in the Start tab is . 

To horizontally align the center of the other selected graphics with the center of the reference graphic. 

Same Center 
The icon of this command in the Start tab is . 

To align the center point of the other selected graphics with the center point of the reference graphic. 

Distribute 

Vertical 

The icon of this command in the Start tab is . 

To align the vertical intervals between three or more selected graphics as shown below. 

 

Distribute 

Horizontal 

The icon of this command in the Start tab is . 

To align the horizontal intervals between three or more selected graphics as shown below. 
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6.8.4 Size 

When there are multiple graphics on the canvas, it may be required to align their sizes in certain ways. 

DIAWeb Designer offers 3 types of commands to resize the graphics, which are applicable only when there 

are two or more graphics selected.  

When multiple graphics are selected, you can use the following rules to have the selected graphic aligned.   

1. When select by drawing a selection box to include multiple graphics on the canvas, the graphic which 

is first created will serve as the reference graphic with brighter stretching points. 

2. When selecting multiple graphics by clicking them one by one, the first clicked graphic will serve as 

the reference graphic with brighter stretching points. 

Command Description 

Same Width 

The icon of this command in the Start tab is . 

To make the width of the other selected graphics the same as the width of the reference graphic. 

 

Same Height 
The icon of this command in the Start tab is . 

To make the height of the other selected graphics the same as the height of the reference graphic. 

Same Size 
The icon of this command in the Start tab is . 

To make the size of the other selected graphics the same as the size of the reference graphic. 
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6.8.5 Group 

Grouping refers to combining two or more graphics to form an assembly, creating a new graphic such as 

fans, motors, water tanks, and so on for practical purposes. The grouped graphic can be added to the library, 

making it easily accessible for future use. 

The grouped graphic is regarded as a new graphic and is subject to adjustments as other graphics. It can 

also be ungrouped at any time as required. 

Command Description 

Group 

The icon of this command in the Start tab is . 

Draw the individual graphics that make up the composite graphic fist. For example, if you are drawing a 

water pump, start by creating its components. 

 

Adjust the size, position, and layer of the components then group them together to form a water pump 

as shown below. 

 

 

Ungroup 

The icon of this command in the Start tab is . 

Select the composite graphic (in the example, the water pump) and click the Ungroup icon. The sub-

graphics become independent on the canvas. 
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6.8.6 Layer 

Layering is used to arrange the display order on the canvas. In DIAWeb Designer, the graphics drawn first 

are placed at the back, whereas those drawn later are placed in front of the first drawn graphics.  

When there are multiple graphics overlapped, you can use this function to move them backward or forward. 

DIAWeb Designer offers 4 types of layering commands: 

Command Description 

Bring to Front 

The icon of this command in the Start tab is . 

When there are multiple graphics overlapped, click to move the selected graphic in front of all other 

graphics. 

For example, select the red graphic as shown below. Then click Bring to Front icon and the red graphic 

is brought in front of all other graphics. 

 

 

Send to Back 

The icon of this command in the Start tab is . 

When there are multiple graphics overlapped, click to move the selected graphic behind all other 

graphics. 

Bring 

Forward 

The icon of this command in the Start tab is . 

When there are multiple graphics overlapped, click to move the selected graphic forward one layer. 

For example, the red graphic is selected and moved in front of the grey graphic. 
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Command Description 

 

Send 

Backward 

The icon of this command in the Start tab is . 

When there are multiple graphics overlapped, click to move the selected graphic back one layer. 
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6.8.7 Skew 

Skewing is used to tilt a graphic.  

To skew a graphic, place the mouse over the skewing point. When the cursor turns into , click and drag 

the skewing point to change the shape of the graphic as illustrated below. 

 

You can move the graphic horizontally.  

 

The graphic has been skewed to the right. 

 

The other approach to skew the graphic is to specify precise values in the Skew Angle X property box in the 

Property Edition dialog. The field ranges from -80 to 80 and may contain two decimal places. 
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Chape 7 Animation 
 

7.1 Introduction 

Animation refers to establishing a correspondence between graphic elements and variables, allowing the 

properties of these elements to dynamically change based on real-time data collection, thereby presenting 

dynamic scenes from industrial environments realistically. For example, this can involve simulating fluid flow 

in pipelines, real-time changes in device data, motor rotation, blinking alarm lights, and so on. 

To configure animations to dynamically change the properties of graphic objects on the screen, it is necessary 

to link them to corresponding variables and configure related properties based on real-time variable data 

collection. Therefore, animations are driven by data. 

The animation configuration features of DIAWeb Designer are powerful, including Visibility, Appearance, Text, 

Value View, Skew, Rotation, Fill, Zoom, Move, Flow. Only one animation of the same type can be configured 

for the same graphic object. 
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7.2 Visibility 

Visibility animation involves controlling the graphic object visibility by using variables or the values of 

expressions to change the “show/hide” property of these objects. 

Based on the visibility effect, visibility animations are divided into two types: “Visibility” and “Blink”. Visibility 

refers to changing the display status of a graphic from visible to hidden or vice versa on conditions, which is 

a single action. On the other hand, blink refers to having the graphic alternatively hide/show at a certain 

frequency, creating a blinking effect. 

7.2.1 Visibility 

Here are the setup steps for Visibility animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Visibility, as 

shown in the image below. 

 

Step 2: Visibility animation configuration window will pop up. 

 

The meanings of each setting in the configuration window are as follows: 
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Expression: Click  to open the variables browser to select variables.  

Clear: Clear the related variables. 

 

Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.2.2 Blink 

Here are the setup steps for Blink animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Blink, as 

shown in the image below: 

 

Step 2: Blink animation configuration window will pop up. 
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The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables.  

Clear: Clear the related variables.  

Blink Speed: Setting the blinking frequency, which is a drop-down list with 3 options: Slow, Medium, and 

Fast.  
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.3 Appearance 

Appearance animation involves changing stroke and brush of a graphic. 

Appearance animation includes two animations: Stroke and Brush, the configuration steps for both are the 

same.  

Taking Brush as an example, here are the configuration steps: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Brush, as 

shown in the image below. 

 

Step 2: Brush animation configuration window will pop up. 
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The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables.  

Clear: Clear the related variables. 

 

Brush configuration: 

 Comparison Operators: Setting the symbol for comparing the expression and value, which 

is a drop-down list with 6 options: 

1. =: Equal to (default) 

2. !=: Not equal to 

3. <: Less than 

4. >: Greater than 

5. <=: Less than / equal to 

6. >=: Greater than / equal to 

 Value: Setting the reference value for “expression” comparison. It can be an integer or a 

decimal (up to two decimal places). 

 Effect: Setting the fill color. 

 Add: Click the button to add a configuration item, as shown in the image below.  

 Delete: Select a fill configuration item and click this button to delete it. 



  Chapter  1  In t roduct ion  

1_ 

 

Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.4 Text 

Text animation involves controlling the foreground color of a text through variables or the value of expression, 

making the text color alternately blinking. Here are the setup steps: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Text Color, 

as shown in the image below. 
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Step 2: Text Color animation configuration window will pop up. 
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The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables.  

Clear: Clear the related variables. 

 

Text Color configuration: 

 Comparison Operators: Setting the symbol for comparing the expression and value, which 

is a drop-down list with 6 options: 

1. =: Equal to (default) 

2. !=: Not equal to 

3. <: Less than 

4. >: Greater than 

5. <=: Less than / equal to 

6. >=: Greater than / equal to 

 Value: Setting the reference value for “expression” comparison. It can be an integer or a 

decimal (up to two decimal places). 

 Effect: Setting the text color. 

 Add: Click the button to add a configuration item, as shown in the image below.  

 Delete: Select a configuration item and click this button to delete it. 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.5 Value View 

Value View animation can only be configured for graphic objects such as button, text box, label, and Nixie 

tube. It changes their "Content" property, meaning their displayed text will change according to the variations 

in the associated variable values and the set conditions. 

Value View animation is divided into 4 types: Analog Value String, Analog Value Display, Discrete Value 

Display, Text. These cannot be configured at the same time. 

Analog Value String works by associating a digital or analog signal (integer or real). It compares the variable 

value with the set value, and when the comparison condition is met, the graphical object displays the specified 

string value. 

Analog Value Display works by associating an analog signal (integer or real), it sets the display format so 

that the variable value is displayed in the graphical object according to the specified format. 

Discrete Value Display is associated with a digital signal (bool). It sets different display content based on 

whether the variable value is True or False. 

Text is associated with a variable or a set string, displaying the content of the graphical object as either the 

related variable value or the specified string. 

7.5.1 Analog Value String 

Here are the setup steps for Analog Value String animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Analog Value 

String, as shown in the image below. 
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Step 2: Analog Value String animation configuration window will pop up. 

 

The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables  

Clear: Clear the related variables. 
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Analog Value String configuration: 

 Comparison Operators: Setting the symbol for comparing the expression and value, which 

is a drop-down list with 6 options: 

1. =: Equal to (default) 

2. !=: Not equal to 

3. <: Less than 

4. >: Greater than 

5. <=: Less than / equal to 

6. >=: Greater than / equal to 

 Value: Setting the reference value for “expression” comparison. It can be an integer or a 

decimal (up to two decimal places). 

 Current Value: Setting the content of text (supports conversion to multiple languages) or 

expression, the value will be displayed in the graphic when the configured comparison 

conditions are met. 

 Add: Click the button to add a configuration item, as shown in the image below. 

 Delete: Select a configuration item and click this button to delete it. 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.5.2 Analog Value Display  

Here are the setup steps for Analog Value Display animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Analog Value 

Display, as shown in the image below. 

 

Step 2: Analog Value Display animation configuration window will pop up. 
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The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 

Clear: Clear the related variables. 

Digit configuration: 

 Digit: Only the format of the digit count for labels and text is supported; the digital display 

does not support setting the digit count format. 

 Integer Digits: Setting the number of integer digits, with a default of 5. If the number of integer 

digits in the output value is less than the set value, leading zeros will be added; if it exceeds 

the set value, it will be displayed according to the actual number of digits. If set to 0, the output 

value will be displayed without adding leading zeros. Example: if the integer digit count is set 

to 3 and the output value is 10, it will display as 010; if the output value is 165, it will display 

as 165. 

 Decimal Digits: Setting the number of decimal places, with a default of 2. If the number of 

decimal places in the output value is less than the set value, trailing zeros will be added; if it 

exceeds the set value, it will be rounded to the set number of decimal places. If set to 0, no 

decimal places will be displayed. Example: if the decimal place count is set to 2 and the output 

value is 2.3, it will display as 2.30; if the output value is 0.125, it will display as 0.12; if the 

output value is 0.126, it will display as 0.13. 

 Scientific Notation: Setting whether to display the variables value in scientific notation. 

 Thousands Separator: Setting whether to use thousands separator. 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.5.3 Discrete Value Display 

Here are the setup steps for Discrete Value Display animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Discrete 

Value Display, as shown in the image below. 

 

Step 2: Discrete Value Display animation configuration window will pop up. 
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The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables 

Clear: Clear the related variables.  

When true, display as string: Setting the display content of the graphic when the expression is true, 

supporting multiple languages. 

When false, display as string: Setting the display content of the graphic when the expression is false, 

supporting multiple languages. 

 

Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 
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To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.5.4 Text 

Here are the setup steps for Text animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Text, as shown 

in the image below. 

 

Step 2: Text animation configuration window will pop up. 

 

The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 

Clear: Clear the related variables. 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.6 Skew 

Skew animation adjusts the tilt degree of a graphical object based on the value of a variable or an expression, 

thereby changing the object's "skew" property. 

Skew animation is divided into 4 types: Horizontal Skew, Horizontal Discrete Skew, Vertical Skew, Vertical 

Discrete Skew. 

Horizontal Skew refers to the tilt degree in the horizontal direction of a graphical objects. 

Horizontal Discrete Skew refers to the correlation between the horizontal tilt angle of a graphical object 

and a discrete variable. 

Vertical Skew refers to the tilt degree in the vertical direction of a graphical objects. 

Vertical Discrete Skew refers to the correlation between the vertical tilt angle of a graphical object and a 

discrete variable. 

7.6.1 Horizontal / Vertical Skew 

The configuration steps for “Horizontal Skew” and “Vertical Skew” are the same.  

Here are the setup steps for Horizontal Skew animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Horizontal 

Skew, as shown in the image below. 
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Step 2: Horizontal Skew animation configuration window will pop up. 

 

The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 

Clear: Clear the related variables. 

Start configuration: 

 Value: Setting the minimum value of the expression. 

 Horizontal Skew: Setting the minimum value for horizontal skew, range is -80 to 80, with a 

default of 0. 

End configuration: 

 Value: Setting the maximum value of the expression. 

 Horizontal Skew: Setting the maximum value for horizontal skew, range is -80 to 80, with a 

default of 80. 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.6.2 Horizontal / Vertical Discrete Skew 

The configuration steps for “Horizontal Discrete Skew” and “Vertical Discrete Skew” are the same.  

Here are the setup steps for Horizontal Discrete Skew animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Horizontal 

Discrete Skew, as shown in the image below. 

 

Step 2: Horizontal Discrete Skew animation configuration window will pop up. 

 

The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 
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Clear: Clear the related variables. 

 

Horizontal Discrete Skew configuration: 

 Comparison Operators: Setting the symbol for comparing the expression and value, which is a 

drop-down list with 6 options: 

1. =：Equal to (default) 

2. !=：Not equal to 

3. <：Less than 

4. >：Greater than 

5. <=：Less than / equal to 

6. >=：Greater than / equal to 

 Value: Setting the reference value for “expression” comparison. It can be an integer or a 

decimal (up to two decimal places). 

 Skew: Setting the corresponding skew degree, ranging from -80 to 80. It can be an integer or 

a decimal (up to two decimal places). 

 Add: Click the button to add a configuration item, as shown in the image below. 

 Delete: Select a configuration item and click this button to delete it. 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 



  Chapter  1  In t roduct ion  

1_ 

 

 

7.7 Rotation 

Rotation animation allows a graphical object to rotate around its center point, changing the object's "rotation 

angle" and "rotation speed" properties. 

Rotation animation is divided into 4 types: Rotation Speed, Rotation Angle, Rotation Control, Discrete 

Rotation. 

Rotation Speed refers to the rotation speed of the graphical objects being bound to variables. 

Rotation Angle refers to the rotation angle of the graphical objects change linearly based on the variables 

or the value of expression. 

Rotation Control refers to the animation that controls whether a graphical object rotates around its center 

point based on whether the variables or the value of expression is True or False. 

Discrete Rotation refers to the correlation between the rotation angle of a graphical object and a discrete 

variable. 

7.7.1 Rotation Speed 

Here are the setup steps for Rotation Speed animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Rotation 

Speed, as shown in the image below. 
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Step 2: Rotation Speed animation configuration window will pop up. 

 

The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 

Clear: Clear the related variables. 
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Start configuration: 

 Value: Setting the minimum value for “expression”. It can be an integer or a decimal (up to 

two decimal places). 

 Speed Percent: Setting the minimum value for speed percent, ranging from -100 to 100. It 

can be an integer or a decimal (up to two decimal places). 

End configuration: 

 Value: Setting the maximum value for “expression”. It can be an integer or a decimal (up to 

two decimal places). 

 Speed Percent: Setting the maximum value for speed percent, ranging from -100 to 100. It 

can be an integer or a decimal (up to two decimal places). 

Property configuration: 

 Speed (ms): Set the time required for each rotation step of the object (unit: milliseconds). 

 Step (Degree): Set the angle by which the object rotates one step (unit: degree). 

Example: As the image shown below, when the expression value is 10, the object rotates clockwise at 9 

degrees per second; when the expression value is 100, the object rotates clockwise at 90 degrees per second. 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.7.2 Rotation Angle 

Here are the setup steps for Rotation Angle animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Rotation 

Angle, as shown in the image below. 

 

Step 2: Rotation Angle animation configuration window will pop up. 
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The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 

Clear: Clear the related variables. 

Start configuration: 

 Value: Setting the minimum value for “expression”. It can be an integer or a decimal (up to 

two decimal places).  

 Rotation Angle: Setting the minimum value for rotation angle, ranging from -360 to 300. It 

can be an integer or a decimal (up to two decimal places). 

End configuration: 

 Value: Setting the maximum value for “expression”. It can be an integer or a decimal (up to 

two decimal places).  

 Rotation Angle: Setting the maximum value for rotation angle, ranging from -360 to 300. It 

can be an integer or a decimal (up to two decimal places). 

 

Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 
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To delete an animation, select the animation from the list, then right-click and choose Delete. 

 

7.7.3 Rotation Control 

Here are the setup steps for Rotation Control animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Rotation 

Control, as shown in the image below. 
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Step 2: Rotation Control animation configuration window will pop up. 

 

The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 

Clear: Clear the related variables.  

Expression is true configuration: Set to begin or stop to rotate when expression is true. 

 Begin to Rotate: If selected, the graphic begins to rotate when the expression is true. 

 Stop to Rotate: If selected, the graphic stops to rotate when the expression is true. 

Property configuration: 

 Speed (ms): Set the time required for each rotation step of the object (unit: milliseconds). 

 Step (Degree): Set the angle by which the object rotates one step (unit: degree). 

 Clockwise / Anti-clockwise: Set the rotation direction. Default setting is clockwise, indicating that 

the graphic rotates in a clockwise direction. 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.7.4 Discrete Rotation 

Here are the setup steps for Discrete Rotation animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Discrete 

Rotation, as shown in the image below. 
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Step 2: Discrete Rotation animation configuration window will pop up. 
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The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 

Clear: Clear the related variables. 

 

Discrete Rotation configuration: 

 Comparison Operators: Set the symbol for comparing the expression and value, which is a 

drop-down list with 6 options: 

1. =: Equal to (default) 

2. !=: Not equal to 

3. <: Less than 

4. >: Greater than 

5. <=: Less than / equal to 

6. >=: Greater than / equal to 

 Value: Set the reference value for “expression” comparison. It can be an integer or a decimal 

(up to two decimal places). 

 Angle: Set the corresponding rotation angle, ranging from 0 to 360. It can be an integer or a 

decimal (up to two decimal places). 

 Add: Click the button to add a configuration item, as shown in the image below. 

 Delete: Select a configuration item and click this button to delete it. 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.8 Fill 

Fill animation controls the fill effect of a graphical object based on the value of a variable or an expression, 

thereby changing the object's "fill ratio” and “fill direction” properties. 

Fill animation is divided into 4 types based on the fill direction: Horizontal Fill, Horizontal Discrete Fill, Vertical 

Fill, Vertical Discrete Fill. 

7.8.1 Horizontal / Vertical Fill 

The configuration steps for “Horizontal Fill” and “Vertical Fill” are the same.  

Here are the setup steps for Horizontal Fill animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Horizontal 

Fill, as shown in the image below. 
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Step 2: Horizontal Fill animation configuration window will pop up. 

 

The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables 

Clear: Clear the related variables. 

Start configuration: 

 Value: Set the minimum value for “expression”. It can be an integer or a decimal (up to two 

decimal places). 

 Percentage: Set the minimum value for fill percentage, ranging from 0 to 100. It can be an 

integer or a decimal (up to two decimal places). 
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End configuration: 

 Value: Set the maximum value for “expression”. It can be an integer or a decimal (up to two 

decimal places). 

 Percentage: Set the maximum value for fill percentage, ranging from 0 to 100. It can be an 

integer or a decimal (up to two decimal places). 

Fill Attributes configuration: 

 Horizontal Fill Direction: Set the filling direction, which is a drop-down list with 3 options: 

1. Left to Right 

2. Right to Left 

3. Center to Edges 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 

 

The difference between “Horizontal Fill” animation and “Vertical Fill” animation configurations: 

Fill Attributes: 

 Vertical Fill Direction: Set the filling direction, which is a drop-down list with 3 options: 

1. Top to Bottom 



  Chapter  1  In t roduct ion  

1_ 

2. Bottom to Top 

3. Center to Edges 

7.8.2 Horizontal / Vertical Discrete Fill 

The configuration steps for “Horizontal Discrete Fill” and “Vertical Discrete Fill” are the same.  

Here are the setup steps for Horizontal Discrete Fill animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Horizontal 

Discrete Fill, as shown in the image below. 

 

Step 2: Horizontal Discrete Fill animation configuration window will pop up. 
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The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 

Clear: Clear the related variables. 

 

Horizontal Discrete Fill configuration: 

 Comparison Operators: Set the symbol for comparing the expression and value, which is a 

drop-down list with 6 options: 

1. =: Equal to (default) 

2. !=: Not equal to 

3. <: Less than 
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4. >: Greater than 

5. <=: Less than / equal to 

6. >=: Greater than / equal to 

 Value: Set the reference value for “expression” comparison. It can be an integer or a decimal 

(up to two decimal places). 

 Percentage: Set the corresponding fill percentage, ranging from 0 to 100. It can be an integer 

or a decimal (up to two decimal places). 

 Add: Click the button to add a configuration item, as shown in the image below. 

 Delete: Select a configuration item and click this button to delete it. 
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Fill Attributes configuration: 

 Horizontal Fill Direction: Set the filling direction, which is a drop-down list with 3 options: 

1. Left to Right 

2. Right to Left 

3. Center to Edges 

 

Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 
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To delete an animation, select the animation from the list, then right-click and choose Delete. 
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The difference between “Horizontal Discrete Fill” animation and “Vertical Discrete Fill” animation 

configurations: 

Fill Attributes configuration: 

 Vertical Discrete Fill Direction: Set the filling direction, which is a drop-down list with 3 options: 

1. Top to Bottom 

2. Bottom to Top 

3. Center to Edges 
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7.9 Zoom 

Zoom animation controls the size of a graphical object based on the value of a variable or an expression, 

thereby changing the object's "size” properties. 

Zoom animation is divided into 4 types based on the zoom direction: Horizontal Zoom, Horizontal Discrete 

Zoom, Vertical Zoom, Vertical Discrete Zoom. 

7.9.1 Horizontal / Vertical Zoom 

The configuration steps for “Horizontal Zoom” and “Vertical Zoom” are the same. 

Here are the setup steps for Horizontal Zoom animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Horizontal 

Zoom, as shown in the image below. 

 

Step 2: Horizontal Zoom animation configuration window will pop up. 



  Chapter  1  In t roduct ion  

1_ 

 

The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 

Clear: Clear the related variables. 

Start configuration: 

 Value: Set the minimum value for “expression”. It can be an integer or a decimal (up to two 

decimal places). 

 Percent: Set the minimum value for horizontal zoom percent, ranging from 0 to 100. It can be 

an integer or a decimal (up to two decimal places). 

End configuration: 

 Value: Set the maximum value for “expression”. It can be an integer or a decimal (up to two 

decimal places). 

 Percent: Set the maximum value for horizontal zoom percent, ranging from 0 to 100. It can 

be an integer or a decimal (up to two decimal places). 

Zoom Attributes configuration: 

 Horizontal Zoom Direction: Set the zoom direction, which is a drop-down list with 3 options: 

1. Left to Right  

2. Right to Left 

3. Center to Edges  
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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The difference between setting “Horizontal Zoom” animation and “Vertical Zoom” animation: 

Zoom Attributes configuration: 

 Vertical Zoom Direction: Set the zoom direction, which is a drop-down list with 3 options: 

1. Top to Bottom 

2. Bottom to Top 

3. Center to Edges 

 

7.9.2 Horizontal / Vertical Discrete Zoom 

The configuration steps for “Horizontal Discrete Zoom” and “Vertical Discrete Zoom” are the same. 

Here are the setup steps for Horizontal Discrete Zoom animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Horizontal 

Discrete Zoom, as shown in the image below. 



  Chapter  1  In t roduct ion  

1_ 
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Step 2: Horizontal Discrete Zoom animation configuration window will pop up. 

 

The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 

Clear: Clear the related variables. 

 

Horizontal Discrete Zoom configuration: 

 Comparison Operators: Set the symbol for comparing the expression and value, which is a 

drop-down list with 6 options: 

1. =: Equal to (default) 

2. !=: Not equal to 

3. <: Less than 
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4. >: Greater than 

5. <=: Less than / equal to 

6. >=: Greater than / equal to 

 Value: Set the reference value for “expression” comparison. It can be an integer or a decimal 

(up to two decimal places). 

 Percentage: Set the corresponding horizontal discrete zoom percentage, ranging from 0 to 

100. It can be an integer or a decimal (up to two decimal places). 

 Add: Click the button to add a configuration item, as shown in the image below. 

 Delete: Select a configuration item and click this button to delete it. 

Zoom Attributes configuration: 

 Horizontal Zoom Direction: Set the zoom direction, which is a drop-down list with 3 options: 

1. Left to Right 

2. Right to Left 

3. Center to Edge 

 

Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 
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To delete an animation, select the animation from the list, then right-click and choose Delete. 

 

The difference between setting “Horizontal Discrete Zoom” animation and “Vertical Discrete Zoom” 

animation: 

Zoom Attributes configuration: 

 Vertical Discrete Zoom Direction: Set the zoom direction, which is a drop-down list with 3 options: 
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1. Top to Bottom 

2. Bottom to Top 

3. Center to Edge 
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7.10 Move 

Move animation controls the position of a graphical object based on the value of a variable or an expression, 

thereby changing the object's "coordinates” properties. 

Move animation is divided into 3 types: Horizontal Move, Vertical Zoom, Discrete Zoom. 

7.10.1 Horizontal / Vertical Move 

The configuration steps for “Horizontal Move” and “Vertical Move” are the same. 

Here are the setup steps for Horizontal Move animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Horizontal 

Move, as shown in the image below. 
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Step 2: Horizontal Move animation configuration window will pop up. 

 

The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables 

Clear: Clear the related variables. 

Start configuration: 

 Value: Set the minimum value for “expression”. It can be an integer or a decimal (up to two 

decimal places). 

 Location: Set the leftmost coordinates that can be reached when moving horizontally. It can 

be an integer or a decimal (up to two decimal places). 

End configuration: 

 Value: Set the maximum value for “expression”. It can be an integer or a decimal (up to two 

decimal places). 

 Location: Set the rightmost coordinates that can be reached when moving horizontally. It can 

be an integer or a decimal (up to two decimal places). 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.10.2 Discrete Move 

Here are the setup steps for Discrete Move animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Discrete 

Move, as shown in the image below. 

 

Step 2: Discrete Move animation configuration window will pop up. 
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The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 

Clear: Clear the related variables. 

 

Discrete Move configuration: 

 Comparison Operators: Setting the symbol for comparing the expression and value, which 

is a drop-down list with 6 options: 

1. =: Equal to (default) 

2. !=: Not equal to 

3. <: Less than 

4. >: Greater than 

5. <=: Less than / equal to 

6. >=: Greater than / equal to 

 Value: Set the reference value for “expression” comparison. It can be an integer or a decimal 

(up to two decimal places). 

 Coordinate: Set the relative coordinates with the control objects as the origin. 

 Add: Click the button to add a configuration item, as shown in the image below. 

 Delete: Select a configuration item and click this button to delete it. 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.11 Flow 

Flow animation can only be configured for the graphical object, pipe, changing its "liquid flow" property. 

Flow animation is divided into 2 types: Line Flow and Flow Control. These cannot be configured at the same 

time. 

Line Flow animation involves setting a variable or expression and comparing it to a preset value. When the 

comparison condition is met, the pipe liquid flows at the specified flow speed. On the other hand, Flow 

Control animation controls whether the pipe liquid flows based on the true / false value of a discrete variable 

or an expression, and it also allows setting the flow speed. 

7.11.1 Line Flow 

Here are the setup steps for Line Flow animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Line Flow, as 

shown in the image below. 
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Step 2: Line Flow animation configuration window will pop up. 
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The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables 

Clear: Clear the related variables. 

 

Line Flow configuration: 

 Comparison Operators: Setting the symbol for comparing the expression and value, which is a 

drop-down list with 6 options: 

1. =: Equal to (default) 

2. !=: Not equal to 

3. <: Less than 

4. >: Greater than 

5. <=: Less than / equal to 

6. >=: Greater than / equal to 

 Value: Set the reference value for “expression” comparison. It can be an integer or a decimal (up 

to two decimal places). 

 Current Speed: Set the liquid flow speed, which is a drop-down list with 4 options: 

1. Static 

2. Slow 

3. Medium 

4. Fast 

 Add: Click the button to add a configuration item, as shown in the image below. 

 Delete: Select a configuration item and click this button to delete it. 
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Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic.  

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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7.11.2 Flow Control 

Here are the setup steps for Flow Control animation: 

Step 1: Open the DIAWeb Designer software, click the window where animation needs to be configured in 

the project. Select the graphic object > double-click to open Property Edition > Animation > Flow Control, 

as shown in the image below. 

 

Step 2: Flow Control animation configuration window will pop up. 
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The meanings of each setting in the configuration window are as follows: 

Expression: Click  to open the variables browser to select variables. 

Clear: Clear the related variables. 

Flow Attributes configuration:  

 Flow Speed: Set the liquid flow speed, which is a drop-down list with 4 options: 

1. Static 

2. Slow 

3. Medium 

4. Fast 

 

Step 3: After finishing the configuration, click OK. The animation window will display the configured 

information for this graphic. 

 

To delete an animation, select the animation from the list, then right-click and choose Delete. 
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Chapter 8 Event 

Overview  

Events are operations that can be recognized and responded to by graphic objects, which are divided into 

system event and user event. Events in DIAWeb Designer are often user event, where the user operates 

the graphic objects in the window to drive the graphic control to perform certain functions.    

Events in the DIAWeb Designer refer to triggering relevant script processes when the user uses mouse, 

keyboard and etc. to operate graphic objects. Therefore, configuring events mainly involves using the 

script editor to configure the script program, or calling the packaged program: The DIAWeb Designer 

software script editor contains many pre-written commands and system functions that users can directly 

use in script programs. 

DIAWeb Designer software provides comprehensive events processing functions, including mouse, 

window operation, value input and etc.; the same event corresponding to the same graphic object can 

only be configured once.       

8.1Mouse Event 

Mouse event is the event triggered by mouse movements, clicks and other operations on the graphic 

objects, and then apply releveant script to complete related functions.  

There are 4 types of Mouse event: Mouse Down, Mouse Up, Mouse Enter, Mouse Leave.  

Take Mouse Down as an example. The configuration process is demonstrated as below: 

Step 1: Open the window in the project where the events need to be configured in DIAWeb Designer 

development environment > Select the graphic object > Double-click Property Edition > Click Event > 

Click Mouse Down button. 
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Step 2: Then the Script Editor window will pop up.  

 

Step 3: Edit the script (The script in DIAWeb Designer is called Visual Basic Script, and the script editor 

will compile the syntax check).  

 



  Chapter  1  In t roduct ion  

1_ 

Step 4: After completing the script, click Save and Exit button , and the event information will be 

displayed in the event window.  

 

To delete the event, select the event in the list and right-click Delete button.  
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8.2 Window Operation Event  

Window Operation events are operations that open and close the windows. Only button controls support 

this configuration.  

There are 3 types of Window Operation event: Open Window, Close Window and Open Window Close 

Others.  

Open Window means open the set window; Close Window means close the set window; Open Window 

Close Others means open the set window and close other windows.  

Take Open Window as an example. The configuration process is demonstrated as below:  

Step 1: Open the window in the project where the events need to be configured in DIAWeb Designer 

development environment > Select the graphic object > Double-click Property Edition > Click Event > 

Click Open Window button. 
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Step 2: Then the Open Window window will pop up.  

 

Step 3: Select the window to open in the window list on the left and click > button to add it to the selected 

window.  

 

Button Description 

 

Add the window to Selected Window. 

 

Add all windows to Selected Window 

 

Move down the chosen window 
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Button Description 

 

Pin the chosen window to the bottom  

 

Pin the chosen window to the top 

 

Move up the chosen window 

 

Remove the chosen window from Selected Window 

 

Remove all chosen windows from the Selected Window 

Step 4: Click OK after the configuration is completed and the event information will display in the window.  

 

To delete the event, select the event in the list and right-click Delete button.  
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8.3 Value Input Event 

Value Input event is event triggering DIAWeb Designer input window by clicking the graphic object in the 

window to perform value input operations.  

There are four types of Value Input event: Analog Value Input, Discrete Value Input, String Input, Button 

Input.  

8.3.1 Analog Value Input 

When the graphic object is clicked, the Analog Value Input dialog will pop up, including numerical buttons. 

User can click the button to enter values to change the value. The configuration process is shown below:  

Step 1: Open the window in the project where the events need to be configured in DIAWeb Designer 

development environment > Select the graphic object > Double-click Property Edition > Click Event > 

Click Analog Value Input.  
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Step 2: Then the Analog Value Input window will pop up.  

 

The meanings of each setting in the configuration window are as follows: 

Variable: click  to open the variable browser to select the variables; click Clear button to clear the 

variables.  

Value range configuration:  

 Minimum Value: the minimum value that can be set. 

 Maximum Value: the maximum value that can be set. 

 Follow the variables to define the maximum and minimum: The maximum value range is 

synchronized to the maximum and minimum of the bound variables.  

Auto create animation: Set whether to create corresponding numerical display animations automatically 

(text box and label controls support this function)    
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Step 3: Click OK after the configuration is completed and the event information will display in the window. 

 

To delete the event, select the event in the list and right-click Delete button.  
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8.3.2 Discrete Value Input 

When the graphic object is clicked, the Discrete Value Input dialog will pop up. User can set text display 

content of the button based on the value of the discrete variables to True or False. The configuration 

process is shown below:  

Step 1: Open the window in the project where the events need to be configured in DIAWeb Designer 

development environment > Select the graphic object > Double-click Property Edition > Click Event > 

Click Discrete Value Input. 

 

Step 2: Then the Discrete Value Input window will pop up.  

 

The meanings of each setting in the configuration window are as follows: 

Variable: Click  to open the variable browser to select the variables; click Clear button to clear the 
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variables.  

Auto create animation: Set whether to create corresponding numerical display animations automatically 

(text and label controls support this function)    
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Step 3: Click OK after the configuration is completed and the event information will display in the window. 

 

To delete the event, select the event in the list and right-click Delete button.  
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8.3.3 String Input 

When the graphic object is clicked, the String Input dialog will pop up, including alphabet and numbers. 

User can click the button to enter a string to change the value of associated text type variables. 

Step 1: Open the window in the project where the events need to be configured in DIAWeb Designer 

development environment > Select the graphic object > Double-click Property Edition > Click Event > 

Click String Input. 

 

Step 2: Then the String Input window will pop up.  

 

The meanings of each setting in the configuration window are as follows: 

Variable: click  to open the variable browser to select the variables; click Clear button to clear the 

variables.  
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Auto create animation: Set whether to create corresponding numerical display animations automatically 

(available in text box and label controls).    

Step 3: Click OK after the configuration is completed and the event information will display in the window. 

 

To delete the event, select the event in the list and right-click Delete button. 
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8.3.4 Button Input  

When the graphic object is clicked, the associated value will change in the way of the settings. The 

configuration process is shown below:  

Step 1: Open the window in the project where the events need to be configured in DIAWeb Designer 

development environment > Select the graphic object > Double-click Property Edition > Click Event > 

Click Button Input. 
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Step 2: Then the Button Input window will pop up.  

 

The meanings of each setting in the configuration window are as follows: 

Variable: click  to open the variable browser to select the variables; click Clear button to clear the 

variables.  

Numerical Value configuration:  

 Input Value: Enter the set value. 

 ValueType: There are 6 types to change the variable value:   

1. Set Value: Directly enter the input value to the associated variable and the analog value 

is valid.  

2. Increase: Add the set value to the associated variable value and assign it to the 

associated variable, the analog is valid.   

3. Decrease: Subtract the set value from the associated variable value and assign it to the 

associated variable, the analog is valid.     

4. Multiply: Multiply the set value by the associated variable value and assign it to the 

associated variable, the analog is valid. 

5. Divide: Divide the associated variable value by the set value and assign it to the 

associated variable, the analog is valid.   

6. Toggle: The analog values switch between 0 and 1; the switching values switch between 

true and false.  
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Step 3: Click OK after the configuration is completed and the event information will display in the window. 

 

To delete the event, select the event in the list and right-click Delete button. 

 



  Chapter  1  In t roduct ion  

1_ 

8.4 Keyboard Event  

Keyboard event refers to the event triggered by keyboard operations such as pressing up and down on 

the graphical objects to further utilize relevant script to complete related functions.  

There are 2 types of Keyboard event: Key Down, Key Up.  

Key Down and Key up share the same configuration process. Take Key Down as an example. 

Step 1: Open the window in the project where the events need to be configured in DIAWeb Designer 

development environment > Select the graphic object > Double-click Property Edition > Click Event > 

Click KeyDown 

 

Step 2: Then the Script Editor window will pop up.  
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Step 3: Edit the script (The script in DIAWeb Designer is called Visual Basic Script, and the script editor 

will compile the syntax check)  

 

Step 4: After completing the script, click Save and Exit button  , and the event information will 

display in the event window. 
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To delete the event, select the event in the list and right-click Delete button.  
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8.5 Control Event  

Control event is a type of event exclusive to window controls; and, different window controls are equipped 

with different types of control events.   

The combo box has Selection Changed event; the check box has Checked and Unchecked event; the 

text box has Text Changed event; the password box has Password changed event; the date time 

picker has Value Changed event. All events share the same configuration process and can be edited 

through the script editor to perform corresponding functions. 

Take Selection Changed event as an example. The configuration process is shown below: 

Step 1: Open the window in the project where the events need to be configured in DIAWeb Designer 

development environment > Select the graphic object > Double-click Property Edition > Click Event > 

Click SelectionChanged. 

 

Step 2: Then the Script Editor window will pop up.  
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Step 3: Edit the script (The script in DIAWeb Designer is called Visual Basic Script, and the script editor 

will compile the syntax check) 

 

Step 4: After completing the script, click Save and Exit button , and the event information will display 

in the event window. 
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To delete the event, select the event in the list and right-click Delete button. 
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8.6 Window Program Event  

Window Program event is the program executed when the window is running within the user-defined 

intervals. 

There is the only one type of Window Program event. The configuration process is shown below:  

Step 1: Open the window in the project where the events need to be configured in DIAWeb Designer 

development environment > Select anywhere in the window > Double-click Property Edition > Click 

Event > Click Window Program button: 

 

Step 2: Then the Window Program window will pop up. Click Add to create new program. 

 

The meanings of each setting in the configuration window are as follows: 

Function Name: User can set their own program name and the naming rules are as below: 

 Consists of letters, numbers, and Chinese characters; must begin with a letter or Chinese character. 

 Not case-sensitive. 

 Cannot contain spaces, periods, exclamation marks, underscores or special characters such as 

@$#?*&. 
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 Cannot exceed 200 characters, with no more than 20 Chinese characters. 

 Cannot share the same name with other window programs in the same web window. 

 Only support names in traditional Chinese, simplified Chinese, or English. 

Program: Set the program to be executed. 

Execute Mode: Methods to execute a specified program, including Loaded, TimerTicked and Closed. 

The default is Loaded. 

Interval Time (ms): Set the program interval time. 

Is Enabled: If the box is checked, it means executing the program; if unchecked, it means not executing 

the program. 

Description: Related information about the ongoing program. 

Add: Add a program. 

Delete: Delete the selected program. 

Clear: Clear all programs. 

Step 3: Click Execute Mode button and choose the mode to execute in the drop-down list.  

 

Step 4: Click Program button and the Script Editor window will pop up for programming.  
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Step 5: Click OK after the setting is completed and the word Configured will be displayed below the 

program.  

 

Step 6: Click OK after confirming the configuration to complete WindowProgram event and the information 

will display in the window.  
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To delete the event, select the event in the list and right-click Delete button.  
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Chapter 9 Thumbnails   

9.1 Thumbnails  

When publishing a project in DIAWeb Designer, it is optional for users to submit related 

pictures to display the project overview on FUDA Cloud platform. By doing so, quick 

previews of projects are released on the cloud platform, which largely enhances user 

experience in project switching. In this case, DIAWeb Designer serves as the thumbnail 

management portal.  

1. Open Thumbnails in the project tree on the Project pane and enter the picture management page. 

 

2. Right-click to open the context menu with options: Add, Delete or Paste. 

 

3. IIoT > Upload Data > Upload the thumbnails. 
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  Chapter  1  In t roduct ion  

1_ 

 Chapter10 Global  

10.1 Overview 

Global function allows users to extract the contents of multiple function blocks to 

multilanguage resource list and edit the extracted contents to achieve multilanguage 

switching.  

String is the multilanguage resource type currently supported. 

10.2 Multilanguage Configuration 

1. Right-click the Global node in the project tree and select Configuration.  
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2. Then the Multilanguage Configuration window will pop up.  

 

Add: Add the language selected in the list on the left. 

Remove: Remove the selected languages from the list on the right. If the chosen language 

is set to be the development language, runtime language or default project language, then 

the removal is denied.  

Set Develop Environment: Set the selected language in the list on the right to be the 

display language in the development environment. 

Set Runtime Environment: Set the selected language in the list on the right to be the 

display language at runtime.   

Default Project Language: Select Default Project Language from the drop-down list. 

Currently, it supports Simplified Chinese, Traditional Chinese and English. When the 

language switched has not been translated, the default language will be displayed. To set 

the default language, all contents in the software needs to be translated into that language. 

Note: When the software language and the default project language do not match (e.g. 

software language is English; default language is Chinese), it is recommended to switch 

the default language to be consistent with the software language.  
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10.3 String  

String is the resource library of Chinese text type in Global function, which can be 

customized and edited by the user. The editing process is as follows:   

1. Click the String node in the project tree.  

 

2. Double-click String to edit.  

 

Note: In the string interface, one row represents the content of the multilanguage displayed in 

different languages; one column represents one type of language. If it left blank in the row, the 

content in the default language will be displayed.  
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Function blocks in DIAWeb Designer that can be converted into the string resource 

includes:  

a. Tooltip for all controls in the window 

b. Text content in the button control, label control, checkbox control and text box control; text 

content and the subset in the combo box control  

c. Some properties in extended controls  

 Select resources 

During development, you can select existing string resources in the text property. Specific steps 

are as follow:  

1. Create a new button control and double-click the button to pop up the property editing window.  
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2. Open the text content editing box.    

 

Note: If the corresponding resources have been edited in the string, then select String List 

and choose the corresponding resources; if the corresponding resources have not been 

edited in the library, then select To Resource to directly add a new resource library and apply 

it.  

3. Click String List and select the corresponding resource content. After clicking OK, the 

multilanguage resource configuration is completed. 
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 Converted into resource  

During development, you can convert texts to string resource library. Specific steps 

are as follow:  

1. Create a new button control and double-click the button to pop up the Property Edition window. 

 

2. Open the text content editing box.  
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3. Click To Resource to add the current content to String List.  

 

4. Click Editor button at the upper left corner to customize the converted resources in the String 

List.      

 

5. Close Resources Editor and select the related string resources. After clicking OK, the 

configuration is completed.  
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10.4 System  

System in the Global function means the system text in the window is displayed in the 

specified language. It includes the menu and drop-down box content of the advanced 

control and menu bar at runtime. For example, there are three languages in the system 

multilanguage editing box: Simplified Chinese, Traditional Chinese and English, then the 

project can switch among languages during development and runtime.  

1. Double-click Global node in the project tree and click System in the menu. 

 
2. Open the System editing interface.  

 

In the system interface, one row represents the content of the resource displayed in 

different languages; and one column represents one language.  

Users cannot edit these three languages, Simplified Chinese, Traditional Chinese and 

English, even the export of Excel to modify the re-import is invalid.  

Users cannot customize the addition of multilanguage resources to the system, but can 

only translate into the corresponding national languages for currently available 

resources.  



  Chapter  1  In t roduct ion  

1_ 

10.5 Runtime Environment Setting   

When the system is in operation, user can change languages in the following way:  

 Runtime Environment Setting:  

When the system is running, click the floating icon in the bottom left corner and the setting window 

will pop for you to switch languages.  
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Chater 11 Runtime Environment  

11.1 Overview 

The DIAWeb Designer software consists of the development environment and the runtime 

environment. The graphical interfaces designed and the scripts edited in the development 

environment must run in the runtime environment so as to dynamically display the screen 

and realize the complete operation of various functions for real-time monitoring.  

The runtime environment can display dynamic graphic components, as well as the 

animations and events configured for graphic objects and controls, achieving real-time 

control and data interaction between the web window and on-site devices. 

11.2 Project Configuration     

Project Configuration in DIAWeb Designer is used to configure the windows to be opened 

for project execution and set up their display mode. 

 Web Window 

This tab sets the default start web window(s) for project execution, as well as the display order of 

web windows. 

 

Select the web window to open from the Window List section for project execution. 
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Click  button to add the selected web window to the Start Window section. 

Click   button to add all web windows to the Start Window section. The 

number of web windows in the Start Window section can be one or more, with newly 

added web windows located below. If there are multiple ones in the section, you can 

click  to move them up and click  to move them down. 

After the setup above is finished, click OK button to save the configuration. 

The order of opening web windows: The web windows in the Start Window list are 

opened in order from top to bottom, and the last web window opened, which is the 

one at the bottom of the list, will display on the top layer of the screen. 

 View 

It sets the window display mode for a running project in the browser, with the following 

4 display modes available: 

1. Actual size: The display size is exactly the same as the canvas size setting in Design 

Canvas Size below.  

2. Fit Width: The width of the canvas is scaled to fit the browser window. 

3. Fit Window: The canvas display is resized to fit the browser window. 

4. Display Scale: The canvas display is resized according to the scale factor, with optional 

factors: 25%, 33%, 50%, 67%, 80%, 90%, 100%, 110%, 125%, 150%, 175%, 200%, 250%, 

300%, 400%, and 500%. 

 Design Canvas Size 

The canvas size setting here is the view size in the browser window. 

Common Size: The display size for a preview, which is the default computer 

resolution for the developer to create a project for the first time. Switching the size 

during project execution is supported. The sizes of 1920 * 1080, 1440 * 900, 1366 * 

768 and 1024 * 768 are for option. 

Size: After a common size is selected, the size will be displayed in the Size field, 

which can be modified by the user. Note that it is the setting value in the Size field 

that is effective eventually. 

 Display mode switch  

In the process of running a project, click on the following floating icon in the bottom-

left corner of the screen to open the Runtime Environment Setting window, where 

you can switch the adaptive display mode. 
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11.3 Runtime Environment  

Before a project is running, it is necessary to configure the project first (see section 12.2 

for details). After the configuration is completed, run the web window to start the runtime 

environment. 

1. Local preview 

In the DIAWeb Designer, click the home interface of the development environment > Start 

tab > Preview button to take a preview of local data as shown in the following figure. 

 

2. DIACloud display 

In login mode, click on the main interface of the development environment in DIAWeb 

Designer > IIoT tab > Upload Data button to upload the project in DIAWeb Designer to 

DIACloud. 
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Select the items to be uploaded in the Local section and then click Upload button. Once 

the upload is finished, the following Tips window pops up, indicating that the project has 

been successfully uploaded. 

 

Click OK to enter the DIACloud login page. 
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Upon successful login, the project will start running in DIACloud. 
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Chapter 12 Scripts 

12.1 Overview  

DIAWeb Designer provides comprehensive and powerful functions. To fulfill the diverse 

and wide-ranging requirements, DIAWeb Designer allows users customization to achieve 

special tasks and functions, which is accomplished by writing programs in the script editor. 

The event configurations and user programs in DIAWeb Designer require script editor for 

script editing. DIAWeb Designer supports the VB Script (Visual Basic Script) scripting 

language, and thus users can write logic control programs that follow the syntax of VB 

Script language to carry out functions for special purposes and enhance the system 

availability. 

Note: Since the VB Script language also supports files or system environments beyond 

DIAWeb Designer, please ensure the security of your files or systems during use so as to 

prevent failures like file loss or incomplete system environment. 
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12.2 Script Editor  

The editing of a script should be carried out in the Script Editor. It is handy for users to edit 

a script accurately since the script editor provides various functions including smart 

prompts, syntax highlights, Type Setting, Scroll to Line, as well as Syntax Check function. 

The script editor in DIAWeb Designer is similar to all other common editors in terms of the 

interface, structure, and functionality. You can open the editor in the following steps. 

On the Project pane of the development environment in DIAWebDesigner, select Web 

Window > right-click New Web Window > draw a shape in the current canvas > double-

click or right-click the shape to open the Property Edition window, and click Event tab in 

the window. Then Click any event configuration button to open the Script Editor window.  

 

Parts in the Script Editor window: 

1. Menu bar: Basic function menus for operations 

2. Toolbar: Shortcut function buttons for operations 

3. Script editing area: Script program writing area 

4. Project / Script Library / Operator / Key words pane: The window of directories for operations  

5. Information bar: Displays the status, operation information, etc. 
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 Menu bar 

The menu bar of the Script Editor contains the following menus and their own 

commands: 

1. File menu 

Button Function 

 Import 
Import an external script file. 

 Export Save the current script as an external script file. 

 Save Save the current script. 

 Save and Exit Save the current script and exit the script editor. 

 Check 
Perform a syntax check on the current script, and the check result is 

displayed in the output window. 

 Exit Stop editing the script and exit the script editor. 

2. Edit menu 

Button Function 

 Undo 
Click this command to cancel the previous operation. The script editing 

starts from the last operation. 

 Restore 
Click this command to redo the previously cancelled operation. The script 

editing starts from the last operation. 

 Cut 

After selecting the text in the script editing area, click this command and 

then the text is deleted and copied to the clipboard. 

 Copy 

After selecting the text in the script editing area, click this command and the 

text is not deleted and copied to the clipboard. 

 Paste Paste the contents of the current clipboard into the script editing area. 

 Delete 
After selecting the text in the script editing area, click this command, and 

then the text is deleted. 

 Select All Selects all text in the editing area will be selected. 



  Chapter  1  In t roduct ion  

1_ 

Button Function 

  Find and 

Replace 

Click this command to open a secondary menu including three commands: 

Find, Replace, and Replace All.  

With a click on this button, the following dialog will pop up: 

 

Item Description 

Find Now Enter the text you want to search for in this editing area. 

Match 

Case 

If this option is selected, the result only displays the 

instances that are written in the same way as those in 

"Find What". 

Search Up 
Select this option to search up from the position of the 

current cursor. 

Match 

Whole 

Word 

Select this option to display the instances that exactly 

match the whole word in “Find What”. For instance, after a 

search for "aaa", the result will return "aaa" instead of 

"baaa" or "aaac". 

Replace 
After entering what to find and what to replace with, click 

the "Replace" button. 

Replace 

All 

After entering what to find and what to replace with, click 

the "Replace All" button. The selections for "Replace" and 

"Replace All" have the same effect as those for "Find 

Now". 

 
 

 Scroll to Line 

Perform the operation of quick positioning. After entering a line number in 

the Scroll to Line dialog box, click OK, and then the system cursor moves 

to the end of the target line and the entire line is selected. 

 Type Setting 
Click this command to perform an automatic typesetting of the script 

contents in the editing area. 

3. View menu 
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Button Function 

 Font Setting 
Clicking this command will open a secondary menu for setting the font style 

and font size. After saved, the settings are applied to the current project. 

  Show / Hide 

Syntax Check 

Window 

Click this command to show or hide the Syntax Check output window. 

  Show / Hide 

Script Comment 

Window 

Click this command to show or hide the Script Comment output window. 
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 Project / Script Library / Operator / Key words pane 

1. Project tab:  

Contains various information for a project such as variables, web window, operation status 

and etc. 

 

2. Script Library tab:  

The system functions are classified into 7 types: Date / Time, Conversion, Format, Math, Array, 

String and Other functions. There are several functions for each type. 
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3. Operator tab:  

Shows three types of operators: Arithmetic operators, Comparison operators, and Logical 

operators. There are several operators for each type. Double-click an operator and then the 

operator will be added to the script editing area immediately. 

 

4. Keyword tab:  

Displays all keywords related to the script syntax. Double-click on a keyword, and then the 

keyword will be added to the script editing area immediately. 
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 Syntax Highlights 

In order to make it convenient and clear for users to edit a script, the script editor provides different 

colors for the highlight of different content types in the syntax. 

Content Type Color 

Defaults Black 

Numbers Purple 

Strings Dark brown 

Mathematical Symbols Red 

Comments Green 

Keywords Blue 

 Smart Prompts 

1. Tip box 

When you enter a system function and a symbol "(", the tip box will appear telling you the 

name, parameters, and description of the function. In the tip box, the black bold parameters 

indicate which parameter is being entered.  
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2. List box for tips  

When you enter a letter, a list box for tips will automatically show up. This box lists the result 

of letter fuzzy matching, including objects, properties, methods, etc. 

 

When you enter the symbol ".", the system will display a prompt box based on the content 

before ".", which may include properties, variable group, etc. 
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 Keyboard Shortcuts    

In the Script Editor dialog, the shortcut keys that can be used are as follows. 

Command Shortcut Keys 

Copy  Ctrl＋C 

Cut  Ctrl＋X 

Paste  Ctrl＋V 

Select All  Ctrl＋A 

Undo Ctrl＋Z 

Restore Ctrl＋Y 

Scroll to Line Ctrl＋G 

Find and Replace Ctrl＋F 

Type Setting Alt＋F8 

Syntax Check Alt＋C 

Exit Alt＋F4 

Font Setting Alt＋S 

Show / Hide the Syntax Check output window Ctrl＋O 

Go to Definition (shown in Script Comment) F12 
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12.3 Programming Model 

12.3.1 Web Window 

12.3.1.1 Basic Graphics 

1. Line  

The properties of a line segment in the script are shown in the following figure. 

 
Property List: 

Property Description Definition Scripting Sample  

Height Height Double Height 
'Set the height of Line1 to 100. 

WebWindow1.Line1.Height=100  

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: Line1 is displayed on the web window. 

WebWindow1.Line1.IsShow=True 

'False: Line 1 is hidden on the web window. 

WebWindow1.Line1.IsShow=False 

Left Left position Double Left 

'The left horizontal coordinate of Line 1 on the 

web window is 100. 

WebWindow1.Line1.Left=100 

Length Length Double Length 
'The length of Line1 is 100. 

WebWindow1.Line1.Length=100 

Name Name String Name 

'Get the name of Line1 and show it in the 

textbox. 

WebWindow1.Textbox1.Text=WebWindow1.

Line1.Name 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of Line1 to ninety 

degrees. 

WebWindow1.Line1.RotateAngle=90 

StrokeThickne Line thickness 
Double 

StrokeThickne
'Set the thickness of Line1 to 10. 
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Property Description Definition Scripting Sample  

ss ss WebWindow1.Line1.StrokeThickness=10 

Top Top position Double Top 

'Set the top vertical coordinate of Line1 on the 

web window to 50. 

WebWindow1.Line1.Top=50 

Width Width Double Width 

'Set the width of Line1 on the web window to 

100. 

WebWindow1.Line1.Width=100 

X1  

X-axis 

coordinate of 

the start point 

Double X1 

'Set the X-axis coordinate of the start point of 

Line1 on the web window to 10. 

WebWindow1.Line1.X1=10 

Y1 

Y-axis 

coordinate of 

the start point 

Double Y1 

'Set the Y-axis coordinate of the start point of 

Line1 on the web window to 20. 

WebWindow1.Line1.Y1=20 

2. Rectangle  

The properties of a rectangle in the script are shown in the following figure. 

 

Property List: 

Property Description Definition Scripting Sample  

Background Fill color 
Object 

Background 

'Set the fill color of the specified object to red. 

WebWindow0.Rectangle1.Background=Color

s.Red 

Height Height Double Height 
'Set the height of the specified object to 100. 

WebWindow0.Rectangle1.Height = 100 

IsShow 

Display or 

hide the 

selected 

Boolean 

IsShow 

'True: The specified object is displayed on the 

web window. 

WebWindow0.Rectangle1.IsShow = True 
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Property Description Definition Scripting Sample  

object 'False: The specified object is hidden on the 

web window. 

WebWindow0.Rectangle1.IsShow = False 

Left Left position Double Left 

'The left horizontal coordinate of the object on 

the web window is 100. 

WebWindow0.Rectangle1.Left = 100 

Name Name String Name 

'Get the name of the specified object. 

WebWindow0.TextBox1.Text = WebWindow0

.Rectangle1.Name 

Opacity Opacity Double Opacity 
'The opacity of the specified object 

WebWindow0.Rectangle1.Opacity = 50 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object 

to 90 degrees. 

WebWindow0.Rectangle1.RotateAngle = 90 

StrokeThickne

ss 

Border 

thickness 

Double 

StrokeThickne

ss 

'Set the border thickness of Rectangle1 to 5. 

WebWindow0.Rectangle1.StrokeThickness = 

5 

Top 
Top 

coordinate 
Double Top 

'The top vertical coordinate of the object on the 

web window is 100. 

WebWindow0.Rectangle1.Top = 100 

Width Width Double Width 
'Set the width of the specified object to 100. 

WebWindow0.Rectangle1.Width = 100 
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3. Round Rectangle 

The properties of a round rectangle in the script are shown in the following figure. 

 

Property List: 

Property Description Definition Scripting Sample  

Background Fill color 
Object 

Background 

'Set the fill color of the specified object to red. 

WebWindow0.RoundRectangle1.Background

=Colors.Red 

BorderRadius 
Corner 

radius 

Double 

BorderRadius 

'Set the Corner radius of the specified object 

to 45 

WebWindow0.RoundRectangle1.BorderRadi

us= 45 

Height Height Double Height 
'Set the height of the specified object to 100. 

WebWindow0.RoundRectangle1.Height = 100 

IsShow 

Display or 

hide the 

selected 

object 

Boolean IsShow 

'True: The specified object is displayed on the 

web window. 

WebWindow0.RoundRectangle1.IsShow = 

True 

'False: The specified object is hidden on the 

web window. 

WebWindow0.RoundRectangle1.IsShow = 

False 

Left Left position Double Left 

'The left horizontal coordinate of the object on 

the web window is 100. 

WebWindow0.RoundRectangle1.Left = 100 
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Property Description Definition Scripting Sample  

Name Name String Name 

'Get the name of the specified object. 

WebWindow0.TextBox1.Text = WebWindow0

.RoundRectangle1.Name 

Opacity Opacity Double Opacity 
'The opacity of the specified object 

WebWindow0.RoundRectangle1.Opacity = 50 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object 

to 90 degrees. 

WebWindow0.RoundRectangle1.RotateAngle 

= 90 

StrokeThickne

ss 

Border 

thickness 

Double 

StrokeThicknes

s 

'Set the border thickness of the object to 5. 

WebWindow0.RoundRectangle1.StrokeThick

ness = 5 

Top Top position Double Top 

'The top vertical coordinate of the object on the 

web window is 100. 

WebWindow0.RoundRectangle1.Top = 100 

Width Width Double Width 
'Set the width of the specified object to 100. 

WebWindow0.RoundRectangle1.Width = 100 

4. Ellipse 

The properties of an ellipse in the script are shown in the following figure. 
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Property List: 

Property Description Definition Scripting Sample  

Background Fill color 
Object 

Background 

'Set the fill color of the specified object to red. 

WebWindow0.Ellipse1.Background=Colors.R

ed 

Height Height Double Height 
'Set the height of the specified object to 100. 

WebWindow0.Ellipse1.Height = 100 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: The specified object is displayed on the 

web window. 

WebWindow0.Ellipse1.IsShow = True 

'False: The specified object is hidden on the 

web window. 

WebWindow0.Ellipse1.IsShow = False 

Left Left position Double Left 

'The left horizontal coordinate of the object on 

the web window is 100. 

WebWindow0.Ellipse1.Left = 100 

Name Name String Name 

'Get the name of the specified object. 

WebWindow0.TextBox1.Text = WebWindow0.

Ellipse1.Name 

Opacity Opacity 
Double 

Opacity 

'The opacity of the specified object 

WebWindow0.Ellipse1.Opacity = 50 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object to 

90. 

WebWindow0.Ellipse1.RotateAngle = 90 

StrokeThickne

ss 

Border 

thickness 

Double 

StrokeThickne

ss 

'Set the border thickness of the object to 5. 

WebWindow0.Ellipse1.StrokeThickness = 5 

Top Top position Double Top 

'The top vertical coordinate of the object on the 

web window is 100. 

WebWindow0.Ellipse1.Top = 100 

Width Width Double Width 
'Set the width of the specified object to 100. 

WebWindow0.Ellipse1.Width = 100 
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5. Polyline 

The properties of a polyline in the script are shown in the following figure. 

 

Property List: 

Property Description Definition Scripting Sample  

Height Height Double Height 
'Set the height of the specified object to 100. 

WebWindow1.Polyline1.Height = 100 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: The specified object is displayed on the 

web window. 

WebWindow1.Polyline1.IsShow = True 

'False: The specified object is hidden on the 

web window. 

WebWindow1.Polyline1.IsShow = False 

Left Left position Double Left 

'The left horizontal coordinate of the object on 

the web window is 100. 

WebWindow1.Polyline1.Left = 100 

Name Name String Name 

'Get the name of the specified object. 

WebWindow1.TextBox1.Text = WebWindow1.

Polyline1.Name 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object to 

90. 

WebWindow1.Polyline1.RotateAngle = 90 

StrokeThickne

ss 

Border 

thickness 

Double 

StrokeThickne

ss 

'Set the border thickness of the object to 5. 

WebWindow1.Polyline1.StrokeThickness = 5 

Top Top position Double Top 

'The top vertical coordinate of the object on the 

web window is 100. 

WebWindow1.Polyline1.Top = 100 

Width Width Double Width 
'Set the width of the specified object to 100. 

WebWindow1.Polyline1.Width = 100 

6. Polygon  
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The properties of a polygon in the script are shown in the following figure. 

 

Property List: 

Property 
Descripti

on 
Definition Scripting Sample  

Background Fill color 
Object 

Background 

'Set the fill color of the specified object to red. 

WebWindow0.Polygon1.Background=Colors.Re

d 

Height Height Double Height 
'Set the height of the specified object to 100. 

WebWindow0.Polygon1.Height = 100 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: The specified object is displayed on the 

web window. 

WebWindow0.Polygon1.IsShow = True 

'False: The specified object is hidden on the web 

window. 

WebWindow0.Polygon1.IsShow = False 

Left 
Left 

position 
Double Left 

'The left horizontal coordinate of the object on the 

web window is 100. 

WebWindow0.Polygon1.Left = 100 

Name Name String Name 

'Get the name of the specified object. 

WebWindow0.TextBox1.Text = WebWindow0.Po

lygon1.Name 

Opacity Opacity 
Double 

Opacity 

'The opacity of the specified object 

WebWindow0.Polygon1.Opacity = 50 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object to 

90 degrees. 

WebWindow0.Polygon1.RotateAngle = 90 

StrokeThickne

ss 

Border 

thickness 

Double 

StrokeThickne

'Set the border thickness of the object to 5. 

WebWindow0.Polygon1.StrokeThickness = 5 
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Property 
Descripti

on 
Definition Scripting Sample  

ss 

Top 
Top 

position 
Double Top 

'The top vertical coordinate of the object on the 

web window is 100. 

WebWindow0.Polygon1.Top = 100 

Width Width Double Width 
'Set the width of the specified object to 100. 

WebWindow0.Polygon1.Width = 100 

7. Bezier Curve  

The properties of a Bezier curve in the script are shown in the following figure. 

 

Property List: 

Property Description Definition Scripting Sample  

Height Height Double Height 
'Set the height of the specified object to 100. 

WebWindow1.BezierCurve1.Height = 100 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: The specified object is displayed on the 

web window. 

WebWindow1.BezierCurve1.IsShow = True 

'False: The specified object is hidden on the 

web window. 

WebWindow1.BezierCurve1.IsShow = False 

Left Left position Double Left 

'The left horizontal coordinate of the object on 

the web window is 100. 

WebWindow1.BezierCurve1.Left = 100 

Name Name String Name 

'Get the name of the specified object. 

WebWindow1.TextBox1.Text = WebWindow1.

BezierCurve1.Name 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object to 

90 degrees. 

WebWindow1.BezierCurve1.RotateAngle = 90 
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Property Description Definition Scripting Sample  

StrokeThickne

ss 

Border 

thickness 

Double 

StrokeThickne

ss 

'Set the border thickness of the object to 5.。 

WebWindow1.BezierCurve1.StrokeThickness 

= 5 

Top Top position Double Top 

'The top vertical coordinate of the object on the 

web window is 100. 

WebWindow1.BezierCurve1.Top = 100 

Width Width Double Width 
'Set the width of the specified object to 100. 

WebWindow1.BezierCurve1.Width = 100 

8. Closed Curve  

The properties of a closed curve in the script are shown in the following figure. 
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Property List: 

Property 
Descripti

on 
Definition Scripting Sample  

Background Fill color 
String 

Background 

'Set the fill color of ClosedCurve1 to green. 

WebWindow1.ClosedCurve1. 

Background=Colors.Red 

Height Height Double Height 
'Set the height of ClosedCurve1 to 100. 

WebWindow1.ClosedCurve1.Height=100 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: ClosedCurve1 is displayed on the web 

window. 

WebWindow1.ClosedCurve1.IsShow=True 

'False: ClosedCurve1 is hidden on the web 

window. 

WebWindow1.ClosedCurve1.IsShow=False 

Left 
Left 

position 
Double Left 

'The left horizontal coordinate of ClosedCurve1 

on the web window is 100. 

WebWindow1.ClosedCurve1.Left=100 

Name Name String Name 

'Get the name of ClosedCurve1 and show it in the 

textbox. 

WebWindow1.TextBox1.Text=WebWindow1.Clo

sedCurve1.Name 

Opacity Opacity 
Double 

Opacity 

'Set the opacity of ClosedCurve1 to 8%. 

WebWindow1.ClosedCurve1.Opacity=80 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of ClosedCurve1 to 90 

degrees. 

WebWindow1.ClosedCurve1.RotateAngle=90 

StrokeThickne

ss 

Border 

thickness 

Double 

StrokeThickne

ss 

'Set the border thickness of ClosedCurve1 to 10. 

WebWindow1.ClosedCurve1.StrokeThickness=1

0 

Top 
Top 

position 
Double Top 

'The top vertical coordinate of ClosedCurve1 on 

the web window is 50.  

WebWindow1.ClosedCurve1.Top=50 

Width Width Double Width 

'Set the width of ClosedCurve1 on the web 

window to 100. 

WebWindow1.ClosedCurve1. Width=100 
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9. Arc  

The properties of an arc control in the script are shown in the following figure. 

 

Property List: 

Property 
Descripti

on 
Definition Scripting Sample  

Height Height Double Height 
'Set the height of Arc1 to 100. 

WebWindow1.Arc1.Height = 100 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: Arc1 is displayed on the web window. 

WebWindow1.Arc1.IsShow = True 

'False: Arc1 is hidden on the web window. 

WebWindow1.Arc1.IsShow = False 

Left 
Left 

position 
Double Left 

'The left horizontal coordinate of Arc1 on the web 

window is 100. 

WebWindow1.Arc1.Left = 100 

Name Name String Name 

'Get the name of Arc1. 

WebWindow1.TextBox1.Text =WebWindow1.Ar

c1.Name 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of Arc1 to 90. 

WebWindow1.Arc1.RotateAngle = 90 

StartAngle Start angle 
Double 

StartAngle 

'The start angle of Arc1 is 90 degrees. 

WebWindow1.Arc1.StartAngle = 90 

StrokeThickne

ss 

Line 

thickness 

Double 

StrokeThickne

ss 

'Set the line thickness of Arc1 to 5. 

WebWindow1.Arc1.StrokeThickness = 5 

SweepAngle 
Sweep 

angle 

Double 

SweepAngle 

'The sweep angle of Arc1 is 90 degrees. 

WebWindow1.Arc1.SweepAngle = 90 

Top 
Top 

position 
Double Top 

'The top vertical coordinate of Arc1 on the web 

window is 100. 
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Property 
Descripti

on 
Definition Scripting Sample  

WebWindow1.Arc1.Top = 100 

Width Width Double Width 
'Set the width of Arc1 to 100. 

WebWindow1.Arc1.Width = 100 

10. Arch  

The properties of an arch control in the script are shown in the following figure. 

 

Property List: 

Property 
Descriptio

n 
Definition Scripting Sample  

Background Fill color 
Object 

Background 

'Set the fill color of the specified object to red. 

WebWindow0.Arch1.Background=Colors.Red 

Height Height Double Height 
'Set the height of the specified object to 100. 

WebWindow1.Arch1.Height = 100 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: The specified object is displayed on the 

web window. 

WebWindow1.Arch1.IsShow = True 

'False: The specified object is hidden on the web 

window. 

WebWindow1.Arch1.IsShow = False 

Left 
Left 

position 
Double Left 

'The left horizontal coordinate of the object on 

the web window is 100. 

WebWindow1.Arch1.Left = 100 

Name Name String Name 
'Get the name of the specified object. 

WebWindow1.TextBox1.Text =WebWindow1.Ar
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Property 
Descriptio

n 
Definition Scripting Sample  

ch1.Name 

Opacity Opacity 
Double 

Opacity 

'The opacity of the specified object is 50. 

WebWindow0.Arch1.Opacity = 50 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object to 

90. 

WebWindow1.Arch1.RotateAngle = 90 

StartAngle Start angle 
Double 

StartAngle 

'Set the start angle of Arch1 to 90 degrees. 

WebWindow1.Arch1.StartAngle = 90 

StrokeThickne

ss 

Border 

thickness 

Double 

StrokeThickne

ss 

'Set the border thickness of Arch1 to 5. 

WebWindow1.Arch1.StrokeThickness = 5 

SweepAngle 
Sweep 

angle 

Double 

SweepAngle 

'Set the sweep angle of Arch1 to 90 degrees. 

WebWindow1.Arch1.SweepAngle = 90 

Top 
Top 

position 
Double Top 

'The top vertical coordinate of the object on the 

web window is 100. 

WebWindow1.Arch1.Top = 100 

Width Width Double Width 
'Set the width of the specified object to 100. 

WebWindow1.Arch1.Width = 100 
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11. Pie  

The properties of a pie in the script are shown in the following figure. 

 

Property List: 

Property 
Descripti

on 
Definition Scripting Sample  

Background Fill color 
Object 

Background 

'Set the fill color of the specified object to red. 

WebWindow0.Pie1.Background=Colors.Red 

Height Height Double Height 
'Set the height of Pie1 to 100. 

WebWindow1.Pie1.Height = 100 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: Pie1 is displayed on the web window. 

WebWindow1.Pie1.IsShow = True 

'False: Pie1 is hidden on the web window. 

WebWindow1.Pie1.IsShow = False 

Left 
Left 

position 
Double Left 

'The left horizontal coordinate of Pie1 on the web 

window is 100. 

WebWindow1.Pie1.Left = 100 

Name Name String Name 

'Get the name of Pie1. 

WebWindow1.TextBox1.Text =WebWindow1.Pi

e1.Name 

Opacity Opacity 
Double 

Opacity 

'Set the opacity of Pie1. 

WebWindow0.Pie1.Opacity = 50 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of Pie1 to 90. 

WebWindow1.Pie1.RotateAngle = 90 
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Property 
Descripti

on 
Definition Scripting Sample  

Start Angle Start angle 
Double Start 

Angle 

'The start angle of Pie1 is 90 degrees. 

WebWindow1.Pie1.StartAngle = 90 

Stroke 

Thickness 

Border 

thickness 

Double Stroke 

Thickness 

'Set the line thickness of Pie1 to 5. 

WebWindow1.Pie1.StrokeThickness = 5 

Sweep Angle 
Sweep 

angle 

Double Sweep 

Angle 

'The sweep angle of Pie1 is 90 degrees. 

WebWindow1.Pie1.SweepAngle = 90 

Top 
Top 

position 
Double Top 

'The top vertical coordinate of Pie1 on the web 

window is 100. 

WebWindow1.Pie1.Top = 100 

Width Width Double Width 
'Set the width of Pie1 to 100. 

WebWindow1.Pie1.Width = 100 

12. Pipe  

The properties of a pipe control in the script are shown in the following figure. 

 

Property List: 

Property Description Definition Scripting Sample  

ForwardFlow 
Liquid flow 

direction 

Boolean 

ForwardFlow 

'True: Forward flow 

WebWindow1.Pipe1.ForwardFlow=True 

'False: Reverse flow 

WebWindow1.Pipe1.ForwardFlow=False 

Height Height 
Double 

Height 

'Set the height of Pipe1 to 100. 

WebWindow1.Pipe1.Height = 100 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: Pipe1 is displayed on the web window. 

WebWindow1.Pipe1.IsShow = True 

'False: Pipe1 is hidden on the web window. 
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Property Description Definition Scripting Sample  

WebWindow1.Pipe1.IsShow = False 

Left Left position Double Left 

'The left horizontal coordinate of Pipe1 on the web window 

is 100. 

WebWindow1.Pipe1.Left = 100 

LiquidWidth Liquid width 
Double 

LiquidWidth 

'Set the liquid width of Pipe1 to 30. 

WebWindow1.Pipe1.LiquidWidth=30 

Name Name String Name 
'Get the name of Pipe1. 

WebWindow1.TextBox1.Text =WebWindow1.Pipe1.Name 

PipeWidth Pipe width 
Double 

PipeWidth 

'Set the pipe width of Pipe1 to 100. 

WebWindow1.Pipe1.PipeWidth=100 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of Pipe1 to 90. 

WebWindow1.Pipe1.RotateAngle = 90 

Top Top position Double Top 

'The top vertical coordinate of Pipe1 on the web window is 

100. 

WebWindow1.Pipe1.Top = 100 

Width Width 
Double 

Width 

'Set the width of Pipe1 to 100. 

WebWindow1.Pipe1.Width = 100 
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13. Group  

The properties of a control group in the script are shown in the following figure. 

 

Property List: 

Property Description Definition Scripting Sample  

Height Height 
Double 

Height 

'Set the height of Group1 to 100. 

WebWindow1.Group1.Height = 100 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: Group1 is displayed on the web window. 

WebWindow1. Group1.IsShow = True 

'False: Group1 is hidden on the web window. 

WebWindow1.Group1.IsShow = False 

Left Left position Double Left 

'The left horizontal coordinate of Group1 on the web window 

is 100. 

WebWindow1.Group1.Left = 100 

Name Name String Name 
'Get the name of Group1. 

WebWindow1.TextBox1.Text =WebWindow1.Group1.Name 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of Group1 to 90. 

WebWindow1.Group1.RotateAngle = 90 

Top Top position Double Top 

'The top vertical coordinate of Group1 on the web window is 

100. 

WebWindow1.Group1.Top = 100 

Width Width 
Double 

Width 

'Set the width of Group1 to 100. 

WebWindow1.Group1.Width = 100 
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12.3.1.2 Window Controls 

1. Button  

The properties of a button control in the script are shown in the following figure. 

 

Property List: 

Property Description Definition Scripting Sample  

Background Fill color 
Object 

Background 

'Set the fill color of the specified object to Red. 

WebWindow0.Button1.Background=Colors.Red 

BorderBrush Border color 
Object 

BorderBrush 

'Set the border color of the specified object to Blue. 

WebWindow0.Button1.BorderBrush = Colors.Blue 

Content Text content 
String 

Content 

'Get or set the text content of Buttion1. 

WebWindow0.Button1.Content = "Delta" 

FontSize Font size 
Double 

FontSize 

'Set the font size of the specified object to 20. 

WebWindow0.Button1.FontSize = 20 

Foreground 
Foreground 

color 

Object 

Foreground 

'Set the foreground color of the specified object to Yellow. 

WebWindow0.Button1.Foreground = Colors.Yellow 
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Property Description Definition Scripting Sample  

Height Height Double Height 
'Set the height of the specified object to 100. 

WebWindow0.Button1.Height = 100 

IsEnabled 
Enable or 

disable 

Boolean 

IsEnabled 

'Enable the control. 

WebWindow0.Button1.IsEnabled = True 

'Disable the control. 

WebWindow0.Button1.IsEnabled = False 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: The specified object is displayed on the web window. 

WebWindow0.Button1.IsShow = True 

'False: The specified object is hidden on the web window. 

WebWindow0.Button1.IsShow = False 

Left Left position Double Left 

'The left horizontal coordinate of the object on the web 

window is 100. 

WebWindow0.Button1.Left = 100 

Name Name String Name 
'Get the name of the specified object. 

WebWindow0.TextBox1.Text = WebWindow0.Button1.Name 

Opacity Opacity 
Double 

Opacity 

'The opacity of the specified object 

WebWindow0.Button1.Opacity = 50 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object to 90 degrees. 

WebWindow0.Button1.RotateAngle = 90 

Top Top position Double Top 

'The top vertical coordinate of the object on the web window 

is 100. 

WebWindow0.Button1.Top = 100 

Width Width Double Width 
'Set the width of the specified object to 100. 

WebWindow0.Button1.Width = 100 
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2. Check Box 

The properties of a check box in the script are shown in the following figure. 

 

Property List: 

Property Description Definition Scripting Sample  

Content Text content  
String 

Content 

'Get or set the text content of CheckBox1. 

WebWindow0.CheckBox1.Content = "Delta" 

FontSize Font size 
Double 

FontSize 

'Set the font size of the specified object to 20. 

WebWindow0.CheckBox1.FontSize = 20 

Foreground 
Foreground 

color 

Object 

Foreground 

'Set the foreground color of the specified object to Yellow. 

WebWindow0.CheckBox1.Foreground = Colors.Yellow 

Height Height 
Double 

Height 

'Set the height of the specified object to 100. 

WebWindow0.CheckBox1.Height = 100 

IsChecked 
Selected or 

not 

Boolean 

IsChecked 

'The control is selected. 

WebWindow0.CheckBox1.IsChecked = True 

'The control is unselected. 

WebWindow0.CheckBox1.IsChecked=False 

IsEnabled 
Enabled or 

not 

Boolean 

IsEnabled 

'The control is enabled. 

WebWindow0.CheckBox1.IsEnabled = True 

'The control is disabled. 

WebWindow0.CheckBox1.IsEnabled = False 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: The specified object is displayed on the web window. 

WebWindow0.CheckBox1.IsShow = True 

'False: The specified object is hidden on the web window. 

WebWindow0.CheckBox1.IsShow = False 

Left Left position Double Left 
'The left horizontal coordinate of the object on the web window is 

100. 
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Property Description Definition Scripting Sample  

WebWindow0.CheckBox1.Left = 100 

Name Name String Name 
'Get the name of the specified object. 

WebWindow0.TextBox1.Text = WebWindow0.CheckBox1.Name 

Opacity Opacity 
Double 

Opacity 

'The opacity of the specified object 

WebWindow0.CheckBox1.Opacity = 50 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object to 90 degrees. 

WebWindow0.CheckBox1.RotateAngle = 90 

Top Top position Double Top 

'The top vertical coordinate of the object on the web window is 

100. 

WebWindow0.CheckBox1.Top = 100 

Width Width 
Double 

Width 

'Set the width of the specified object to 100. 

WebWindow0.CheckBox1.Width = 100 
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3. Combo Box 

You can perform the following operations for a combo box in a script. 

 

Operation Description Parameter Scripting Sample  

AddItem(item) Add an item. 

The item 

parameter 

is required, 

with the 

data type of 

String. 

'Add the item A. 

WebWindow1.ComboBox1.AddItem("A") 

AddItems(items) 
Add an item 

set 

The items 

are required, 

separated by 

a comma and 

with the data 

type of String 

'Add a set of items A, B and C. 

WebWindow1.ComboBox1.AddItems("A,B,C") 

ClearItems() 
Clear the 

item set. 
———— 

'Clear all items in the set. 

WebWindow1.ComboBox1.ClearItems() 

RemoveAtItem(index) 

Remove the 

specified 

item 

according to 

the index. 

The index 

parameter is 

required, with 

the data type 

of Int. 

'Remove the first item in ComboBox1. 

WebWindow1.ComboBox1.RemoveAtItem(0) 

RemoveItem(item) 

Remove the 

specified 

item 

The item 

parameter 

is required, 

with the 

data type of 

String. 

'Remove the specified item A. 

WebWindow1.ComboBox1.RemoveItem("A") 
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The properties of a combo box in the script are shown in the following figure. 

 

Property List: 

Property 
Descripti

on 
Definition Scripting Sample  

Background 
Backgroun

d color 

Object 

Background 

'Set the background color of the specified object to 

Yellow. 

WebWindow1.ComboBox1.Background=Colors.Yello

w 

BorderBrus

h 

Border 

color 

Object 

BorderBrush 

'Set the border color of the specified object to Red. 

WebWindow1.ComboBox1.BorderBrush=Colors.Red 

FontSize Font size 
Double 

FontSize 

'Set the font size of the text of the specified object to 

20. 

WebWindow1.ComboBox1.FontSize=20 

Foreground 
Foregroun

d color 

Object 

Foreground 

'Set the foreground color of the specified object to 

Blue. 

WebWindow1.ComboBox1.Foreground=Colors.Blue 

Height Height 
Double 

Height 

'Set the height of the specified object to 100. 

WebWindow1.ComboBox1.Height=100 

IsEnabled Enable 
Boolean 

IsEnabled 

'Enable the control. 

WebWindow1.ComboBox1.IsEnabled=True 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: The specified object is displayed on the web 

window. 

WebWindow1.ComboBox1.IsShow=True 

'False: The specified object is hidden on the web 
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Property 
Descripti

on 
Definition Scripting Sample  

window. 

WebWindow1.ComboBox1.IsShow = False 

Left 
Left 

position 
Double Left 

'The left horizontal coordinate of the object on the web 

window is 100. 

WebWindow1.ComboBox1.Left = 100 

Name Name String Name 

'Get the name of the specified object. 

WebWindow1.TextBox1.Text = WebWindow1.Comb

oBox1.Name 

Opacity Opacity 
Double 

Opacity 

'The opacity of the specified object is 50. 

WebWindow1.ComboBox1.Opacity=50 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object to 90. 

WebWindow1.ComboBox1.RotateAngle = 90 

SelectedInd

ex 

Get or set 

the index 

of the 1st 

item.  

(It returns -

1 for a null 

selection.) 

Int32 

SelectedInd

ex 

'Select the first item in ComboBox1. 

WebWindow1.ComboBox1.SelectedIndex=0 

SelectedVal

ue 

Select a 

value 

String 

SelectedVal

ue 

'Select A in ComboBox1. 

WebWindow1.ComboBox1.SelectedValue="A" 

Text 

Set or get 

text 

content 

String Text 
'Set the text content of ComboBox1 to A. 

WebWindow1.ComboBox1.Text="A" 

Top 
Top 

position 
Double Top 

'The top vertical coordinate of the object on the web 

window is 100. 

WebWindow1.ComboBox1.Top = 100 

Width Width 
Double 

Width 

'Set the width of the specified object to 100. 

WebWindow1.ComboBox1.Width = 100 
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4. Label  

The properties of a label control in the script are shown in the following figure. 

 

Property List: 

Property Description Definition Scripting Sample  

Background 
Background 

color 

Object 

Background 

'Set the background color of the specified object to Yellow. 

WebWindow1.Label1.Background = Colors.Yellow 

FontSize Font size 
Double 

FontSize 

'Set the font size of the text content of the object to 20. 

WebWindow1.Label1.FontSize=20 

Foreground 
Foreground 

color 

Object 

Foreground 

'Set the foreground color of the specified object to Blue. 

WebWindow1.Label1.Foreground = Colors.Blue 

Height Height 
Double 

Height 

'Set the height of the specified object to 100. 

WebWindow1.Label1.Height=100 

IsEnabled Enable 
Boolean 

IsEnabled 

'Enable the control. 

WebWindow1.Label1.IsEnabled=True 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: The specified object is displayed on the web window. 

WebWindow1.Label1.IsShow=True 

'False: The specified object is hidden on the web window. 

WebWindow1.Label1.IsShow = False 

Left Left position Double Left 

'The left horizontal coordinate of the object on the web 

window is 100. 

WebWindow1.Label1.Left = 100 
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Property Description Definition Scripting Sample  

Name Name String Name 
'Get the name of the specified object. 

WebWindow1.TextBox1.Text = WebWindow1.Label1.Name 

Opacity Opacity 
Double 

Opacity 

'The opacity of the specified object is 50. 

WebWindow1.Label1.Opacity=50 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object to 90. 

WebWindow1.Label1.RotateAngle = 90 

Text 
Set or get 

text content 
String Text 

'Set the text content of Label1 to A. 

WebWindow1.Label1.Text="A" 

Top Top position Double Top 

'The top vertical coordinate of the object on the web window 

is 100. 

WebWindow1.Label1.Top = 100 

Width Width 
Double 

Width 

'Set the width of the specified object to 100. 

WebWindow1.Label1.Width = 100 

5. Text Box  

You can perform the following operations for a text box in a script. 

 

Operation Description Scripting Sample 

Focus() 
Set the focus on this 

control. 

'The focus is on TextBox1. 

WebWindow1.TextBox1.Focus() 

SelectAll() 
Select all contents of the 

text box 

'Select all contents in TextBox1. (Note: set the 

focus on the textbox first.) 

WebWindow1.TextBox1.Focus() 

WebWindow1.TextBox1.SelectAll() 
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The properties of a text box in the script are shown in the following figure. 

 

Property List: 

Property Description Definition Scripting Sample  

Background 
Background 

color 

Object 

Background 

'Set the background color of the specified 

object to Yellow. 

WebWindow1.TextBox1.Background = 

Colors.Yellow 

BorderBrush Border color 
Object 

BorderBrush 

'Set the border color of the specified object to 

Red. 

WebWindow1.TextBox1.BorderBrush = 

Colors.Red 

FontSize Font size 
Double 

FontSize 

'Set the font size of the text content of the 

object to 20. 

WebWindow1.TextBox1.FontSize=20 

Foreground 
Foreground 

color 

Object 

Foreground 

'Set the foreground color of the specified object 

to Blue. 

WebWindow1.TextBox1.Foreground = 

Colors.Blue 

Height Height Double Height 
'Set the height of the specified object to 100. 

WebWindow1.TextBox1.Height=100 

IsEnabled Enable 
Boolean 

IsEnabled 

'Enable the control. 

WebWindow1.TextBox1.IsEnabled=True 
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Property Description Definition Scripting Sample  

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: The specified object is displayed on the 

web window. 

WebWindow1.TextBox1.IsShow=True 

'False: The specified object is hidden on the 

web window. 

WebWindow1.TextBox1.IsShow = False 

Left Left position Double Left 

'The left horizontal coordinate of the object on 

the web window is 100. 

WebWindow1.TextBox1.Left = 100 

Name Name String Name 

'Get the name of the specified object. 

WebWindow1.TextBox1.Text = WebWindow1. 

TextBox1.Name 

Opacity Opacity 
Double 

Opacity 

'The opacity of the specified object 

WebWindow1.TextBox1.Opacity=50 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object to 

90. 

WebWindow1.TextBox1.RotateAngle = 90 

Text 
Set or get 

text content 
String Text 

'Set the text content of TextBox1 to A. 

WebWindow1.TextBox1.Text="A" 

Top Top position Double Top 

'The top vertical coordinate of the object on the 

web window is 100. 

WebWindow1.TextBox1.Top = 100 

Width Width Double Width 
'Set the width of the specified object to 100. 

WebWindow1.TextBox1.Width = 100 

 

  



  Chapter  1  In t roduct ion  

1_ 

6. Password Box  

The properties of a password box in the script are shown in the following figure. 

 

Property List: 

Property 
Descripti

on 
Definition Scripting Sample  

Backgroun

d 

Backgroun

d color 

Object 

Background 

'Set the background color of the specified object to red. 

WebWindow0.PasswordBox1.Background=Colors.Re

d 

BorderBru

sh 

Border 

color 

Object 

BorderBrush 

'Set the border color of the specified object to Blue. 

WebWindow0.PasswordBox1.BorderBrush = 

Colors.Blue 

FontSize Font size 
Double 

FontSize 

'Set the font size of the specified object to 20. 

WebWindow0.PasswordBox1.FontSize = 20 

Foregroun

d 

Foregroun

d color 

Object 

Foreground 

'Set the foreground color of the specified object to 

Yellow.  

WebWindow0.PasswordBox1.Foreground = 

Colors.Yellow 

Height Height Double Height 
'Set the height of the specified object to 100. 

WebWindow0.PasswordBox1.Height = 100 

IsEnabled 
Enable or 

not 

Boolean 

IsEnabled 

'Enable the control. 

WebWindow0.PasswordBox1.IsEnabled = True 

'Disable the control. 

WebWindow0.PasswordBox1.IsEnabled = False 

IsShow Display or Boolean 'True: The specified object is displayed on the web 
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Property 
Descripti

on 
Definition Scripting Sample  

hide the 

selected 

object 

IsShow window. 

WebWindow0.PasswordBox1.IsShow = True 

'False: The specified object is hidden on the web 

window. 

WebWindow0.PasswordBox1.IsShow = False 

Left 
Left 

position 
Double Left 

'The left horizontal coordinate of the object on the web 

window is 100. 

WebWindow0.PasswordBox1.Left = 100 

Name Name String Name 

'Get the name of the specified object. 

WebWindow0.TextBox1.Text = WebWindow0.Passwor

dBox1.Name 

Opacity Opacity 
Double 

Opacity 

'The opacity of the specified object 

WebWindow0.PasswordBox1.Opacity = 50 

Password Password 
String 

Password 

'Set the password. 

WebWindow0.PasswordBox1.Password = “123456” 

RotateAngl

e 

Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object to 90 

degrees. 

WebWindow0.PasswordBox1.RotateAngle = 90 

Top 
Top 

position 
Double Top 

'The top vertical coordinate of the object on the web 

window is 100. 

WebWindow0.PasswordBox1.Top = 100 

Width Width Double Width 
'Set the width of the specified object to 100. 

WebWindow0.PasswordBox1.Width = 100 

 

  



  Chapter  1  In t roduct ion  

1_ 

7. Date Time Picker 

The properties of a date time picker in the script are shown in the following figure. 

 

Property List: 

Property 
Descriptio

n 
Definition Scripting Sample  

Backgroun

d 

Backgroun

d color 

Object 

Background 

‘Set the background color of the specified object to 

Yellow. 

WebWindow1.DateTimePicker1.Background = 

Colors.Yellow 

BorderBrus

h 

Border 

color 

Object 

BorderBrus

h 

‘Set the border color of the specified object to Red. 

WebWindow1.DateTimePicker1.BorderBrush = 

Colors.Red 

FontSize Font size 
Double 

FontSize 

'Set the font size of the text of the specified object to 

20. 

WebWindow1.DateTimePicker1.FontSize=20 

Foreground 
Foregroun

d color 

Object 

Foreground 

'Set the foreground color of the specified object to Blue. 

WebWindow1.DateTimePicker1.Foreground = 

Colors.Blue 

Height Height 
Double 

Height 

'Set the height of the specified object to 100. 

WebWindow1.DateTimePicker1.Height=100 

IsEnabled Enable 
Boolean 

IsEnabled 

'Enable the control. 

WebWindow1.DateTimePicker1.IsEnabled=True 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: The specified object is displayed on the web 

window. 

WebWindow1.DateTimePicker1.IsShow=True 

'False: The specified object is hidden on the web 
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Property 
Descriptio

n 
Definition Scripting Sample  

window. 

WebWindow1.DateTimePicker1.IsShow = False 

Left 
Left 

position 
Double Left 

'The left horizontal coordinate of the object on the web 

window is 100. 

WebWindow1.DateTimePicker1.Left = 100 

Name Name 
String 

Name 

'Get the name of the specified object. 

WebWindow1.TextBox1.Text = WebWindow1.DateTi

mePicker1.Name 

Opacity Opacity 
Double 

Opacity 

'The opacity of the specified object 

WebWindow1.DateTimePicker1.Opacity=50 

RotateAngl

e 

Rotation 

angle 

Double 

RotateAngl

e 

'Set the rotation angle of the specified object to 90. 

WebWindow1.DateTimePicker1.RotateAngle = 90 

Top 
Top 

position 
Double Top 

'The top vertical coordinate of the object on the web 

window is 100. 

WebWindow1.DateTimePicker1.Top = 100 

ValueTime 
Display the 

time value 

String 

ValueTime 

'Display the time value 

WebWindow1.Label1.Text = 

WebWindow1.DateTimePicker1.ValueTime 

Width Width 
Double 

Width 

'Set the width of the specified object to 100. 

WebWindow1.DateTimePicker1.Width = 100 
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8. Image  

The properties of an image in the script are shown in the following figure. 

 

Property List: 

Property Description Definition Scripting Sample  

Height Height Double Height 
'Set the height of Image1 to 100. 

WebWindow1.Image1.Height=100 

IsEnabled 
Enabled or 

not 

Boolean 

IsEnabled 

'The control is enabled. 

WebWindow1.Image1.IsEnabled=True 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'Image1 is displayed on the web window. 

WebWindow1.Image1.IsShow=True 

'Image1 is hidden on the web window. 

WebWindow1.Image1.IsShow=False 

Left Left position Double Left 

'Set the left horizontal coordinate of Image1 on the web 

window to 100. 

WebWindow1.Image1.Left=100 

Name Name String Name 
'Get the name of Image1 and show it in the textbox. 

WebWindow1.TextBox1.Text=WebWindow1.Image1.Name 

Opacity Opacity 
Double 

Opacity 

'Set the opacity of Image1 to 8%. 

WebWindow1.Image1.Opacity=80 

RotateAngle 
Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of Image1 to 90. 

WebWindow1.Image1.RotateAngle=90 

SwitchingPath Image path 
String 

SwitchingPath 

'Switch the image display in Image1 to “123.jpg” picture 

under “Image” folder (Only the existing pictures in the 

project folder under a relative path can be switched to.) 

WebWindow0.Image1.SwitchingPath="/Image/123.jpg" 

Top Top position Double Top 
'Set the top vertical coordinate of Image1 on the web 

window to 50. 
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Property Description Definition Scripting Sample  

WebWindow1.Image1.Top=50 

Width Width Double Width 
'Set the width of Image1 to 100. 

WebWindow1.Image1.Width=100 

9. Nixie Tube  

The properties of a Nixie tube in the script are shown in the following figure. 

 

Property List: 

Property 
Descripti

on 
Definition Scripting Sample  

Backgrou

nd 

Backgroun

d color 

Object 

Background 

'Set the background color of the specified object to 

Yellow. 

WebWindow1.NixieTube1.Background = 

Colors.Yellow 

Bit 
Decimal 

places 
Int Bit 

'Set the number of decimal places to 5. 

WebWindow1.NixieTube1.Bit = 5 

Height Height 
Double 

Height 

'Set the height of the specified object to 100. 

WebWindow1.NixieTube1.Height=100 

IsEnabled Enable 
Boolean 

IsEnabled 

'Enable the control. 

WebWindow1.NixieTube1.IsEnabled=True 

IsShow 

Display or 

hide the 

selected 

object 

Boolean 

IsShow 

'True: The specified object is displayed on the web 

window. 

WebWindow1.NixieTube1.IsShow=True 

'False: The specified object is hidden on the web 

window. 
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Property 
Descripti

on 
Definition Scripting Sample  

WebWindow1.NixieTube1.IsShow = False 

Left 
Left 

position 
Double Left 

'The left horizontal coordinate of the object on the web 

window is 100. 

WebWindow1.NixieTube1.Left = 100 

Name Name String Name 

'Get the name of the specified object. 

WebWindow1.TextBox1.Text = WebWindow1.NixieTu

be1.Name 

Number 
Number 

display 

Double 

Number 

'Set the value displayed in NixieTube1. 

WebWindow1.NixieTube1.Number=1.23456 

Opacity Opacity 
Double 

Opacity 

'The opacity of the specified object 

WebWindow1.NixieTube1.Opacity=50 

RotateAng

le 

Rotation 

angle 

Double 

RotateAngle 

'Set the rotation angle of the specified object to 90. 

WebWindow1.NixieTube1.RotateAngle = 90 

Top 
Top 

position 
Double Top 

'The top vertical coordinate of the object on the web 

window is 100. 

WebWindow1.NixieTube1.Top = 100 

Width Width 
Double 

Width 

'Set the width of the specified object to 100. 

WebWindow1.NixieTube1.Width = 100 
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12.3.1.3 Command 

 HMICmd Object 

 

HMICmd 

HMICmd is used for calling the commands of opening and closing windows.  

 Command List 

 

 CloseDialogWindow  

This closes a dialog window.  

Definition: 

CloseDialogWindow() 

Example: 

Close the dialog window which is open.  

VBScript Example 

HMICmd.CloseDialogWindow() 

Note: The event script to be executed must be placed in the same window as the dialog 

window to be closed. 
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 CloseWindow  

This closes a window. 

Definition: 

CloseWindow(windowName) 

Parameter: 

Name Required / optional Data type Description 

windowName Required String Window name 

Example: 

Close the window of WebWindow0. Close the windows of WebWindow0, WebWindow1 

and WebWindow2. Employ the same way for closing more web windows. 

VBScript Example 

HMICmd.CloseWindow("WebWindow0") or 

HMICmd.CloseWindow("WebWindow0,WebWindow1,WebWindow2") 

 OpenDialogWindow  

This opens a dialog window. 

Definition: 

OpenDialogWindow(windowName,isShowTitle) 

Parameters: 

Parameter name Required / optional Data type Description 

windowName Required String Window name 

isShowTitle Required Bool 
Whether or not to show the 

title 

Example: 

Open a dialog window. 

VBScript Example 

Call 

HMICmd.OpenDialogWindow("WebWindow0",true) 
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 OpenWindow  

This opens a window.  

Definition: 

OpenWindow(windowName) 

Parameter: 

Parameter name Required/optional Data type Description 

windowName Required String Window name 

Example:  

Open both WebWindow0 and WebWindow1. 

VBScript Example 

HMICmd.OpenWindow("WebWindow0, 

WebWindow1")  

 OpenWindowAndCloseOther 

This just opens the specified window(s) and closes other window(s).  

Definition: 

OpenWindowAndCloseOther(windowName) 

Parameter: 

Parameter name Required / optional Data type Description 

windowName Required String Window name 

Example:  

Open the windows of WebWindow0 and WebWindow1 and close other windows that are 

open.  

VBScript Example 

HMICmd.OpenWindowAndCloseOther("WebWindow0, WebWindow1") 
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12.3.2 Variable 

12.3.2.1 AnalogVariable Object 

The following figure shows the properties of an analog variable in a script. 

 

Property List: 

Property Description Scripting Sample  

DecimalPlac

es 

Number of decimal 

places 

'Get the number of decimal places of the specified variable. 

WebWindow0.TextBox0.Text=Var.Cloud.tag1.DecimalPlac

es  

Description Variable description 

'Get the description of the specified variable. 

WebWindow0.TextBox0.Text=Var.Local.Variable.Descripti

on 

InitValue Initial value 
'Get the initial value of the specified variable. 

WebWindow0.TextBox0.Text=Var.Cloud.tag1.InitValue 

IsSaveHistor

y 

Whether to save the 

history records 

(Only for Cloud tags) 

'Get the setting of the history records of the specified 

variable, which are to be saved or not. 

WebWindow0.TextBox0.Text=Var.Cloud.tag1.IsSaveHistor

y 

MaxValue Maximum value 

'Get the maximum value of the specified variable. 

WebWindow0.TextBox0.Text=Var.Local.Variable.MaxValu

e 

MinValue Minimum value 
'Get the minimum value of the specified variable. 

WebWindow0.TextBox0.Text=Var.Local.Variable.MinValue 

Name Name 
'Get the variable name of the specified variable. 

WebWindow0.TextBox0.Text=Var.Local.Variable.Name 

Path Path 
'Get the path of the specified variable. 

WebWindow0.TextBox0.Text=Var.Cloud.tag1.Path 
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Property Description Scripting Sample  

Value Variable value 
'Get the current value of the specified variable. 

WebWindow0.TextBox0.Text=Var.Cloud.tag1.Value 

12.3.2.2 DigitalVariable Object 

The following figure shows the properties of a digital variable in a script.  

 

 Property List: 

Property Description Scripting Sample  

Description Variable description 

'Get the description of the specified variable. 

WebWindow0.TextBox0.Text=Var.Local.Variable.Descripti

on 

InitValue Initial value 
'Get the initial value of the specified variable. 

WebWindow0.TextBox0.Text=Var.Cloud.tag1.InitValue 

IsSaveHistor

y 

Whether to save 

history records (only 

for cloud tags) 

‘Get whether the specified variable is set to save history 

records. 

WebWindow0.TextBox0.Text=Var.Cloud.tag1.IsSaveHistor

y 

Name Name 
'Get the name of the specified variable. 

WebWindow0.TextBox0.Text=Var.Local.tag1.Name 

Path Path 
'Get the path of the specified variable. 

WebWindow0.TextBox0.Text=Var.Cloud.tag1.Path 

Value Variable value 
'Get the current value of the specified variable. 

WebWindow0.TextBox0.Text=Var.Cloud.tag1.Value 
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12.3.2.3 TextVariable Object 

The following figure shows the properties of a text variable in a script.  

 

Property List: 

Property Description Scripting Sample  

Description Variable description 

'Get the description of the specified variable.  

WebWindow0.TextBox0.Text=Var.Local.Variable.Descripti

on 

InitValue Initial value 
'Get the initial value of the specified variable. 

WebWindow0.TextBox0.Text=Var.Cloud.tag1.InitValue 

IsSaveHistor

y 

Whether to save 

history records (only 

for cloud tags) 

‘Get whether the specified variable is set to save history 

records. 

WebWindow0.TextBox0.Text=Var.Cloud.tag1.IsSaveHistor

y 

Name Name 
'Get the name of the specified variable. 

WebWindow0.TextBox0.Text=Var.Local.Variable.Name 

Path Path 
'Get the path of the specified variable.  

WebWindow0.TextBox0.Text=Var.Cloud.tag1.Path 

Value Variable value 
'Get the current value of the specified variable. 

WebWindow0.TextBox0.Text=Var.Cloud.tag1.Value 
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12.3.2.4 SystemVariable Object 

The following figure lists the system variable properties in a script.  

 

Property List: 

Property Description Scripting Sample  

Date  

The current date of 

the system 

'The text of TextBox0 displays the current date of the 

system. 

WebWindow0.TextBox0.Text=Sys.Date 

Day 

The number of days 

of the current system 

date 

'The text of TextBox0 displays the number of days of the 

current system date. 

WebWindow0.TextBox0.Text=Sys.Day 

DayOfWeek 

The day of week of 

the current system 

date 

'The text of TextBox0 displays the day of week of the current 

system date. 

WebWindow0.TextBox0.Text=Sys.Day 

DayOfYear 

The day of year of 

the current system 

date 

'The text of TextBox0 displays the day of year of the current 

system date. 

WebWindow0.TextBox0.Text=Sys.Day 

Hour 
The hours of the 

current system time 

'The text of TextBox0 displays the hours of the current 

system time. 

WebWindow0.TextBox0.Text=Sys.Hour 

Minute 
The minutes of the 

current system time 

'The text of TextBox0 displays the minutes of the current 

system time. 

WebWindow0.TextBox0.Text=Sys.Minute 

Month 
The month of the 

current system date 

'The text of TextBox0 displays the month of the current 

system date. 

WebWindow0.TextBox0.Text=Sys.Month 

file:///E:/二十一、脚本/21.4%20编程模型/变量/SystemVariable%20对象/属性/Date%20属性.docx
file:///E:/二十一、脚本/21.4%20编程模型/变量/SystemVariable%20对象/属性/Day%20属性.docx
file:///E:/二十一、脚本/21.4%20编程模型/变量/SystemVariable%20对象/属性/DayOfWeek%20属性.docx
file:///E:/二十一、脚本/21.4%20编程模型/变量/SystemVariable%20对象/属性/DayOfYear%20属性.docx
file:///E:/二十一、脚本/21.4%20编程模型/变量/SystemVariable%20对象/属性/Hour%20属性.docx
file:///E:/二十一、脚本/21.4%20编程模型/变量/SystemVariable%20对象/属性/Minute%20属性.docx
file:///E:/二十一、脚本/21.4%20编程模型/变量/SystemVariable%20对象/属性/Month%20属性.docx
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Property Description Scripting Sample  

Now 
The current date and 

time of the system 

'The text of TextBox0 displays the current date and time of 

the system. 

WebWindow0.TextBox0.Text=Sys.Now 

Second 
The seconds of the 

current system time 

'The text of TextBox0 displays the seconds of the current 

system time. 

WebWindow0.TextBox0.Text=Sys.Second 

Time 
The current system 

time 

'The text of TextBox0 displays the current system time. 

WebWindow0.TextBox0.Text=Sys.Time 

Year 
The year of the 

current system date 

'The text of TextBox0 displays the year of the current system 

date. 

WebWindow0.TextBox0.Text=Sys.Year 

 

 

  

file:///E:/二十一、脚本/21.4%20编程模型/变量/SystemVariable%20对象/属性/Now%20属性.docx
file:///E:/二十一、脚本/21.4%20编程模型/变量/SystemVariable%20对象/属性/Time%20属性.docx
file:///E:/二十一、脚本/21.4%20编程模型/变量/SystemVariable%20对象/属性/Year%20属性.docx
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12.3.3 Global 

12.3.3.1 LanguageCmd Object 

LanguageCmd is used for calling the commands of getting the current language and all 

configured languages, as well as switching to the specified language.  

 Command list 

 

 GetCurrentLanguageName 

GetCurrentLanguageName 

This gets the current language name. 

Definition: 

GetCurrentLanguageName() 

Example: 

Get the current language name. 

VBScript Example 

Text0.Text = 

Languagecmd.GetCurrentLanguageName() 

 GetLanguageNames  

GetLanguageNames 

This gets the names of all configured languages. 

Definition: 

GetLanguageNames() 

Example: 

Get the names of all configured languages. 

VBScript Example 

Text0.Text = LanguageCmd.GetLanguageNames() 

 SwitchLanguageTo  
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SwitchLanguageTo 

This switches the current language to the specified language. 

Definition: 

SwitchLanguageTo(language) 

Parameter: 

Parameter name Required / optional Data type Description 

language Required String The specified language 

name 

Example: 

Switch the current language to English. 

VBScript Example 

LanguageCmd.SwitchLanguageTo("en") 
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12.3.4 Color 

12.3.4.1 Colors Object 

The Colors object is for writing the scripts of color commands.  

 Command list 

 

 LinearGradientColor  

This sets a linear gradient color. 

Definition: 

LinearGradientColor(colorContent)  

Parameter: 

Parameter name Required/optional Data type Description 

colorContent Required String 
Multiple sets of RGB color codes 

and offsets 

Example: 

Set the fill color of Rectangle0 to a linear gradient color. 

VBScript Example 

Rectangle0.Fill = Colors.LinearGradientColor("#FFFF8080,0;#FFC1FFFF,0.5;#FFFF8080,1;") 
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 LinearGradientColorWithAngle 

This sets a linear gradient color with the gradient angle. 

Definition: 

LinearGradientColorWithAngle (startcolor, endcolor, angle)  

Parameter: 

Parameter name Required / optional Data type Description 

startcolor Required String Starting color  

endcolor Required String Finishing color  

angle Required Double Gradient angle 

Example: 

Set the fill color of Rectangle0 to a linear gradient color (with the angel of 45 degrees). 

VBScript Example 

Rectangle0.Fill = Colors.LinearGradientColor("#FFFF80FF","#FF80FFFF",45) 

 RadialGradientColor  

This sets a radial gradient color.  

Definition: 

RadialGradientColor(colorContent) 

Parameter: 

Parameter name Required / 

optional 

Data type Description 

colorContent Required String 
Multiple sets of RGB color codes 

and offsets 

Example: 

Set the fill color of Rectangle0 to a radial gradient color. 

VBScript Example 

Rectangle0.Fill = Colors.RadialGradientColor("#FFFFFFFF,0;#FFFFFFFF,0;#FF000000,1;") 

 

 RadialGradientColorWithPoint 

This sets a radial gradient color.  
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Definition: 

RadialGradientColorWithPoint(startcolor, endcolor)  

Parameters: 

Parameter name Required / optional Data type Description 

startcolor Required String Starting color  

endcolor Required String Finishing color  

Example: 

Set the fill color of Rectangle0 to a radial gradient color. 

VBScript Example 

Rectangle0.Fill = Colors. RadialGradientColorWithPoint ("#FFFF0000","#FF00FF00") 

 SolidColor  

This sets a single solid color.  

Definition: 

SolidColor(colorstring) 

Parameter: 

Parameter name Required / optional Data type Description 

colorstring Required String Color code 

Example: 

Set the fill color of Rectangle0 to a single solid color. 

VBScript Example 

Rectangle0.Fill = Colors.SolidColor("#FFFF0000") 
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